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This document contains important information about installation, fixed limitations, and known limitations 
for PowerCenter, Data Analyzer, and Metadata Manager. Do not upgrade to this release from a previous 
version without carefully reading the relevant sections on upgrading and bug fixes, since bug fixes may 
change the behavior of existing sessions. For more complete information on the product, consult the 
manuals and online help.  

For information about fixed and known limitations for PowerExchange Client for PowerCenter, see the 
PowerExchange Release Notes. 

Compilers 
You can use any C compiler for Custom transformation procedures.  

Use C++ compiler versions for any External Procedure or Custom transformation, and when you develop 
with PowerCenter Connect SDK. Use the following C++ compiler versions: 

 AIX (32-bit and 64-bit): Visual Age C++, version 6.0 patch vacpp.60.oct2003.ptf.tar  

 HP-UX (32-bit): HP ANSI C++, bundle number B3910B, version A.03.45 

 HP-UX (64-bit): HP ANSI C++, bundle number B3910B, version A.03.73 

 HPUX-IPF64: aCC -V aCC: HP aC++/ANSI C B3910B A.05.55 [Dec 04 2003] 

 Linux (32-bit and 64-bit): g++ (GCC) 3.3.1  

 Solaris (32-bit and 64-bit): CC: Sun C++ 5.5 2003/03/12 

 Solaris X86 (64-bit): CC: Sun C++ 5.8 2005/10/13 

 Windows: Microsoft Visual C++ .NET 7.1.3088 

If you compiled your DLL or shared library using a C++ compiler other than the ones specified above, you 
need to recompile it. 
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Installing PowerCenter 8.1.1 SP5 

PowerCenter 8.1.1 SP5 contains updates to PowerCenter 8.1.1. 

You can apply PowerCenter 8.1.1 SP5 to the following PowerCenter components: 

 PowerCenter Services 8.1.1, 8.1.1 SP1, 8.1.1 SP2, 8.1.1 SP3, 8.1.1. SP4 

 PowerCenter Client 8.1.1, 8.1.1 SP1,  8.1.1 SP2, 8.1.1 SP3, 8.1.1 SP4 

 DataAnalyzer 8.1.,18.1.1 SP2, 8.1.1 SP3 

 Metadata Manager 8.1.1, 8.1.1 SP2, 8.1.1 SP3 

If your current version of PowerCenter is version 8.1 or earlier, you must upgrade to PowerCenter 8.1.1 
before you apply the service pack.   

You can install the PowerCenter Client on Windows 2000, Windows XP, and Windows 2003 operating 
systems. 

You can apply PowerCenter 8.1.1 SP5 to PowerCenter Services, Data Analyzer, and Metadata Manager on 
the following operating systems: 

 AIX 32bit – v5.2 and v5.3 

 AIX 64bit – v5.2 and v5.3 

 Linux 32bit – RedHat v3.0 and v4.0 

 Linux 32bit – SuSe9 

 Linux 64bit(x64) – RH v3.0 and v4.0 

 Linux 64bit(x64) – SuSe9  

 Solaris 32bit – v9 and v10 

 Solaris 64bit – v9 and v10 

 Solaris x86 64 

 HP UX 32bit – v11.11,11.23 

 HP UX IPF 64bit – v11.23 

 Windows 32bit – v2000 and v2003  

 Windows x64 EM64T   

 Windows x64 Itanium  

You can apply the service pack to Data Analyzer and Metadata Manager on the following application 
servers: 

 JBoss Application Server 

 IBM WebSphere Application Server 

 BEA WebLogic Server 

 The PowerCenter 8.1.1 SP5 installer is available only through Electronic Software Distribution (ESD). 

For more information about installing PowerCenter 8.1.1 SP5, see the PowerCenter SP5 Service Pack 
Installation Guide. 
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Patches and Libraries 

This section contains information about patches and libraries required to run domain and application 
services. 

Installing on AIX 
To run domain and application services on AIX, install the 6.0.0.0 or later runtime environment. 

Installing on HP-UX 
To run domain and application services on HP-UX, install HP patch PHSS_33033 or later. 

Installing on HP Itanium 
To run domain and application services on HP Itanium machine with an aCC 5.55 compiler, install the 
following patches: 

  PHSS_32502 Aries cumulative patch  

  PHSS_33349 linker + fdp cumulative patch  

  PHSS_34041 aC++ Runtime (IA: A.06.06, PA: A.03.66) 

  PHSS_34043 Integrity Unwind Library 

Installing on Solaris 
To run domain and application services on Solaris 2.8, install patches 109147, 108434, and 108993-53. 
To run domain and application services on Solaris 2.9, install patches 112963 and 1171-11. 
To run domain and application services on Solaris 8 32-bit, install patch 108434. 
To run domain and application services on Solaris 8 64-bit, install patch 108435. 
To run domain and application services on Solaris 9 32-bit, install patches 111711-15 and 112963-25. 
To run domain and application services on Solaris 9 64-bit, install patch 111712. 

Installing AXIS on the Web Services Hub 
To run the AXIS samples or any client application developed using AXIS, you need AXIS 1.1. You can 
find AXIS libraries in $INFA_HOME\server\samples\BatchWebServices\lib\axis-1.1. 

PowerCenter Closed Enhancement Requests 
This section describes enhancement requests that were fulfilled for PowerCenter. 

8.1.1 SP5 PowerCenter Closed Enhancement Requests 

This section describes PowerCenter enhancement requests that were fulfilled in version 8.1.1 SP5. 

CR  Description 

179553 The Designer creates groups for hierarchies with multiple child elements when you import an XML 
definition and create denormalized views. 

178899 The de-initialization method of the partition driver updates the session load summary. 

178794 You can configure the Integration Service to stop periodically sending Get requests to the web service 
target to verify that the web service is running. 
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176934 A getPeer() API function has been added to the PowerCenter SDK. 

103547 The Designer does not perform unnecessary connection queries in the repository when you edit a 
transformation. 

8.1.1 PowerCenter Closed Enhancement Requests 

This section describes PowerCenter enhancement requests that were fulfilled in version 8.1.1. 

CR  Description 

107169 You can enter mapping parameters, mapping variables, and user-defined workflow variables in pre- and 
post-session shell commands. 

105087 You can display group names associated with each user by adding –g option to the pmrep ListAllUsers 
command. 

105002 You can enter service, service process, and user-defined workflow variables in workflow log file names. 

105001 See 105087. 

103925 You can enter parameters and variables in the table name prefix for relational targets. 

103832 You can enter service, service process, and workflow variables in commands in the Command task. 

103383 You can enter service, service process, and workflow variables in the address, subject, and body of the 
Email task. 

101379 You can use the pmrep ObjectImport and ObjectExport commands without having the Admin 
Repository privilege. 

100443 You can parameterize the FTP connection default remote directory using the general session 
parameter “$ParamName”. 

99658 You can dynamically name target flat files based on the value of a FileName port in the flat file target 
definitions. 

99413 See 86342. 

98581 See 90555. 

97506 You can use the pmrep PurgeVersion command or an advanced purge in the Repository Manager to 
purge deleted objects and older versions of objects based on purge criteria. 

96134 See 96128. 

96128 You can create a new flat file target for each transaction and dynamically change the file name.  

94765 When you run a session or workflow that uses a parameter file, and the parameter file does not exist, 
the Integration Service generates an error message. 

90555 You can create control file variables to override the Teradata loader control file properties for a session. 

88697 See 103925. 

87744 See 103925. 
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86342 You can configure an Integration Service to run in safe mode before enabling the service to stop 
scheduled workflows and workflows scheduled to run continuously when the service starts. 

85824 You can connect to the DB2 database without providing DB2 username and password. 

83835 During environment migration, you can use Integration Service safe mode to change the assigned 
Integration Service for a workflow before the scheduled workflow runs. 

82748 You can enter parameters and variables in connection and transaction environment SQL. 

82713 You can use the pmrep PurgeVersion command or an advanced purge in the Repository Manager to 
retain a specified number of object versions and purge older versions. 

82374 You can start the Integration Service in safe mode and the Integration Service does not run any 
scheduled workflow. 

81264 You can enter parameters and variables in the source table owner name and target table name prefix. 

80831 See 70696. 

70696 You can start an Integration Service without running the scheduled workflows. 

65941 See 100443. 

55235 In a parameter file, you can define parameters and variables globally, for a specific Integration Service, 
or for a specific Integration Service process. 

52844 See 81264. 

41519 You can enter parameters and variables in the call text for an unconnected Stored Procedure 
transformation. 

31790 See 55235. 

 

8.1 PowerCenter Closed Enhancement Requests 

This section describes PowerCenter enhancement requests that were fulfilled in version 8.1. 

CR  Description 

105040 Workflow Monitor shows transformation statistics, such as applied rows, affected rows, and rejected 
rows for sessions with partitions. 

93043 You can configure the Database Name attribute for Teradata FastExport, and the Integration Service 
generates the SQL statement using the database name as a prefix to the table name. 

90758 The name and location of the pmrep connection file can be stored in an environment variable. This 
allows you to specify different connection files for different DOS or UNIX shells. 

89315 You can import session and workflow logs into the Workflow Monitor to view them. 

89291 The session log displays the PowerCenter Integration Service version number. 

86778 In Data Profiling, you can load verbose data for the Referential Integrity Analysis (Orphan Analysis) 
function and view the orphan row data using the PowerCenter Data Profiling reports. 
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85632 You can allow users to view session logs but not run sessions with one of the following sets of 
permissions and privileges: 

- Workflow Operator privilege with read permission on the folder 

- Use Workflow Manager privilege with read permission on the folder 

85621 Informatica improved the messages in the session log when the mapping variable length is incorrect. 

84171 pmrep contains commands that list the groups a user belongs to and the privileges a user has. 

83177 You do not need administrator privileges to install the PowerCenter Client on Windows. 

82089 DTM process performance is improved when accessing the repository. 

75175 Session emails display the name of the attached file but not the path to the attachment. 

73463 You can enable the Lookup transformation to build caches concurrently to improve session 
performance. 

71840 You can use a wildcard in a source file name by creating a command in the session properties. 

69633 You can use the CONVERT_BASE function to convert hexadecimal to decimal or decimal to 
hexadecimal. 

66299 When the Integration Service process on UNIX creates any file other than a recovery file, it sets the file 
permissions according to the umask of the shell that starts the Integration Service process. 

46652 You can configure the Integration Service to automatically determine the cache size for index and data 
caches, XML target caches, Sorter caches, and DTM buffers and buffer blocks. 

15811 Sybase stores milliseconds with 1/300 of a second accuracy. 

 

Data Analyzer Closed Enhancement Requests 
This section describes enhancement requests that were fulfilled for Data Analyzer. 

8.1.1 Data Analyzer Closed Enhancement Requests 

This section describes Data Analyzer enhancement requests that were fulfilled in version 8.1.1. 

CR  Description 

105219 Data Analyzer uses the JDK expression parser instead of the Jakarta ORO Perl parser. 

94668 You can use the Data Analyzer API to remove a user’s primary email address. 

87553 You can use the Data Analyzer API to flush the global cache. 

 

8.1 Data Analyzer Closed Enhancement Requests 

This section describes Data Analyzer enhancement requests that were fulfilled in version 8.1. 
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CR  Description 

99189 Report table scroll bar works correctly on the Internet Explorer browser on Windows XP. 

 

Metadata Manager Closed Enhancement Requests 
This section describes enhancement requests that were fulfilled for Metadata Manager. 

8.1.1 Metadata Manager Closed Enhancement Requests 

This section describes Metadata Manager enhancement requests that were fulfilled in version 8.1.1. 

CR  Description 

103107 The Custom Metadata Configurator creates mappings that extract up to 4,000 characters from each 
source column. 

92391 You can install the PowerCenter repository for Metadata Manager and the Metadata Manager 
repository on a Sybase ASE database. 

 

8.1 Metadata Manager Closed Enhancement Requests 

This section describes Metadata Manager enhancement requests that were fulfilled in version 8.1. 

CR  Description 

90310 In Metadata Manager, the repository metadata search uses the attribute value when the search is 
defined on a specific class and all properties. 

87259 The Metadata Manager Console Parameter Setup tab provides horizontal scroll bars for the inclusion 
and exclusion list boxes when the parameter file name is too long to fit in the list windows. 

 

PowerCenter Fixed Limitations 
This section describes fixed limitations for PowerCenter.  

8.1.1 SP5 PowerCenter Fixed Limitations 

This section describes PowerCenter limitations that were fixed in version 8.1.1 SP5. 

CR  Description 

179637 The Integration Service fails to generate separate output files when you configure a FileName port in a 
mapping.  
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179520 Cannot validate a workflow that contains a non-reusable worklet. 

179511 The Integration Service incorrectly reads from delimited flat file sources with consecutive delimiter 
characters.  

179510 You cannot edit a connection object on which you have write permission. 

179380 The getPartitionKeys() function in the PowerCenter API can fail to return the correct list of partition 
keys. 

179295 Session fails when the Integration Service runs in Unicode mode and writes filtered rows from a Filter 
transformation into reject files. 

179162 On AIX, the Integration Service does not expand environment variables in the email address of an 
Email task. 

179147 The Integration Service does not perform all of an Event Wait task instance on the node assigned to the 
Event Wait task.   

178778 Calls to functions in the Load Manager API start too many threads and use up resources. 

178732 Data loss occurs on z/Linux when the mapping includes a Sorter transformation.   

178626 Sorter transformation drops one row. 

178402 The Repository Service on 64-bit Solaris shuts down unexpectedly when you use pmrep Validate. 

178398 The Integration Service shuts down unexpectedly when it runs with a UTF-8 code page and processes 
a Sorter transformation. 

178379 The Integration Service allocates incorrect index and data cache sizes when you configure automatic 
memory settings for a session on German machines.    

178373 Lookup transformation does not find data that is added to a lookup source from a different target load 
order group in a mapping. 

178363 The Integration Service shuts down unexpectedly when a sorter cache file exceeds 2 GB. 

178137 Session with XML Generator transformation and JMS target fails with signal exception due to DTM 
buffer management error. 

177708 The Integration Service may incorrectly calculate workflow schedule time when daylight savings time 
ends. 

177645 A session hangs when the source contains no data, the source requires an FTP connection, and the 
FTP host runs on AIX. 

177595 The Repository Service shuts down unexpectedly when the Integration Service runs a Session task.  

177575 The Integration Service shuts down unexpectedly when it encounters a connection error. 

177573 Oracle source-based commit sessions that use commit intervals of several thousand rows might shut 
down unexpectedly on Windows if the source contains “raw” data. 

175545 A session running on AIX fails when the source requires a DataDirect ODBC driver and the target is a 
flat file. 

177503 When a session running a Web Services Consumer transformation sends a request through a proxy 
server that has authentication enabled, the session fails. 
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177460 A port-to-port data conversion between a Sorter transformation and Expression transformation fails a 
session on AIX 64. 

177373 The Integration Service does not update the final status of a workflow in the workflow log if you stop the 
service process during execution of the workflow. 

177258 The repository audit trail log shows incorrect password changes when LDAP users are added to the 
repository. 

177177 Null pointer exception occurs when you run the Backupdomain command and specify the –cs option. 

177174 Repository passwords are not encrypted.  

177173 The Integration Service cannot create a workflow log file when a session runs in debug mode. 

177015 Workflow Monitor shuts down unexpectedly when you disconnect from the repository. 

177000 The Integration Service process shuts down unexpectedly when a Lookup transformation references a 
value that does not exist in cache memory. 

176997 Session log displays an error instead of a warning when a lookup table contains no data. 

176946 Command tasks or pre- and post-session tasks fail when the output is not redirected. 

176935 The execute() API function in the writer SDK does not receive a callback for targets with multiple 
groups. 

176932 Sessions that use FastExport to read Teradata sources with hundreds of thousands of rows might 
cause the Integration Service to shut down unexpectedly because the DTM process uses too much 
memory. 

176882 Session fails while running in bulk mode on DB2. 

176797 A Custom transformation fails to correctly return the session extension information. 

176781 The user-defined function IIF(ISNULL(INPUT_STRING) is not returning TRUE when the source is 
NULL. 

176742 A session fails if a Java Custom transformation has a port that is not connected in the mapping. 

176710 The Integration Service generates a target XML file with a root element when there are no source rows. 

176696 The Designer hangs when you link ports of multiple Java transformations to other transformations in a 
mapping. 

176675 When you use pmcmd to run a workflow and specify the -localparamfile option, the Integration Service 
deletes the parameter file after completing the workflow.   

176674 In the HTTP transformation, you cannot override the final URL to connect to the HTTP server. 

176667 The Integration Service might shut down unexpectedly when it tries to abort a failed session in a worklet 
within a workflow that is configured to suspend on error. 

176626 The Integration Service process shuts down unexpectedly when you run a mapping with a sorter 
transformation. 

176569 The SQL transformation converts a null value to zero in a pass-through port. 

176568   See 176781. 



   12

176563 Session fails when source data contains a null character. 

176512 Profile mapping with Union transformation fails due to license error. 

176371 See 174209 

176145 The Integration Service sometimes cannot delete storage files on Windows 2003 Server because it 
cannot obtain permissions on the files. 

176091 The Web Services Consumer transformation incorrectly removes leading and trailing spaces from string 
values. 

175807 See 179510. 

175536 Session using the COMPRESS function leaks memory.  

175511 The Integration Service overwrites session reject files.  

175508 The Integration Service drops characters when it reads data from source files with single character 
delimiters and the file properties specify multiple characters as delimiters. 

175368 See 177460. 

175143 When fetching binary data from the database, the writer API does not return the correct length of the 
data. 

175091 AIX 64-bit installer shuts down unexpectedly. 

175067 See 175536. 

174852 Exporting and importing repository objects cause inconsistencies in display of objects in Designer and 
Repository Manager. 

174787 Source row data contains n/a for CDC real-time sessions.  

174292 The Debugger cannot connect to the Integration Service over a VPN connection in a NAT environment. 

174209 Pre- and post-session commands fail when standard error (stderr) is written to the server/bin directory 
without write permissions. 

174206 Integration Service generates a core file when it retrieves repository login information. 

173969 Service Manager marks worker node as inactive when CPU load is high. 

173897 The Integration Service drops random characters from delimited files in Unicode mode.  

173539 The Integration Service drops Unicode characters when reading from Oracle database. 

173120 The Task View tab in the Workflow Monitor shows the date in the Start Time and Completion Time 
fields instead of the time. 

172753 Integration Service or Repository Service shuts down unexpectedly when the Service Manager fails to 
read the application service status. 

172703 Teradata TPump sessions fail when you enable the serialize option because the Integration Service 
does not create the Key field in the control file. 

172490 Session shuts down unexpectedly with a svecmatrix.cpp:256 error in PowerCenter 8.1.1 SP3. 
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170739 The Web Services Consumer transformation does not correctly resolve namespaces when the WSDL 
includes nested XSD. 

170692 Repository Service shuts down unexpectedly when the Repository Service receives a reconnection 
from a repository client. 

170659 Sessions that contain a Union transformation fail with the following message: ERROR: Partitioning 
option license required to run sessions with user-defined partition points. 

170509 Session fails with SIGSEGV(11) exception when accessing a persistent lookup cache in a mapplet on a 
Solaris 64-bit machine. 

170161 Screen layout problems occur when using the Data Profiling Option in Japanese. 

170123 Post-session email or email tasks fail on a 64-bit machine. 

170010 Installer debug log displays administrator password when you select the option to join the domain on a 
node that will serve as a gateway.  

169620 Can not use Oracle RAC, DB2 server_encryption, or HTTPS features without manual configuration. 

169551 In the Workflow Monitor, you must expand source and target statistics for sessions without multiple 
partitions. 

169543 The Web Services Consumer transformation does not correctly display the qualified attribute of a 
namespace. 

169271 See 176696. 

135566 Session hangs on Solaris when the input type for a flat file source is set to command. 

133487 Session shuts down unexpectedly with a stack trace error. 

133270 The XML Editor displays error messages when the client machine runs Microsoft Internet Explorer 7. 

130336 Data is truncated and a session does not fail when a Source Qualifier port is smaller than the database 
data. 

108965 Partitioned session containing a Sorter transformation hangs on 64-bit AIX machines. 

108250 When you run a session with a Java transformation and the value for a port has the wrong datatype, the 
session fails.  

106239 See 176674. 

103969 The XML Parser transformation does not process non-ASCII characters. 

101062 The XML XPath does not appear in the XML Parser transformation or XML Generator transformation. 

8.1.1 SP4 PowerCenter Fixed Limitations 

This section describes PowerCenter limitations that were fixed in version 8.1.1 SP4. 

CR  Description 

175081 A Transaction Control transformation with a TC_COMMIT_AFTER transaction expression hangs after 
processing rows from a flat file source. 
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173905 A workflow does not complete when a flat file target size is between 512 KB and 768 KB and the target 
has a filename port. 

173585  8.1.1 Service Pack install script hangs on HP-UX when LANG is set to different languages. 

173051 Integration Service requires restart due to memory leakage. 

173050 Web service session continually restarts after it fails, requiring shutdown of the Web Service Hub to 
stop the session permanently. 

172999 A pre-session SQL command fails in PowerCenter 8.1.1 SP3 on HP-UX PA RISC 64bit. 

172941 Integration Service on AIX 64-bit or Windows 32-bit shuts down unexpectedly when you run a debug 
session with a Union transformation. 

172301 The PowerCenter Client or  pmrep might hang when you import a session or workflow that has a 
complex mapping. 

172299 The Repository Service shuts down unexpectedly when the database server tries to remove locks on 
previous database connections. 

172243 Round function incorrectly rounds values up. 

172219 The Integration Service might terminate unexpectedly when aborting a workflow that contains a 
Command or Event-Wait task. 

171830 If you change the schedule settings for a workflow, the Integration Service cannot reschedule the 
workflow. 

171593 The Repository Service fails to update the values for the associated port when you deploy a mapping 
with a Lookup transformation. 

171362 The Integration Service shuts down unexpectedly when it runs a Command task with over 1024 
characters. 

171293 HP multiprotocol file transfer libraries on HPUX IA 64 should be updated. 

171087 JDBC drivers do not support SSL on Oracle and DB2. 

171082 The Integration Service might generate a core file when the Load Balancer attempts to log a message 
saying that it could not terminate a service process on another node. 

170834 PowerCenter does not enforce CPU restrictions on licenses for OEM partners.  

170484 The Repository Service drops key range partitions when importing a mapping with a non-reusable 
session. 

170250 Session with a Joiner transformation fails when the input data is over one million rows. 

169608 When running a mapping that contains an Expression transformation with a decimal port, the 
Integration Service skips rows in which the decimal port receives a zero value that contains leading or 
trailing spaces. 

169520 The session sometimes terminates unexpectedly when the Integration Service tries to write null values 
to an Oracle column that is not null. 

169455 The Integration Service generates a core file when you upgrade from 6.x to 8.1.1 SP1, modify a 
parameter file session property, and then run the session. 

169423 The Repository Service returns incorrect status for a folder when you deploy global shortcuts.  



 15

169414 Sessions fail on Solaris when the Integration Service writes session reject files with file descriptors 
greater than 255. 

169401 Sessions fail because the Repository Service declares the maximum number of cursors on Oracle when 
the Integration Service runs on a grid and the repository is on Oracle. 

169376 Workflow recovery sometimes does not start after failover on a grid. 

169270 The Integration Service shuts down unexpectedly when it processes a regular expression in an 
Expression transformation. 

169239 An unexpected condition occurs when you import a mapping into a shared folder by choosing the 
replace option to resolve mapping conflicts. 

169219 If the Integration Service encounters the error threshold in one pipeline branch, it stops processing in 
that branch, but continues to process other branches. 

169150 When you copy a folder, the target folder does not retain overridden properties in the session Config 
Object tab. 

168619 Session hangs when the mapping contains a Transaction Control transformation. 

168565 Session fails when using pushdown optimization on Teradata. 

168534 The Sequence Generator transformation generates duplicate values in sessions with multiple partitions. 

137046 Sessions that use Sorter transformations that process more than 10,000 rows might terminate 
abnormally. 

136854 The Designer does not allow you to import source and target definitions that begin with a number. 

136834 pmrep DeployFolder compares objects between incorrect folders. 

136787 A workflow does not stop when you place MsgCount(n) and Idle(n) in the Filter Condition of an MQ 
Series session. 

136751 The source repository service fails unexpectedly when deploying a large group on Linux. 

136594 The session terminates unexpectedly when mapplets in the mapping contain a large number of 
unconnected Lookup transformations. 

136154 The Repository Manager sometimes fails to import a worklet if the workflow already exists in the 
repository. 

135900 Sequence Generator transformation generates duplicate values when the session runs with multiple 
partitions. 

135741 Integration Service shuts down unexpectedly with an out of memory exception. 

135651 When you add a port to a Union transformation in a mapping, the links to other ports in the 
transformation change. 

135632 Session terminates unexpectedly when it writes to a Teradata multiload target with a Korean code page 
on AIX 64-bit  

135602 Integration Service may shut down unexpectedly when it runs on Linux.   

135123 The XML Parser transformation returns incorrect data in a pass-through port. 
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135083 Session with JMS target shuts down unexpectedly when body text is greater than 2.5 MB and the 
Integration Service runs in Unicode mode. 

134174 The links between ports break in the latest version of a mapping when you purge older versions of the 
mapping. 

134067 Real-time web service workflow fails when it receives multiple requests to perform string search. 

133435 Concurrent sessions running a stored procedure fail to write to the same target flat file. 

133335 The scheduler associated with a workflow is deleted when you import the workflow into the repository.   

133150 The Integration Service generates a core file when running sessions upgraded from PowerCenter 6.x to 
8.1.1.   

133091 Session with a Microsoft SQL Server Stored Procedure transformation fails when the stored procedure 
contains a PRINT statement. 

131745 Performance is slow when the Integration Service writes data to a DB2 target table  alias and the 
database table is partitioned.   

131551 The Transaction Control transformation incorrectly generates output files. 

131495 When you change the status of a repository object in the Designer or Workflow Manager, pmrep 
Validate does not return the updated status of the object. 

127554 Lookup sessions that run on a grid may fail when they share a named dynamic cache. 

127499 Sessions running on Solaris 32-bit operating system fail at initialization. 

127291 The Integration Service shuts down with an unexpected condition when restarting a suspended 
workflow containing a worklet. 

107804 The Workflow Monitor shuts down unexpectedly with a helpers.cpp 1655 error. 

107604 Unable to revert a mapping to a previous version when you export and import it back into the repository.  

106414 See 171593. 

 

8.1.1 SP3 PowerCenter Fixed Limitations 

This section describes PowerCenter limitations that were fixed in version 8.1.1 SP3. 

CR  Description 

168453 A workflow  with a PowerExchange ODBC connection does not stop running when the number of errors 
reaches the error threshold. 

136904 The Import Mapping Template wizard ignores the source DBDNAME parameter when it creates 
mappings from a mapping template. 

136572 The Workflow Manager shuts down unexpectedly when you import a second workflow. 

136494 The Workflow Monitor fails with an unexpected condition when you open and close folders in the 
repository multiple times. 
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136174 Web Services sessions may fail when the Integration Service uses HTTP Proxy server. 

135735 The Integration Service might generate an internal error when you run a mapping with a Joiner 
transformation that performs a full outer join on large amounts of data. 

135583 The Integration Service converts not-null data to empty string in an Expression transformation when 
precision of the variable string port is less than the precision of the input string port. 

135495 When you deploy mappings with shortcuts to VSAM sources or targets, undeployed mappings that 
have the same shortcuts become invalid. 

135280 See 135495. 

134977 The SQL transformation does not generate output for pass-through ports. 

134932 Backup node on the domain takes over ten minutes to recover during service process failover. 

134905 The Integration Service might generate a core file when you use Perl compatible regular expression 
syntax with the REG_EXTRACT function. 

134626 A session running an external loader on Sybase or Oracle fails when the control file is read-only. 

134453  Pmrepagent process for the Repository Service leaks memory on Windows. 

134419 Sessions fail after applying EBF127325_109115_13361. 

134382 Integration Service shuts down unexpectedly when it connects to the PowerCenter Client. 

134339 Integration Service shuts down unexpectedly when it runs on a grid with two nodes. 

134127 If you start a background process from a post-session shell command on UNIX, the Integration Service 
waits for it to finish instead of letting it run in the background. 

134053 The Integration Service inserts Char data values as NULL in the target when the precision of the 
transformation datatype is less than the precision of the source datatype. 

133949 Session fails unexpectedly when processing two Joiner transformations with same ports in the join 
condition. 

133932 The Repository Service process does not restart if it shuts down unexpectedly and you do not have the 
high availability option. 

133856 An error appears if you use the Administration Console to generate a repository backup file and the file 
name contains multiple periods (.). 

133697 Cannot recover session because the Integration Service could not acquire the execute lock for the 
workflow during failover. 

133475 Sessions fail on Solaris when the Integration Service writes session reject files with file descriptors 
greater than 255. 

133413 Workflow Monitor displays incorrect run status for a workflow. 

133360 The Integration Service incorrectly rejects rows when it updates a Microsoft SQL Server database in 
bulk mode. 

133102 The ROUND function rounds the result down to the nearest integer when high precision is disabled. 

132958 Integration Service shuts down unexpectedly when a session is run on a grid where one of the nodes is 
down. 
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132879 Web service workflow does not process any client requests after it processes initial client requests. 

132874 Sessions that load data to Oracle targets using the Oracle SQL Loader might hang if the parent 
workflow is configured to run continuously. 

132495 Installer does not have a silent client install option. 

132093 Unable to access the Workflow Monitor when multiple workflows are scheduled to run continuously. 

131018 Repository object locks and the session log are not released after session failover. 

130196 Session fails when executing a stored procedure that includes a PRINT statement. 

107937 Session configured for high precision returns incorrect values when the ROUND function uses Double 
datatype. 

 

8.1.1 SP2 PowerCenter Fixed Limitations 

This section describes PowerCenter limitations that were fixed in version 8.1.1 SP2. 

CR  Description 

132817 Integration Service generates a core file when processing a Joiner transformation. 

132619 Integration Service leaks memory while running Event tasks. 

132617 Integration Service leaks memory while writing to log files. 

132056 Session executing a Microsoft SQL Server Stored Procedure transformation leaks memory. 

132020 Sessions that are configured to run on a grid, have a large number of source rows (10,000 or more), 
and load data to multiple targets may hang. 

131829 Domains.infa file displays information that should be restricted to users.   

131729 When a mapping uses an Oracle source and writes to an XML file target containing date/time 
datatypes, the session fails with no errors logged. 

131532 Integration Service shuts down unexpectedly when running workflows with Command tasks.   

131520 Integration Service may shut down unexpectedly when running sessions with file watch events.   

131317 The Workflow Manager checks out the workflow when you validate it. 

131012 A session fails unexpectedly processing a Sorter transformation with a flat file source and relational 
target. 

130928 Integration Service rejects rows with valid Date/Time datatype and writes a data overflow and data 
conversion message to the session log. 

130905 DB2 bulk loader writes a success return code to the session log when the load operation fails.   

130904 XML Parser transformation writes output in UTF-8 instead of writer codepage. 

130853 Pushdown optimization session fails when writing to Teradata containing time(0) field.  
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130503 The Debugger shuts down unexpectedly if you stop it before it loaded all the data. 

130414 The Integration Service process aborts a session with a dynamic lookup cache. 

130269 When a PowerCenter client connects to a different version of the PowerCenter server, the Repository 
server does not recognize the shortcut to a table name. 

130267 A Lookup transformation returns incorrect values when the lookup condition contains a timestamp and 
the session swaps the lookup cache from disk. 

130255 Session returns unexpected results when you perform incremental aggregation. 

130247 ODBC drivers unavailable for Sun Solaris x86 64-bit platform. 

130246 ODBC drivers unavailable for HP PA-RISC 64-bit platform. 

 130170 Bulk load sessions with Oracle targets fail. 

127889 The Integration Service may stop unexpectedly if you run a workflow on a grid multiple times and the 
workflow contains at least one worklet. 

127735 Integration Service leaks memory while running Command tasks on AIX.  

127695 Integration Service may shut down unexpectedly and generate a core file when concurrent sessions run 
on Linux.   

127204 Session fails when the Web Services Consumer transformation is configured to be non-partitionable. 

127134 Data loaded to an Oracle database in bulk mode is truncated. 

127130 Cannot update table name prefix with pmrep UpdateSrcPrefix and UpdateTargPrefix. 

108610 The Designer shuts down unexpectedly on the Union transformation Group Ports tab for multibyte 
locales. 

107548 Samples in the InformaticaDeveloperPlatform8.1.1/LoadManager_API_JAVA/samples directory stop 
responding when run on Solaris.   

106929 Designer might shut down unexpectedly when you switch between the Mapping Designer and Source 
Analyzer in full screen mode. 

8.1.1 SP1 PowerCenter Fixed Limitations 

This section describes PowerCenter limitations that were fixed in version 8.1.1 SP1. 

CR  Description 

130266 Cached Lookup transformations do not return the correct value when there is a Timestamp column in 
the lookup condition, the lookup cache is written to disk, and swapping occurs. 

127747 Session performance slows for sessions that use target database partitioning on IBM DB2 when the 
partition key column has a Bigint datatype. 

127697 The installer does not restore the server/infa_shared directory when it upgrades a PowerCenter 8.1 
installation. 

127592 Nested worklet validation fails in versioned repository. 
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127556 Sessions with a large number of lookups running on heavily utilized machines may fail with Resource 
temporarily unavailable or Interrupted system call errors. 

127553 Lookup sessions that run on a grid may run slowly when they share a named static cache. 

127552 Session log displays extraneous messages when the DTM process for a session fails. 

127472 Debugger shuts down unexpectedly when debugging a mapping that contains a Sorter transformation. 

127405 See 107800. 

127381 The Integration Service creates null values for parent elements in a denormalized view and the session 
fails. 

127341 See 107934. 

127272 See 108080. 

127097 See 108861. 

127089 See 108257. 

109110 The Integration Service Stops unexpectedly when a workflow that is configured to suspend on error 
contains a worklet with concurrent sessions in which one succeeds and the other fails. 

108901 Changing the connection name or replacing a connection causes repository inconsistencies, such as 
incorrect lookup table names and lookup cache directory names. 

108894 Session with Sorter transformation may fail after upgrade from PowerCenter 7.x. 

108861 The Integration Service may shut down unexpectedly if you stop a session a few minutes after it starts 
or if the Integration Service shuts down while a session is initializing. 

108834 In AIX, if you enable a Web Services Hub associated with a repository that does not contain any web 
service workflow, editing and saving any workflow in the repository can cause the Web Services Hub 
and PowerCenter node to shut down unexpectedly. 

108662 If you enable a Web Services Hub associated with a repository that contains a web service workflow 
with an invalid mapping, the Web Services Hub and PowerCenter domain may shut down 
unexpectedly. 

108080 Session using Teradata FastExport reader fails when a Source Qualifier transformation is associated 
with more than one source. 

108773 The Integration Service truncates or skips rows in an XML target when the XML target is encoded as 
UTF8. 

108761 The Integration Service skips processing the first few bytes of flat file records after processing some of 
the records correctly. 

108257 Sessions loading to Microsoft SQL Server targets do not reject NULLs. 

107942 Session fails when loading to a named pipe on Linux. 

107934 Session using a cached lookup and a PowerExchange AS/400 connection fails. 

107800 Session that contains a Joiner transformation with sorted input and stop on error set to one hangs when 
the PowerCenter Server encounters a row transformation error. 
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107557 Session with a Java transformation that uses an unconnected lookup and an expression that uses the 
same lookup terminates unexpectedly. 

106015 DATE_DIFF function returns integer values after you upgrade from PowerCenter 7.x. 

99773 Description property in transformations is too small to display Japanese characters. 

 

8.1.1 PowerCenter Fixed Limitations 

This section describes PowerCenter limitations that were fixed in version 8.1.1. 

CR  Description 

107035 See 107017. 

107017 Number of initial rows to skip does not reset after reading a flat file when using an indirect file list. 

106742 Repository Service shuts down unexpectedly when running 40 concurrent sessions. 

106434 See 103601. 

106324 See 105381. 

106321 Repository Service shuts down when you try to change user permissions on an existing relational 
connection. 

106276 A session terminates when it reaches the configured error threshold of 1. 

105947 See 106321. 

105897 The Workflow Monitor shows a succeeded status for a failed parent when you enable Fail Parent if This 
Task Does Not Run. 

105718 Mapplet cannot be edited if it contains a shortcut to an object that has been modified in an unversioned 
repository. 

105698 See 105354. 

105598 See 106742. 

105484 Integration Service does not write reject row information to session log when rows are rejected from the 
Microsoft SQL Server target. 

105381 The Designer shuts down unexpectedly when you import an SAP mapping into the repository. 

105354 The Copy Folder Wizard does not always provide the option to retain workflow history when you copy a 
folder in the repository. 

105284 

 

The Debugger fails unexpectedly when an unconnected Lookup is called from an Expression 
transformation that contains an expression with a wrong syntax. 

105193 In workflows that contain link conditions that check the previous task status of a worklet, the Integration 
Service always follows the workflow path as if the worklet succeeded. 

105014 Cannot create domain with a named SQL Server database during installation. 
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104960 When you upgrade PowerCenter 5.1.2 to 7.1.2, you may encounter database locking problems with 
sessions that previously ran in bulk mode, had a Sybase relational source or target, and had the Treat 
Source Rows As session property set to Update. 

104959 See 103807. 

104907 Warning messages appear in the session log when the session’s Tracing Level property is set to 
Normal. 

104902 In a partitioned session that uses a parameter file, the Integration Service may expand one numerical 
parameter with a different parameter’s value. 

104898 The password encryption utility pmpasswd does not work on HP-UX. 

104844 The XML Generator transformation generates output although it receives no source rows. 

104644 Repository Manager shuts down unexpectedly when copying a workflow that contains a mapplet 
shortcut to another folder in the same repository. 

104541 JBoss Application Server does not start on AIX. 

104487 When you stop or abort a workflow, the workflow state remains “stopping” or “aborting”. 

104455 Repository Manager shuts down unexpectedly when you add a user. 

104447 See 104902. 

104332 Default locale not set to EN during validation of mapping containing a Java transformation. 

103999 See 103934. 

103934 Users with Use Workflow Manager privilege and write permission on the folder cannot run the pmrep 
UpdateTargPrefix and UpdateSrcPrefix commands. 

103929 See CR 104960. 

103807 Number of bytes to skip between rows in flat files does not reset after reading a flat file when using an 
indirect file list. 

103782 Repository Service shuts down unexpectedly if you update user or user’s group information while the 
user opens a folder. 

103768 Database error appears when you unregister LDAP. 

103767 See 103768. 

103614 See 102743. 

103601 A session with an XML Parser transformation hangs on Windows 2003/XP when the source data 
contains an xsi:type attribute. 

103510 Domain shuts down unexpectedly if you check out a workflow while the Web Services Hub is running. 

103410 Joiner transformation outputs incorrect values when the session is configured for high precision. 

103381 See CR 103782. 

103377 Session fails with SIGSEGV (11) signal when session contains an XML source. 

103227 When you start Visio Client for PowerCenter, it may not display the Data Integration toolbar. 
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103199 Last 7 Days Time Series report displays incorrect results for the Distinct Value Count function. 

103106 When you import a Teradata source that has a Varchar column longer than 4000 characters, the 
Designer truncates the source definition column to 4000 characters. 

102915 The session log does not contain messages returned by Sybase stored procedures. 

102910 Repository Service does not release locks on workflows. 

102900 See 102521. 

102899 Data profiles created in a previous release may cause the profile session to fail when you run the 
session against a new Data Profiling warehouse. 

102852 Data Analyzer Data Profiling reports display incorrect results for null value count in List of Values 
Domain Inference functions. 

102849 Data Analyzer Data Profiling reports use predefined attribute filter values that do not match Data 
Profiling warehouse content. 

102829 pmrep ObjectImport command fails when you import multiple XML files in sequence. 

102828 See 102543. 

102750 When you import objects into the repository, the PowerCenter Client may overwrite the Lookup 
transformation database connection value. 

102743 A mapping that contains an XML target changes properties when you copy the folder to another 
repository. 

102720 Batch Services WSDLs do not contain the correct URL if the URL schema is HTTPS. 

102698 See 102239. 

102543 Designer hangs when you try to validate or save a mapping. 

102538 The infasetup UpdateGatewayNode command nodeaddress and serverport options do not work when 
specified alone. 

102521 Sessions with a Java transformation, Java Custom transformation, or JMS source or target fail on 64-bit 
Linux. 

102394 Mass changes to service workflows in the Workflow Manager may result in the Web Services Hub 
shutting down unexpectedly. 

102391 See 102210. 

102373 The Web Services Hub may fail to start after you fix a configuration error. 

102276 See 102750. 

102239 Designer shuts down unexpectedly when you import or export a mapping with global shortcuts. 

102210 Workflow Manager fails to respond when you open a session. 

101924 Data Profiling upgrade scripts for Teradata Data Profiling warehouses are not complete. 

101913 See 102521. 

101805 See 104541. 
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101684 Data profiles created in a previous release that contain the Referential Integrity Analysis function cause 
the Integration Service to shutdown unexpectedly. 

101603 Copy Wizard handles null values incorrectly when you select the option to retain persisted values for 
mapping variables. 

101457 DB2 repository does not start on AIX 64-bit platforms. 

101357 The Integration Service sometimes sets the value for workflow variable ErrorMsg to an empty string 
when the associated task completes with an error. 

101335 See CR 102829. 

101134 When you run a session that contains a Sorter transformation, the DTM process may generate a core 
file if the Integration Service cannot allocate enough memory for the sort. 

100864 See 101357. 

100489 See 101603. 

100007 See 101134. 

99953 Error messages REP_57172 appears when you try to run a workflow for a persistent auto profile 
session. 

99669 Sessions with an Oracle source that contain a large number of Aggregator, Joiner, and Sorter 
transformations fail on Solaris with error ORA-12154. 

99659 Cannot run pmrep UpdateSeqGenVals command with Use Designer privilege and write permission on 
folder. 

99547 The Integration Service fails to update an Oracle target that contains an XMLType column. 

99513 Workflow Manager option to get default object during conflict resolution causes session to use incorrect 
mapping. 

99262 See 99513. 

99137 Sessions that load data from a Teradata source to an Oracle target and run on Solaris may fail and do 
not write errors to the session log. 

98525 See 103377. 

98120 Session hangs reading an XML source with two namespaces. 

98120 Session hangs when the mapping contains an XML source and a flat file target. 

97725 See 98120. 

97308 You can configure JNDI connection parameters for SSL security between PowerCenter and a JMS 
provider. 

97051 Automatic failover and restart of application services can occur without the high availability option. 

97050 See 97051. 

97048 See 97051. 

97047 See 97051. 
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96846 See 102915. 

95608 Session fails when an XPath query predicate has a binary operand. 

95595 See 98120. 

95237 See 99953. 

94854 See 94854. 

94679 Integration Service does not generate session logs for temporary profile sessions. 

94303 The pmrep AddToDeploymentGroup command does not work with a manual persistent input file. 

93397 See 94679. 

92330 Business Rule Validation results are truncated in Data Profiling reports you view in Data Analyzer. 

85119 Upgrading PowerCenter repository from version 6.x fails with a constraint violation on table 
OPB_VER_PROPS_IDX. 

85115 Copying a folder with mappings containing shortcuts to mapplets removes links to mapplets. 

84771 getPartitionKeys fails on Linux using PowerCenter Connect API. 

82735 Copying a folder with shortcuts to objects causes folder inconsistencies. 

81027 Error occurs when viewing Data Profiling results with data of CLOB datatype in PowerAnalyzer. 

79968 Error message for rejected fixed-width flat file rows does not contain the width of the rejected value. 

77901 When importing Visio metadata, MIMB does not convert Visio Notes to PowerCenter comments. 

75896 Profile session fails in Finnish locale, because it cannot load the Finnish message catalog. 

64798 The Integration Service reads Byte Order Mark (BOM) information as data when reading and extracting 
data from UTF-8 flat files. 

53972 Copying a folder with shortcuts to objects removes links between sources and source qualifiers in 
mappings. 

103085 The Integration Service on 64-bit Solaris generates a core file when you debug a mapping containing a 
Normalizer transformation. 

103408 The Designer shuts down unexpectedly while opening an XML definition that contains a default 
namespace with no prefix. 

103140 The Integration Service hangs when you debug a mapping containing a mapplet. 

105015 When a workflow is configured to suspend on error, a session succeeds when configured to run after 
two concurrent sessions complete, even though one of the concurrent sessions fails. 

105770 The Integration Service does not fail a worklet or workflow when you set a Control task to fail the parent 
or the top-level workflow. 

8.1 PowerCenter Fixed Limitations 

This section describes PowerCenter limitations that were fixed in version 8.1. 
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CR  Description 

102019 When you specify an invalid target folder in a pmrep object import control file, pmrep creates a new 
folder in the target repository. 

101430 Permissions on the workflow recovery check point file restrict read and write access to the file owner on 
Linux. 

101338 See 96457. 

100673 See 96457. 

99685 See 96457. 

98923 Importing a Web Services Provider target with multiple faults results in improper names for the fault 
targets. 

98720 The Integration Service sometimes generates lookup SQL override queries that contain the distinct 
keyword incorrectly. 

98469 Repository Service loses primary key-foreign key relationships for shortcut target objects when 
importing or exporting a mapping. 

98163 DB2 bulk load sessions do not use Environment SQL attribute for targets (ref 94133). 

98118 PowerCenter does not allow an inheritance relationship between a column and a type view in an XML 
definition. 

98018 Repository Service retains idle database connections for completed workflows until you stop the service 
(ref 92840). 

98005 When a session that loads data using Teradata MultiLoad stops, the Integration Service does not 
terminate the MultiLoad process. 

97841 When you install PowerCenter and join a domain, you cannot set the host name for the node. 

97789 The Designer displays an error when you click help in the Configure for Data Lineage dialog box. 

97629 The PowerCenter installer creates an Integration Service with the wrong administrator user name and 
password when the Integration Service is associated with existing repository. 

97509 A workflow scheduled with a customized repeat option continues to run on days when it is not 
scheduled to run. 

97451 See 84630. 

97312 Data Profiling reports show inconsistent results when the Maximum Allowable Error for Functional 
Dependencies is greater than 50%. 

97298 A user with the Use Workflow Manager repository privilege and Read permission on a folder cannot 
view logs for workflows and sessions in the folder. 

97049 See 96966. 

96966 Sessions containing mapplets sometimes fail when they are configured for pushdown optimization. 

96815 Master service process cannot connect to the node after removing and adding the node back to the 
grid. 
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96813 Master gateway node shuts down unexpectedly while running multiple concurrent sessions. 

96786 Some custom profile mappings must be regenerated after you upgrade to a PowerCenter 8.0 
repository. 

96680 Running the pmcmd getrunningsessionsdetails command when multiple workflows are scheduled to run 
continuously may cause the Integration Service process to stop unexpectedly. 

96457 Workflow Manager shuts down with unexpected condition when attempting to preview pushdown 
optimization results. 

95990 Service Manager does not validate shared directory location for service logs. 

95982 Purging logs does not remove log directories, index files, or files currently in use. 

95758 Sessions that contain a shortcut to a target definition may fail because the Integration Service attempts 
to write data to the target shortcut instead of the target table. 

95646 A session might fail because it cannot delete the state of operation. 

94631 The session and workflow log contain different time stamps when a session completes. 

93998 A session log does not contain the last error message when a session fails. 

93627 Cannot recover or rerun workflow after you abort the Repository Service process or after the process 
quits unexpectedly. 

93453 The Log Events window does not display messages in the same order as they originally appeared when 
you sort the messages by time stamp. 

93397 Integration Service does not generate session logs for temporary profile sessions. 

92954 The Repository Service process sometimes stops unexpectedly when multiple threads try to access the 
same function in a Sybase repository. 

92865 Integration Service process is still running when the Integration Service appears as disabled. 

92771 See 91416. 

92769 See 92954. 

92592 The Integration Service does not drop Sybase database connections after a session completes. 

92572 Incorrect settings in relational connection created for Metadata Manager during installation. 

92551 Integration Service shuts down with unexpected condition when writing to an XML target with multiple 
foreign keys. 

91573 Repository Service may shut down unexpectedly when deploying objects. 

91416 When you create an auto profile on an SAP R/3 source, you receive an error when you try to generate 
the ABAP code for the source extraction in the profile. 

91289 Profile sessions fail on an Informix warehouse (ref 90750). 

91166 In the Designer, when you right-click a source in the Navigator and select Profiling, the submenu 
options can be selected but if you select a submenu item, the Designer displays an error message if 
you have not licensed Data Profiling. 

91145 Data Profiling sessions fail when the workflow name contains a slash character. 
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90531 See 88900. 

89692 In the Metadata Manager Custom Metadata Configurator, you cannot name a template the same name 
as a deleted template. 

89510 PowerCenter erroneously enables rollback on errors for a session configured with target-based commit. 

89470 Debugger options are unavailable for target instances in mappings. 

89400 Repository Service returns multiple error messages when attempting to connect to a repository service 
that is no longer available. 

89354 Metadata Manager Custom Metadata Configurator throws an exception when you map more than 12 
associations. 

89169 If you check out the parent object after you check out and modify a child object, you lose unsaved 
changes in the child object. 

88900 Repository Service does not deploy all objects in a deployment group containing over 1000 objects. 

88802 Repository Service process shuts down unexpectedly when fetching some sessions after you modify 
the mapping. 

88236 Integration Service fails session with Router and Sorter transformation on zLinux. 

87565 Integration Service shuts down unexpectedly during a Debugger session. 

86205 When you run a temporary profile session in the Profile Manager on a mapplet that contains both an 
SAP application connector and a flat file, you cannot specify the file properties and the Profile Wizard 
shows File Reader instead of SAP Streaming Reader for the SAP source. 

86111 Sessions may fail when the associated mapping contains a mapping variable that is followed by a 
constant. 

85792 Deployment fails with a name conflict error if the target folder was modified after the last deployment, 
the source and target folders contain conflicting objects, and you do not select the "folder modified" 
option during deployment. 

85669 When the Repository Service process cannot connect to the repository database, it generates a 
misleading error message. 

85663 Integration Service writes incorrect data to a Microsoft SQL Server target in Unicode data movement 
mode with UTF-8 code page. 

85658 Email sent through PowerCenter does not get stored in the Outlook Sent Items folder. 

85560 The Designer fails with an unexpected error when you drag an XML definition into a mapping. 

85286 Import of mapping fails with invalid-value error in the Designer and Repository Manager when object 
attributes of type Integer contain empty string values. 

85210 When importing objects in the Repository Manager, if you set more than one rule for conflict resolution 
to “all objects,” the Import Wizard uses only the last rule. 

85194 Session may shut down unexpectedly when performing a same-source join. 

85108 The XML Parser transformation does not parse all characters correctly when the session runs in 
Unicode mode. 

85082 You cannot import an exported COBOL copybook with port names that start with numbers. 
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85061 Compare folders does not show differences using colored text. 

84983 Workflow Manager may shut down unexpectedly when copying a mapping that contains multiple 
instances of the same mapplet. 

84712 MX data includes NULL instead of valid field expression when mapping contains Normalizer 
transformation. 

84630 Repository Service process fails when copying a deployment group. 

84447 Import of mapping with MQSeries source causes missing-port-type error in the Repository Manager. 

84261 See 83583. 

84024 If a Data Profiling warehouse is in a repository configured with external authentication procedures, the 
Workflow Manager fails to validate the Integration Service connection when running an auto profile 
session through Profile Manager. 

83978 See 91573. 

83680 If a session fails to load a Custom transformation external library that has dependencies on another 
library, the session log does not list the reason for load failure. 

83583 A partitioned Lookup transformation uses the same database connection instead of multiple parallel 
connections. 

82482 The Files, Directories, and Commands section on the Mapping tab of session properties is incomplete. 

81526 PowerCenter Email tasks fail with earlier version of mapi32.dll. 

76766 See 81526. 

76116 Deployment fails with a unique constraint error instead of a name conflict error when you deploy a 
deployment group containing a modified shortcut that conflicts with a shortcut in the target folder. 

51913 Workflow Monitor hangs when it reads a session log greater than 1 GB. 

 

8.0 PowerCenter Fixed Limitations 

This section describes PowerCenter limitations that were fixed in version 8.0. 

CR  Description 

94408 Session hangs when the PowerCenter Server runs on Linux. 

93939 A session fails when it is configured to log source row data and the mapping contains a hash auto-key 
partition. 

93638 The Profile Manager crashes when you add more than three join conditions to the Orphan Analysis 
(Referential Integrity Analysis) function. 

93569 A session fails with a SIGSEGV (11) error on HP-UX when writing to an XML target if the foreign key of 
a derived group is not projected. 

93342 Mapplet in deployment group does not retain connections after you copy the deployment group to 
another repository. 
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91839 Session using Teradata Multiload fails with an assertion when the target table contains column names 
that start with “CF”. 

91581 Session remains invalidated after the invalid mapping is fixed and saved. 

91572 Mapping with an output port misidentified as an import port causes the pmrep ObjectExport command 
to abort and creates an unexpected condition error in the Repository Manager during object export. 

91226 Unexpected condition error occurs when you export a session with a source connection variable, 
rename the source in the repository, and then import the session into the repository, replacing the 
original. 

91125 Import of Lookup transformation does not retain connection variables. 

91121 Loading to Teradata using Multiload, TPump, and Teradata Warehouse Builder external loaders fails 
when the precision is greater than 15 for a decimal column. 

91099 Transformation contains some invalid characters in mappings where the source transformation 
character column size is greater than the physical database character column size. 

91042 Session shuts down unexpectedly when performing a sorted join. 

91038 Teradata external loaders hang on UNIX. 

91035 Sessions upgraded from PowerCenter 6.2.1 product different results when they contain Aggregator 
transformations that produce multiple rows. 

91034 When using a trusted connection, you cannot specify a Windows user for the relational connection to a 
SQL Server database. 

91030 Inconsistent Joiner output when switching Master and Detail sources. 

91028 Session may fail with unexpected condition when the Session Retry on Deadlock property is selected. 

91027 See 83660. 

90575 See 79313. 

90573 Database error occurs when you delete a large number of ports from a source or when you save a filter 
condition that has over 2000 characters. 

90569 Navigator does not indicate when a parent object contains shortcuts to invalid child objects in another 
folder. 

90543 See 86280. 

90538 Repository Agent hangs when copying folders between repositories. 

90536 See 88402. 

90533 Unexpected condition occurs when you use Teradata Multiload external loader. 

90529 The PowerCenter Server removes white space from XML source data. 

90527 A session containing a Router transformation hangs when the transformation drops all rows of data. 

88939 See 85626. 

88586 When a data profile contains two sources and the Domain Validation function is applied to one of the 
sources, the Data Profiling report shows verbose data for both sources. 
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88549 Stored Procedure on Oracle database fails with Oracle error ORA-06502. 

88526 See 90566. 

88402 The XML error action file does not work in XML sessions. 

88242 Sessions hang when you use target database partitioning with a DB2 target. 

88125 ODBC connection with UTF-8 code page and Unicode data are not handled correctly. 

88122 Dynamic Lookup transformation sessions fail when Output Old Value On Update is not selected. 

88079 The cache does not refresh after you change properties in a flat file dynamic Lookup transformation. 

87933 The PowerCenter Server generates a core file when an XML foreign key is not projected. 

87832 See 88242. 

87429 See 90538. 

87366 See 86838. 

86838 The PowerCenter Server creates null values for elements in some rows of an XML source. 

86655 Session fails because of a CRC error when PowerCenter Server runs on HP-UX. 

86631 Session fails if last row in a fixed-width flat file source does not have a carriage return. 

86566 Designer fails to validate count aggregation type mapping variables that use SETMAXVARIABLE, 
SETMINVARIABLE, or SETCOUNTVARIABLE in a reusable transformation. 

86444 Correct repository name does not appear when you compare objects in a repository with objects in a 
copy of the repository. 

86440 See 86444. 

86389 When row error logging is enabled, database fatal errors are not sent to the session log. 

86280 PowerCenter join syntax converted incorrectly and session fails when running a user-defined join 
against a Teradata database. 

86078 Designer does not indicate that a mapping is invalid until the mapping is fetched to the workspace. 

85727 The Designer displays the following error when you open a folder: 

Unexpected condition at RCMapping.cpp:676 

85662 A session fails with the an unexpected error when the data row size of the input row is larger than the 
cache size. 

85656 The Debugger displays the following message when you configure it to truncate target tables: 

The value must be greater than or equal to 0 and less than or equal to 0 

85628 The PowerCenter Server produces inconsistent results when reading from a fixed-width flat file and 
writing to a relational target. 

85577 The repository does not save ports in a Union transformation when you copy them from a Source 
Qualifier transformation. 
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85539 DB2 repository fails to upgrade. 

85263 See 90573. 

85211 The Repository Manager fails to import XML files with duplicate objects. 

85201 Workflow Monitor displays duplicate Integration Service names when you copy a folder to another 
repository and you copy the session or workflow run history. 

85196 See 91028. 

85188 Errors occur in the Designer when you open folders you do not have permission on. 

85147 The Designer enables Ignore in Comparison when you do not select it. 

85061 Compare folders does not show differences using colored text. 

84983 Workflow Manager shuts down unexpectedly and displays incorrect message when copying a session 
that contains a mapping with multiple instances of the same mapplet. 

84697 See 91226. 

84617 See 84983. 

84578 See 91030. 

84480 See 90573. 

84305 See 84100. 

84175 See 91038. 

84142 The Workflow Manager indicates that a mapping containing a mapplet is invalid, but does not indicate 
when a mapplet within the mapping is invalid. 

84100 Full and master outer joins produce incorrect output when duplicate values are present in the master 
source. 

84047 See 91581. 

83964 See 90569. 

83926 See 91572. 

83797 Session containing a Joiner transformation shuts down unexpectedly with a fatal error. 

83782 Joining data from a single-source fails when the PowerCenter Server runs in ASCII mode. 

83660 Cannot reimport Custom transformations or transformations built on the Custom transformation that 
have been updated. 

83468 See 83343. 

83343 The PowerCenter Server might not output data when the XML definition contains a circular hierarchy 
relationship. 

83256 SQL queries, user-defined joins, and source filters may appear truncated in the SQL Editor when you 
have read-only privileges on the repository folder. 
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82914 Cannot prevent Integration Service from printing FR_3015 error messages to the session log. 

82902 See 91042. 

82871 See 90527. 

82332 PowerCenter Server and Repository Server installation sometimes fail with the following error: 
Overlapped I/O operation in progress. 

82237 Mappings that contain a Custom transformation or transformation built on the Custom transformation 
are marked valid when the transformation receives input from a Sequence Generator transformation. 

82091 See 91121. 

81779 Session hangs when it is configured for target-based commit and constraint-based load ordering. 

81761 See 91125. 

81650 You cannot designate the folder owner when you copy a folder to another repository. 

81356 In the Debugger, changing a port to a null value replaces the data in another port in the downstream 
transformation. 

81320 A session creates an invalid XML target file when the source is empty. 

80402 Oracle external loader sessions write the following message to the session log in error: 

DBG_21388 Oracle Version not set so setting dbversion to [8] 

80378 A reusable Lookup transformation with an SQL override fails a session when a single quote ' is used to 
pass a value to one of the ports. 

80363 See 51084. 

79854 Import of a session changes some valid session attribute values to invalid default values and displays a 
warning message. 

79418 Session performance slows when PowerCenter Server on Solaris creates multiple threads to read fixed-
width source. 

79380 “Failed to load DLL” error messages may display when opening the Designer if you install a new version 
of the PowerCenter Client on the same machine as an older version of the PowerCenter Client. 

79350 The INFA_CreateLocale function in LMAPI returns an invalid code page ID error. 

79313 Hypertext links in transformation objects do not work. 

77553 The Designer fails due to a lack of system resources when you iconize an XML mapping. 

77525 Session containing lookup SQL override shuts down unexpectedly while parsing Lookup override SQL 
statements. 

76493 FTP response not included in session log. 

75440 See 75439. 

75439 Cannot terminate user connection to the repository or list user connections to the Repository Service 
using pmrep. 

75067 Error threshold does not count errors in variable ports. 
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73280 Compare Folder Wizard is not available to all users who have the Browse Repository privilege. 

72610 ABORT function message does not display in the session log when the session is run with the terse 
tracing level 

72607 PowerCenter Server does not immediately fail sessions when fatal database errors occur. 

71507 Session calculations that convert a Double value to a String or Decimal value may have a rounding 
problem in the last digit when high precision data handling is not enabled. 

71165 Exporting an XML object that contains AnySimpleType returns errors and fails. 

69538 Startup of PowerCenter Server fails if IP address of the server differs from the address stored in the 
repository. 

66229 Database connection name does not appear in session log. 

65762 Data Profiling client does not support Japanese characters. 

64421 The Integration Service truncates data to 255 characters when it reads a Sybase Varchar(950) column. 

61750 Cannot configure the function column precision for string and integer datatypes. 

60652 Repository Agent might fail to save XML source definition. 

58180 The Profile Sources page of the Profile Wizard does not allow you to select multiple sources at the 
same time. 

51396 See 51084. 

51084  A session hangs when it receives a multiple line response from an FTP source on AS/400. 

44206 When a mapping uses a mapplet, and the mapplet has shared objects, the mapplet dependencies are 
not shown under the mapping dependency list. 

 

Data Analyzer Fixed Limitations 
This section describes fixed limitations to Data Analyzer. 

8.1.1 SP5 DataAnalyzer Fixed Limitations 

This section describes DataAnalyzer limitations that were fixed in version 8.1.1 SP5. 

 

CR  Description 

178418 If a data connector is configured with two instances of the same data source where one data 
source has a time dimension and the other does not, editing the data source with a time dimension 
results in an exception. 

176014 Creating a cross-tab report with aggregation for 13 columns and 15,000 rows leads to a 
StackOverFlow error.   
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174909 

 

Concurrent logins to Data Analyzer result in the following error message: 'userLimitExceeded=1' if 
the number of licensed concurrent users is exceeded. Users who were logged in concurrently can 
no longer log in. 

174849 

 

Attempting to use ‘Save As’ to save a  workflow report from one folder to another displays the 
following duplication exception: "This name is already in use. If it is not listed, you do not have the 
appropriate permissions." 

174625 If the system date is configured using “Today” with “System Time,” the system date does not get 
updated correctly 

173881 Using the API to update dashboards created using Data Analyzer with the layout "row and 2 x 2 
cell" or layout "2 x 3 cell" results in an exception. 

173077 Data Analyzer does not parse custom metric expressions if the attribute includes the parentheses. 

172982 A limit of 19 characters is applied to the table name if you use the Add button to add an existing 
table to an operational schema without selecting the 'Prefix the table names with’ option. This limit 
also applies to new operational schemas created. 

170346 Data Analyzer does not allow cycles in group definitions. 

134894 During LDAP synchronization, when Data Analyzer is unable to retrieve information about a user, it 
deletes the user from the Data Analyzer repository. 

134161 For analytical schemas, Data Analyzer does not export custom attributes into the schema XML. 

 

8.1.1 SP3 DataAnalyzer Fixed Limitations 

This section describes DataAnalyzer limitations that were fixed in version 8.1.1 SP3. 

CR  Description 

 134690  If you change the time setting from Current Year to Date in a report upgraded from 4.1.1 to 8.1.1, Data 
Analyzer returns IndexOutOfBounds exception. 

 134275 The Export to PivotTable option generates a Microsoft Excel sheet with field names and no supporting 
data. 

 133502  When five concurrent users run large reports, the reports for some users do not display and Data 
Analyzer hangs. 

 133422  Cannot add new users to Data Analyzer due to license error. 

 108958  Log in through API in Data Analyzer returns stack trace error. 

 

8.1.1 SP2 DataAnalyzer Fixed Limitations 

This section describes DataAnalyzer limitations that were fixed in version 8.1.1 SP2. 
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CR  Description 

133634 Users choosing Korean language under Manage Account see Unicode escape character values instead 
of Korean characters. 

131552 Data Analyzer displays blank pages when you open very big reports. 

131206 You can log in to Data Analyzer through a deleted admin account. 

131204 Users can log in with old passwords after changing the password using Manage Account.  

131063 The top of the Filterset tree is not available to select the filterset.  

130816 See 108978. 

130815 See 130713. 

130714 See 108978. 

130713 Schedules are not reset properly when Data Analyzer is stopped and restarted. 

130614 An inconsistent personal folder entry or the deletion of a user causes metrics to disappear. 

127301 The upgrade utility returns a PRIMARY KEY constraint error when Data Analyzer is upgraded from 
version 4.1.1 to 8.1. 

127181 If the width of a metric is changed in the Formatting tab of a complex report, it reflects only for the metric 
heading in the Analyze tab.  

108978 Data Analyzer configured for LDAP does not synchronize the groups present in the active directory. 

108958 Login through API returns stack trace error. 

108880 Drill down of a report using a custom metric and time dimension returns a NullPointerException error.  

108709 You cannot change the year when running some reports.  

108514 There is no date format control in the Date Format field in the Manage Accounts > Report Preferences 
page. 

108015 Oracle error “ORA-00907: missing right parenthesis” when a workflow report is viewed. 

107989 Schedules upgraded from version 4.1.1 to 5.0.2 do not run due to a configuration problem in JBoss. 

107906 Custom metrics do not display in the correct order in indicators and charts. 

107420 When a report is exported using the Hide Metrics attribute, the PDF or the CSV output is incorrect. 

107273 Users with only Manage User Access privilege cannot apply data restrictions. 

106108 The Print and Export links on a report do not work properly in the Firefox 1.0.5 browser. 

 

8.1.1 Data Analyzer Fixed Limitations 

This section describes Data Analyzer limitations that were fixed in version 8.1.1. 
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CR  Description 

107234 You cannot import a source table from Microsoft SQL Server 2005. 

105652 Reports that contain a large number of attributes may display incorrectly on the Analyze tab. 

105195 Composite reports do not correctly display non-English characters. 

103249 When using a non-Oracle data source, exception may occur when you open reports containing CLOB 
attributes. 

103174 Data Analyzer displays an incorrect message when a user’s LDAP password is about to expire. 

103067 Data Analyzer encounters an error when it synchronizes users in the LDAP Microsoft Active Directory 
Service. 

102846 Filter Identifier displays CLOB columns. 

102645 Data Analyzer cannot flush the cache on nodes in a cluster. 

102379 Data Analyzer cannot flush the global cache on nodes in a cluster. 

102143 A user can access reports after the user is removed from the group that has access to the reports 

101023 Users without the Access Advanced Report Creation privilege can set provider-based security for 
reports. 

99799 On WebSphere and Microsoft SQL Server, the Data Analyzer API encounters a deadlock when multiple 
concurrent users create reports. 

99094 If you create a dashboard filter for attribute values that include special characters, the attribute values 
may display incorrectly when you apply the dashboard filter on the View tab. 

98194 Data Analyzer does not display the double line before the sum line in report results. 

97931 Documentation for gridline density algorithm is incomplete. 

97218 You cannot change the permissions on an imported report that is owned by a deleted user. 

94840 In the Data Analyzer API, the IASDashboardManager service returns dashboard objects without 
checking for access permissions on content folders. 

94511 Data Analyzer may encounter an occur when you change the time period when adding a time setting to 
a report. 

90201 Existing applications in a WebLogic domain may encounter problems when you install Data Analyzer on 
the same domain. 

88754 If you create a custom metric for a report and the metric expression consists of an attribute only, Data 
Analyzer encounters an error when you click the Formatting tab in the Create Report Wizard. 

84419 Data Analyzer cannot successfully synchronize users for LDAP authentication in a WebSphere cluster. 

 

8.1 Data Analyzer Fixed Limitations 

This section describes Data Analyzer limitations that were fixed in version 8.1. 
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CR  Description 

102708 Data Analyzer returns a missing parenthesis exception when you drill down from a primary report to a 
sub report. 

100909 See 98320. 

100908 Time filter on workflow report results in an error. 

100179 If you configure a comma as a filter condition, the data restrictions do not work. 

99379 Problem ranking attribute with single quote in name. 

99252 Too many rows returned when you run a report with metric based on Time Dimension table that has 
date and time in separate tables. 

98412 When you move your mouse over charts or chart indicators, a script error appears. 

99189 Report scroll-bar is not working correctly with Internet Explorer on Windows XP SP2. 

98628 On the Analyze tab, sorting on an attribute/metric header does not work. 

98320 Problems sorting data on ranked report. 

98294 Highlight for sum field is not displayed in the dashboard. 

98101 Global variable with less than or greater than condition results in an error in the report for the date 
attribute. 

98065 Transaction times out when you delete an Operational Schema folder. 

97942 The headers and footers are too small in the PDF output of some reports. 

97941 If you configure long descriptions in dashboards, the text does not wrap correctly. 

97651 For Data Analyzer on the AIX platform, you must set the JAVA_HOME environment variable before you 
run the Data Analyzer EAR repackager utility. 

97500 When you filter a date attribute to be less than or equal to a global variable, Data Analyzer returns the 
wrong dates. 

96615 Repository issues upgrading from 3.5 to 4.1.1 to 5.0.1 on Oracle 8.1.7.4. 

89189 Documentation for dashboard filters option No Filter is incorrect. 

87732 Session fails with inner class of a Java transformation. 

86790 Blank page is exported to Excel (retain PA formatting) if the report name is exactly 32 characters. 

81714 Custom attributes created in the Schema Directory incorrectly display in the dimension tables. 

8.0 Data Analyzer (PowerAnalyzer) Fixed Limitations 

This section describes the Data Analyzer (PowerAnalyzer) limitations that were fixed in version 8.0. 
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CR  Description 

96179 Exception occurs when trying to access the Administration tab after refreshing a gauge indicator on a 
Dashboard in SVG mode. 

95257 Too many rows returned when you run a report with metric based on Time Dimension table that has 
date and time in separate tables. 

94958 % in a filter value throws exception. 

94747 When you select an attribute value for dashboard filter, the tooltip displays the correct metric but the 
attribute values is always the first one. 

94687 Precision for Stdev function does not match format settings in report. 

94599 Not able to use system variable '$USER_LOGIN$'. 

94592 Exception occurs if you run a report with time settings between dates and for N years and try to view 
aggregate data. 

94344 Trusted Party Sign On through API does not work. 

93765 When you import a schema from an XML file where the Last Table property is corrupted, Data Analyzer 
replaces the table’s properties with the table column properties. 

93279 Upgrade fails for certain reports containing timestamp. 

91964 Exception occurs when you click an advanced chart option for a report with ranking. 

91895 Exporting reports with attributes to pdf results in blank page. 

91728 If Global Caching is turned ON, database dependent expressions do not work properly for Operational 
Schemas. 

91504 For report format, if you use a space as the grouping symbol for numeric data, Data Analyzer trims the 
space and numeric data displayed without a separator. For example, 1 456 789 displays as 1456789. 

88379 Data lineage is not supported for real-time reports. 

86524 Exception occurs when you create a custom attribute from the Analyze tab. 

84223 Data Analyzer allows users to delete all data connectors. 

83586 Cannot have Sunday as the first day of the week for time-based schedules. 

81895 Cannot use display setting for series label name for a chart or chart indicator in a report with an HTML 
datatype attribute. 
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Metadata Manager Fixed Limitations 
This section describes fixed limitations to Metadata Manager. 

8.1.1 SP5 Metadata Manager Fixed Limitations 

CR  Description 

179560 The Metadata Manager Console hangs when you import models from a Cognos ReportNet Content 
Manager source repository. 

179329 The Metadata Manager Console does not handle non-English characters correctly. 

178895 Data Lineage does not show dependent objects for shortcut sources. 

177221 Data Lineage does not show lineage for a source used in mapplet if the mapplet is not contained in 
mapping. 

176571 The S_M_FEATURE_MAP_LOAD session rejects records when a mapping contains multiple instances 
of a mapplet that use the same flat file source. 

168802 A S_M_ALLDB_VIEWPROCFN_DEPS_EXTRACT session fails when you run PowerCenter 64-bit and 
the Microsoft SQL Server source repository has stored procedures and functions. 

8.1.1 SP3 Metadata Manager Fixed Limitations 

This section describes Metadata Manager limitations that were fixed in version 8.1.1 SP3. 

CR  Description 

 135748  The Microstrategy XConnect fails because it cannot parse a special character in the XML file. 

 

8.1.1 SP2 Metadata Manager Fixed Limitations 

This section describes Metadata Manager limitations that were fixed in version 8.1.1 SP2. 

CR  Description 

133801 When you remove all projects from the source repository connection for the Microstrategy XConnect 
and run the XConnect, the Metadata Manager Console loads the metadata configured for the previous 
XConnect run. 

133797 The Metadata Manager Console does not display any error message and sometimes loads incorrect 
data when it cannot write IME files to the Integration Service directory. 

133292 The PowerCenter XConnect truncates SQL Override queries and loads up to 2000 characters. 

131668  See 130845. 

131633 See 130841. 
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130849 When you try to generate the mapping for a custom XConnect, the Custom Metadata Configurator fails 
to generate the mapping and displays the following error: String index out of range: -1. 

130848 See 133797 and 133801. 

130847 Data lineage on a PowerCenter source definition does not show connections to Oracle objects. 

130845 Data lineage on an ERStudio object does not show connections to Oracle objects. 

130841 When the Metadata Manager Warehouse runs on an Oracle database and you schedule an XConnect, 
Metadata Manager opens a connection to the database but never closes it. 

130840 Cannot run data lineage on a shortcut to an object in the Metadata Manager Warehouse. 

130141 When you import an RFC/BAPI module to the repository, the port name is invalid. 

127145 When you click a report link for workflow report in Metadata Manager, the DataAnalyzer login page 
displays. 

108266 PowerCenter XConnects fail on HP-UX. 

108073 Metadata Browser does not display objects from a Metadata Manager Warehouse on SQL Server 2005 
if the folder contains more than 100 objects. 

107941 See 107932. 

107932 Data lineage diagram does not display the entire mapping when the mapping contains a lookup on a 
target table. 

106398 The PowerCenter XConnect may not load correct PowerCenter operational data for workflow runs from 
a versioned repository. 

 

8.1.1 Metadata Manager Fixed Limitations 

This section describes Metadata Manager limitations that were fixed in version 8.1.1. 

CR  Description 

105069 PowerCenter XConnect fails when the PowerCenter repository for Metadata Manager resides on a 
Sybase database. 

104537 Custom objects appear at the same level as their parent objects in the Metadata tree when you first 
create them. 

103876 An error occurs when you click the Add button to add an Erwin 4.x ER1 source file to the XConnect in 
the Metadata Manager Console. 

103556 The ERwin XConnect fails because it cannot resolve the repository ID. 

103322 The XConnect does not fail when it encounters IME file errors. 

102941 WebSphere Application Server on Solaris 9 runs out of memory when running Data Analyzer and 
Metadata Manager. 

102927 The installer installs duplicate files in the PowerCenter Client directory and the Upgrade folder under the 
Metadata Manager installation directory. 
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102602 Data lineage shows an error when the number of objects in the lineage diagram exceeds the limit. 

102137 You can assign parameter files to a maximum of 255 workflows in the Metadata Manager Console. 

100963 Cannot access the Parameter Setup tab after configuring the source repository connection for 
PowerCenter, Data Analyzer, or database XConnects. 

100920 Assigning a large number of parameter files to workflows in the PowerCenter 7.x XConnect may cause 
an error. 

98877 The Metadata tree does not list all objects in a subgroup in alphabetical order. 

88836 Column names of metadata files cannot contain special characters. 

 

8.1 Metadata Manager Fixed Limitations 

This section describes Metadata Manager limitations that were fixed in version 8.1. 

CR  Description 

101250 Workflows that contain an Email task fail. 

99327 Erroneous message appears when you try to access the Data Lineage report or Where-Used Analysis 
report without permission. 

97468 Sybase Power Designer metadata may not appear in the Metadata Directory after upgrade from 2.1 to 
2.2. 

97279 Triggers that are imported from another Metadata Manager instance do not show the complete data 
lineage. 

96794 Cognos ReportNet Content Manager XConnect fails with an Unknown Tag error. 

96567 Resume option does not start XConnects from point of failure if the XConnect is a Miti-based XConnect. 

90630 Metadata Manager server hangs when trying to create a new object in the Create New Object page. 

86241 Data lineage and where-used analysis does not appear correctly for Teradata tables that have names 
with lowercase letters. 

85977 Each data modeling tool XConnect truncates the description of a metadata object if the description 
contains a double quote. 

84974 When you view the query used to display an ODS report in Metadata Manager, multiple FROM and 
WHERE statements and an invalid hyperlink appear in the query. 

83756 Erroneous message appears when you cancel the option to specify a file transfer directory in the 
Metadata Manager Console. 

83479 The Microstrategy, Cognos ReportNet Content Manager, Cognos Impromptu, DB2 CubeViews, 
Hyperion, Business Objects, Data Analyzer, and data modeling tool XConnects extract metadata twice 
from the source repository with each XConnect run. 

83179 The Microstrategy XConnect does not extract hidden metadata objects. 
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8.0 Metadata Manager (SuperGlue) Fixed Limitations 

This section describes the Metadata Manager (SuperGlue) limitations that were fixed in version 8.0. 

CR  Description 

97386 When you run the Microstrategy XConnect, an error appears if the name of the Microstrategy project 
uses special characters. 

95631 You cannot resize the height of the Details task area on the Metadata Directory page. 

94873 If you try to save source connection information in Metadata Manager Console for an XConnect that 
requires a database connection and the database connection fails, the error message dialog box shows 
the database password. 

94434 When you run the PowerCenter XConnect and try to assign a connection to an Informix database, a 
JDBC error appears. 

93897 First row of data does not load if the source file does not contain column headers. 

93886 The ObjectImport pmrep command fails when you try to generate the mappings from the Custom 
Metadata Configurator because the Custom Metadata Configurator does not copy the DTD file and 
control xml file to the source directory. 

93816 In the Metadata Manager Console, the Operational Metadata Extraction option in Parameter Setup tab 
should not be enabled by default. 

93758 Data lineage does not show correctly for PowerCenter Source Qualifier transformations that use 
parameters in SQL overrides. 

93749 Data lineage does not show correctly for Lookup transformations that use parameters in SQL overrides. 

93313 Data lineage does not show for Table Trigger objects for Microsoft SQL Server and IBM DB2 
databases. 

93310 Data lineage does not show for View Trigger objects for Oracle, Microsoft SQL Server, and IBM DB2 
databases. 

93286 The filter condition in the Metadata Browser is not applied properly to objects with no links. 

93090 Metadata Manager Console should not drop indexes when another workflow is running. 

92979 The real parent name does not display in the lineage diagram for a PowerCenter mapping object when 
the mapping has multiple sessions. 

92606 If the Metadata Manager Warehouse and PowerCenter repository are on Microsoft SQL Server 
databases and you run the PowerCenter 7.x XConnect, the sessions 
S_M_PC7X_FF_OBJECTS_STAGE and S_M_PC7X_LKP_SESS_INST_CNX_DERIVE fail. 

92326 Data lineage does not show completely for data structures used in database stored procedures. 

92096 The Daily schedule is not assigned for some Metadata Manager operational reports. 

92091 If you upgraded to Metadata Manager 2.2, data lineage does not display between Hyperion and Oracle 
or IBM DB2 CubeViews and Oracle. 

91994 The PowerCenter mappings generated by the Custom Metadata Wizard do not populate all custom 
class properties. 

91993 See 91994. 
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91786 Data modeling tool reports may not show results for Embarcadero, ERStudio, or IBM Rational Rose ER 
source repositories. 

91197  Metadata Manager hangs when you click on the object icon and you do not have read permission on 
the object. 

91165 The wrong join expression is used for the IMA_STATUS view. 

90849 The keys in the IMW_TASK_LOG and IMW_TASK_STRUCT tables are not resolved. 

90848 See 90849. 

90635 XConnect loads may fail if the Metadata Manager Warehouse is on Oracle 9i and the Oracle client is 
10g. 

90388 The Custom Workflow Configuration tab in the Metadata Manager Console should not show Informatica 
CWMX as one of the repository types. 

90051 Some fields become blank when you click OK in the Edit Package or Edit Classes page. 

90042 Metadata Manager displays an internal server error message when you click the OK button on the Edit 
Class page for a custom class. 

89441 The SQL override for the lookup LKP_IMW_CLASS_ATTR in the mapping 
M_ELMNT_ATTR_EXTRACT does not use a parameter. 

89366 The child objects of subgroups do not display in the Results task area for Business Objects and ERwin 
metadata. 

89355 In the Associations Mapping page, you cannot see the names of the From and To classes and 
associations because the columns are not resizable. 

88967 Custom XConnect runs WF_STATUS when it should not. 

88836 The PowerCenter mapping import fails if the source file has column names with special characters. 

88269 Multiple source repositories cannot be registered for the same custom repository type in the Metadata 
Manager Console. 

87599 Data lineage does not display for public synonyms. 

86819 Scroll bar does not appear when you resize the Custom Metadata Configurator window. 

86684 See 89366. 

84885 The IMC_XCONN_TYPE table shows the old name for the Teradata staging workflow. 

78535 See 90635. 

75043 See 90635. 

 

Third-Party Limitations 
You may encounter the following limitations related to third party and platform products that you use with 
PowerCenter. If you encounter difficulties or have further questions regarding one of these limitations, 
contact Informatica Global Customer Support and reference the CR number. 
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BEA Weblogic  

CR 107795: Data Analyzer and Metadata Manager with BEA WebLogic Server do not run on 
a Windows Itanium 2 system 
WebLogic 8.1 Service Pack 5 includes BEA JRockit SDK 1.4.2_8. However, a Windows Itanium 2 system 
requires BEA JRockit SDK 1.4.2_11. 

Workaround: Install BEA JRockit SDK 1.4.2_11 to replace the earlier version. 

Data Direct 

CR 88536: Integration Service truncates large string data when writing to Microsoft SQL 
Server using the Data Direct wire protocol ODBC driver 
The Integration Service truncates string data under the following conditions: 

 The target database connection uses the Data Direct wire protocol ODBC driver for Microsoft SQL 
Server. 

 The Integration Service writes a very long string to a string column. 

Workaround: On Windows, either use the native Microsoft SQL Server database drivers or the Data Direct 
ODBC driver for Microsoft SQL Server that does not use the wire protocol. On UNIX, contact Informatica 
Global Customer Support and ask about Data Direct Support Case 15016960. 

HP-UX 

CR 133051: Repository Service process hangs when running on a 32-bit HP-UX machine 
and you use Oracle client 10.2.0.3.   
When you use the Oracle client version 10.2.0.3 to connect to the repository on a 32-bit HP-UX machine, 
the Repository Service process hangs.  

Workaround: Apply HP patch PHCO_36229. 

CR 107488: Memory allocation error occurs when cache size for an Aggregator or a Rank 
transformation is greater than 4 GB 
If the Integration Service process runs on a 64-bit HP-UX machine with a PA RISC processor and the 
aggregator or rank cache exceeds 4 GB, an error occurs and the Integration Service writes a message 
similar to the following message in the session log: 

FATAL 8/17/2006 5:12:21 PM node01_havoc *********** FATAL ERROR : Failed 
to allocate memory (out of virtual memory). ***********  

FATAL 8/17/2006 5:12:21 PM node01_havoc *********** FATAL ERROR : 
Aborting the DTM process due to memory allocation failure. ***********  

Workaround: By default, a 64-bit HP-UX machine with a PA RISC processor allocates up to 4 GB of 
memory per process. If a session requires more than 4 GB of memory, increase the maximum data memory 
limit for the machine using the maxdsiz_64bit operating system variable. For more information about 
maxdsiz_64bit, see http://docs.hp.com/en/B3921-90010/maxdsiz.5.html. 

CR 106705: After installation, JBoss Application Server on 64-bit HP-UX PA-RISC 
machines fails to start. 
When you install Data Analyzer or Metadata Manager on JBoss Application Server on a 64-bit HP-UX PA-
RISC machine, the application server starts. If you shut down the application server and restart it, the 
application server fails to start. 

http://docs.hp.com/en/B3921-90010/maxdsiz.5.html�
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Workaround: Add the following line to run.sh before you restart JBoss Application Server: 
SHLIB_PATH="PCInstallDir/java/jre/lib/PA_RISC2.0W:PCInstallDir/java/jr
e/lib/PA_RISC2.0W/hotspot:${SHLIB_PATH}" 

CR 101657: When running multiple concurrent sessions on HP-UX Itanium, the system 
returns out of memory errors and sessions may shut down unexpectedly 
The DTM process for a session may use excessive memory on HP-UX Itanium, even when no 
transformation is configured with a large cache size. An individual session may succeed but the overall 
system utilization is impacted because other applications requiring memory may have little or no memory 
available. 

If you run multiple sessions concurrently, each DTM process uses excessive memory resulting in some 
sessions shutting down unexpectedly. 

Workaround: Install HP patch PHSS_33349. 

CR 99558: Repository Service shuts down while copying a large folder on HP-UX 
The Repository Service fails when copying a large folder from one repository to another on 32-bit HP-UX 
PA-RISC machines. The virtual memory size can grow to over 1 GB when you copy large folders. 32-bit 
HP-UX PA-RISC limits the virtual memory size to 1 GB. 

IBM AIX 

CR 127630: pmrepagent process generates a core file on AIX 5.3 64-bit 
The pmrepagent process may generate a core file on AIX 5.3 64-bit. 

Workaround: Install APAR IY83580, available from the following web site: 
http://www-1.ibm.com/support/docview.wss?uid=isg1IY83580 

CR 105650: The Load Balancer reads the available memory as zero on nodes running 
AIX 5.2 
On nodes that run AIX 5.2, the Load Balancer may read the amount of available memory as zero, even 
when there is free memory on the node. 

Workaround: If you use adaptive or metric-based dispatch mode, make sure the node is running 
AIX 5.2.0.14 or higher. 

CR 85167, 85159: Cannot start a 32-bit Repository Service process when using an Oracle 
database on AIX 5.3 
The Repository Service cannot load dynamic libraries and fails to start when you use an Oracle database on 
AIX 5.3. The problem results from an issue with the ldopen() call of AIX when a program is compiled with 
the following compiler option: 

-b maxdata=0x80000000/dsa 

Workaround: Issue the following command on PowerCenter.binary files to prevent an ldopen() call in that 
file from failing: 

/usr/ccs/bin/ldedit -b maxdata=0x70000000/dsa pmrepagent 
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IBM DB2 

CR 103881, 100706: Sessions fail that run on 64-bit AIX or HP-UX IPF and connect to an 
IBM DB2 8.2 source using IBM DB2 8.1.0.64 or 8.2 client libraries 
If you run a session on a 64-bit AIX or HP-UX IPF machine and connect to an IBM DB2 source using IBM 
DB2 8.1.0.64 or 8.2 client libraries, the session fails. 

Workaround: Apply Fixpack 12 from IBM to the 64-bit AIX or HP-UX IPF machine. 

CR 95718: A session fails when it has a key range partition on a date field from a DB2 
source 

A session running a DB2 8 client fails when the session has a key range partition on a source date field. 

Workaround: Use pass-through partitioning instead of key range partitioning. Create an SQL override and 
define the date ranges in the WHERE clause as follows: 

SELECT [...] FROM db2source WHERE db2source.date <= '2001-01-01' 
SELECT [...] FROM db2source WHERE db2source.date >  '2001-01-01' AND 
                                  db2source.date <=  '2002-01-01' 

CR 81462: Integration Service may load incorrect data when target definition column order 
does not match target table column order 
If you run a DB2 bulk load session when the target definition column order does not match the target table 
column order, the Integration Service may load incorrect data into the target table and may not write an 
error message to the session log. 

Workaround: Verify that the column order in the target definition matches the column order in the target 
table. Run the DESCRIBE TABLE command to identify the target table column order. Or, use the 
Designer to import the target table definition. 

CR 74822: Repository Service process shuts down unexpectedly during repository restore 
from command line on IBM DB2 8.1 
The Repository Service process might shut down unexpectedly if you use pmrep to restore a repository and 
you are using an IBM DB2 8.1 client. 

Workaround: Install the DB2 8.1 client fix pack 5 that is available from http://www.ibm.com/support/us/. 

CR 73796: Session fails using bulk load to load to a DB2 table 
The session fails using bulk load to load to a DB2 target when the table name contains Japanese characters. 

CR 57810: Bulk load session hangs in Unicode mode 
When bulk loading to DB2, the session may hang if the data contains CLOB datatype. 

Workaround: Run the session in normal mode or use the IBM DB2 EEE external loader to load data. 

CR 50375, 49780: Sessions using database partitioning may hang when the Integration 
Service loads a large number of rows to IBM DB2 targets 
Sessions may hang when you use the database partitioning partition type for an IBM DB2 target. 

Workaround: Reduce the buffer block size, such as 32 KB or less. If the session still hangs, configure the 
Integration Service to perform single row inserts. Configure the following custom property in the 
Administration Console for the Integration Service: 

OptimizeDB2Write=0 

http://www.ibm.com/support/us/�
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CR 49362: Bulk load sessions may run in normal mode when an IBM DB2 table uses a 
Decimal datatype for a database partitioning key 
A bulk load session configured for database partitioning that loads to an IBM DB2 database may run in 
normal mode if an IBM DB2 table partitioning key uses a Decimal datatype. The session slows because 
data is routed to the first partition and processed in normal mode. 

Workaround. Use IBM DB2 version 8.1 or higher and apply fix pack 2 before you use a Decimal datatype 
for database partitioning keys. 

CR 46763: Designer does not define correct port precision when importing DB2 for AS/400 
stored procedures  
When you import a DB2 for AS/400 stored procedure, the Designer creates a Stored Procedure 
transformation with incorrect precision for some input and output ports compared to the precision specified 
in the stored procedure. 

Workaround: Open the Stored Procedure transformation in the Designer and correct the precision for input, 
input/output, and output ports. 

CR 39615: Sessions load data to a locked DB2 target table on AS/400  
If you do not truncate the table, you can load data to a locked DB2 target table on AS/400 because the DB2 
database on AS/400 does not detect the lock. You may get inconsistent data. 

CR 39427: Constraint violations cause session failure when loading to DB2 on AS/400 
When loading to DB2 on AS/400 violates key constraints, the session may fail with a communication error.  

The following messages might appear in the session log: 
WRITER_1_1_1> WRT_8229 Database errors occurred:  
[IBM][CLI Driver][AS] SQL30081N A communication error has been detected. 
Communication protocol being used: "TCP/IP". Communication API being 
used: "SOCKETS". Location where the error was detected: "10.1.72.203". 
Communication function detecting the error: "recv". Protocol specific 
error code(s): "*", "*", "0". SQLSTATE=08001 
. 
. 
. 
WRITER_1_1_1> CMN_1022 Database driver error...CMN_1022 [[IBM][CLI 
Driver] CLI0106E Connection is closed. SQLSTATE=08003 

Workaround: Verify that you load primary key tables before you load foreign key tables. 

CR 39101: Integration Service reports incorrect load statistics in the session log for DB2 
targets on AS/400 or OS/390 
The Integration Service reports incorrect load statistics in the session log when: 

 The session loads to a DB2 database on AS/400 or OS/390. 

 There are DB2 errors, such as violating not null constraints. 

 You configure the Integration Service to perform array writes. 

Workaround: Configure the following custom property in the Administration Console for the Integration 
Service: 

DB2ArrayStatusPtrWorkAround=Yes 
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CR 36093: Repository Service fails to promote a local DB2 repository after creating the 
repository 
When you create a DB2 repository, the Repository Service fails to promote the local repository to a global 
repository. 

Workaround: Catalog the DB2 database as a remote node instead of a local node. For more information, see 
the Knowledge Base article 14745. 

CR 10655: Column names do not appear in the source definition when importing DB2 table 
aliases containing underscores (_) 
When you import a DB2 table alias in the Designer, no columns appear in the source definition if the alias 
name contains an underscore ( _ ).  

Workaround: Remove the underscore from the table or alias name. 

-or- 

In the DB2 CAE Client Configuration Assistant, clear the Underscore as Wildcard option: 

1. Click the Properties button for the database alias. 

2. Click Settings. 

3. Click Advanced. 

4. Click the Optimization tab. 

5. Clear the Underscore as Wildcard option. 

CR 6163: Session fails for non-cached lookups on DB2  
When performing a non-cached lookup on an integer value, DB2 has an upper limit of 2147483583. 

Workaround: Enable caching in the Lookup transformation. 

Informix 

CR 98286, 97440: Invalid date values may be loaded to Informix targets on Windows Multi-
CPU machines 
The Integration Service sometimes loads invalid date values to Informix targets when you run a session on 
a multi-CPU Xeon machine on Windows. 

Workaround: Configure the following Custom property for the Integration Service: 
OptimizeInformixWrite=0 

CR 9582: Sybase and Informix string datatypes display incorrectly in the Source Analyzer 
When you import a Sybase source definition with Nchar and Nvchar datatypes, the Designer displays them 
as Char and Varchar. When you import an Informix source definition with Nchar datatype, the Designer 
displays it as Char. 

Workaround: Manually change these datatypes to Nchar and Nvarchar.  
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Linux 

CR 48674: When sessions fail on Linux due to insufficient memory allocation, the 
Integration Service does not write a message to the session log 
When a session fails to allocate enough memory, the session might terminate unexpectedly without logging 
an error message. Linux does not provide an error message for the Integration Service to log. 

Workaround: Verify that you did not allocate too much memory for DTM buffer pool size or cache sizes 
for Joiner, Aggregator, Sorter, Lookup, and Rank transformations.  

Meta Integration Technology 

CR 77910: When exporting PowerCenter metadata to Visio, MIMB defines all columns as 
required 
When you export source or target definitions to Visio, MIMB defines all columns in Visio as required. 

Workaround: Edit the metadata in Visio and define the required property. 

Microsoft SQL Server 

CR 108648: Partitioning causes dead lock error with Microsoft SQL Server 2005 in bulk 
mode 
A session fails with a dead lock error if it runs in more than one partition and it updates Microsoft SQL 
Server in bulk mode.    

CR 42355: Sessions may hang or fail when running multiple workflows against Microsoft 
SQL Server repository  
Deadlocks may occur when you run multiple workflows against a Microsoft SQL Server repository.  

Workaround: Apply Microsoft SQL Server Service Pack 2. For more information on this limitation, see 
Microsoft Knowledge Base Article 300412. 

CR 40506: Microsoft SQL Server may not commit smalldatetime values correctly 
When you use OLE DB drivers to load data from a flat file into a Microsoft SQL Server smalldatetime 
field, the Integration Service does not commit rows that contain any invalid smalldatetime data.  

Workaround: Use one of the following workarounds: 

 Verify that you load only valid data. 

 Add a Router transformation to filter rows containing invalid smalldatetime values. 

 Use bulk mode. 

 Use an ODBC driver. 

CR 40190: Repository Service may take several minutes to complete repository operations 
for folders with very large sources or targets  
If your repository resides on a Microsoft SQL Server database on a Windows 2000 machine, the Repository 
Service may take several minutes to complete operations on folders containing multiple sources or targets 
with 4,000 columns or more. These operations include opening and deleting the folder. 
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CR 22991: Microsoft SQL Server ODBC driver does not report decimal truncation 
The Microsoft SQL Server ODBC driver does not report decimal truncation when the following conditions 
are true: 

 Decimal column in the source has a precision less than the length of the field. 

 The session uses a Microsoft SQL 2000 ODBC call.  

 The Integration Service does not report the truncation. Instead, it reads truncated data and loads it to 
the target. 

Workaround: Use native drivers. 

CR 16959: Loading data to Microsoft SQL Server or Sybase targets in bulk mode does not 
preserve primary-key and foreign-key relations 
When the Integration Service loads a row with a foreign constraint to a Microsoft SQL Server or Sybase 
target using bulk mode, Microsoft SQL Server and Sybase allow the foreign key table to be loaded before 
the primary key table. Bulk load bypasses the foreign key restraint check in the database and does not 
require that the primary key be loaded. Microsoft SQL Server and Sybase SQL Server preserve primary 
key-foreign key relations for normal load only. 

Oracle 

CR 170657: Repository Service generates a core file when running a query on AIX with 
Oracle client 10.2 
The Repository Service sometimes generates a core file when you run an existing query against an Oracle 
repository. This problem happens on AIX with Oracle client 10.2. 

CR 127643: Session running in bulk mode and loading an Oracle 10i target truncates 
German characters 
The Integration Service incorrectly truncates German data when loading to a UTF-8 Oracle 10i database in 
bulk mode. 

Workaround: Use normal mode. 

CR 100786: Repository Service process may leak memory when running on a 64-bit Linux 
or 64-bit Solaris machine and you use Oracle client 9.2.0.1 
The Repository Service process may leak memory when it runs on a 64-bit Linux or 64-bit Solaris 
machine, and you use Oracle 9.2.0.1 client to connect to the repository. 

CR 97162, 97020: Repository Service process may run out of memory when Oracle client 
9.2.0.1 is used to connect to the repository 
When you use the Oracle client version 9.2.0.1 to connect to the repository on Linux, the Repository 
Service process may run out of memory.  

Workaround: Use the Oracle client version 9.2.0.4 or 10g to connect to the repository.  

CR 95962: Repository copy or backup on Oracle Database 10g causes Oracle database 
server error ORA-01455 
Oracle database server errors occur when a converted expression is too large for the specified database 
type. 

Workaround: Use Oracle Database 10g Release 1, version 10.1.0.4 or higher. For more information, see 
http://www.oracle.com/technology/deploy/security/pdf/cpujul2005.html. 

http://www.oracle.com/technology/deploy/security/pdf/cpujul2005.html�
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CR 93177: Pushdown Optimization fails on an Oracle 10.1.0.2 database 
Pushdown optimization fails on an Oracle 10.1.0.2 database when a Lookup transformation is downstream 
from a Joiner transformation. 
Workaround: Do not configure a session for pushdown optimization if it contains a Lookup transformation 
that is downstream from a Joiner transformation.  

-or- 

Use Oracle Database 10g Release 1, version 10.1.0.4 or higher. For more information, see 
http://www.oracle.com/technology/deploy/security/pdf/cpujul2005.html. 

CR 82575: Repository Service cannot create or upgrade repository on Oracle 10 
The Repository Service cannot create or upgrade a repository on Oracle when the Oracle server version is 
10.1.0.2 or 10.1.0.3 and is on a different platform than the Oracle client. 

The Repository Service writes the following message to the service log: 
ERROR: OBJM_54543 [Tue Nov 09 19:42:35 2004] : (2320|1972) Database 
error: ORA-01455: converting column overflows integer datatype 

Workaround: Perform one of the following actions: 

 Use the same platform for the Oracle server and client. 

 Upgrade Oracle server to version 10.1.0.4. 

 Contact Oracle about bug 3417593 to install a patch for the Oracle server. 

CR 60629: Deleting a folder through Repository Manager fails with maximum DML locks 
You cannot delete repository folders from an Oracle repository if the database exceeds the DML_LOCKS 
threshold. The Repository Manager displays the following message: 

An error occurred while accessing the repository ORA-00055: maximum 
number of DML locks exceeded. 

Workaround: Try to delete the folder again in a few minutes. If the error message occurs often, increase the 
DML_LOCKS parameter value in the Oracle server.  

CR 38932: Integration Service fails to connect to Oracle 9i databases running on Windows 
XP 
The Integration Service fails to connect to Oracle 9i databases on Windows XP and the Integration Service 
machine runs Oracle 8i client. The Integration Service writes an error message to the session log similar to 
the following message: 

READER_1_1_1> RR_4036 Error connecting to database  
ORA-12154: TNS:could not resolve service name 

Workaround: Use Oracle 9i client on the machine running the Integration Service. 

CR 38672, 36211: Oracle bulk load session fails or runs in normal mode on some versions 
of Oracle  
When you configure a session for bulk loading and the target database is on Oracle, the session fails when 
the Oracle client version is greater than or equal to 8.1.5 and less than 8.1.7.2. When the Oracle client 
version is less than 8.1.5, the session runs in normal mode. 

Workaround: Apply the Oracle Threaded Bulk Mode patch (Oracle bug number 1666360), use Oracle 
client 8.1.7.2 or higher, or run the session in normal mode. 

http://www.oracle.com/technology/deploy/security/pdf/cpujul2005.html�
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CR 35240: Oracle external loader interprets new line characters as line breaks 
When reading data from fixed-width or delimited flat file sources, the Oracle SQL*Loader always 
interprets new line characters as row delimiters. Therefore, you cannot use a new line character as part of 
any field that converts to the String or Nstring transformation datatype. This includes the following Oracle 
datatypes: Char, Long, Nchar, Nvarchar2, Varchar, and Varchar2. 

Solaris 

CR 42353: Integration Service on Solaris cannot read XML INF or –INF values  
When you use the INF (infinity) or –INF value for an XML float or double datatype, the Integration 
Service does not read the value. 

Sybase 

CR 130635: Deleting or deploying a transformation or task from a PowerCenter repository 
on Sybase ASE 12.5.0.3 fails 
If you delete or undelete a transformation or task or deploy a deployment group that deletes a 
transformation or task in a Sybase ASE 12.5.0.3 repository database, the operation fails and the Designer 
returns the following message: 

[REP_12014] An error occurred while accessing the repository 
 

Workaround: Upgrade the repository database to Sybase ASE 12.5.1. 

CR 95029: Network failure causes operation on Sybase database to hang even if 
connection is reestablished during database connection timeout  
If a temporary network failure occurs during an operation on a repository object in a Sybase database, the 
operation may hang even though the connection is reestablished before the database connection timeout 
expires. This problem occurs because the Sybase client uses TCP to determine when a connection is 
broken. If the TCP KeepAlive parameter is too high on the node that runs the Repository Service, the 
repository may not be resilient to network failures.  

Workaround: On the node that runs the Repository Service, set the operating system parameter called TCP 
KeepAlive timeout to a lower value. To achieve resilience, you may also need to use a lower value for the 
TCP KeepAlive timeout on the machine that hosts the Sybase database. 

CR 94299: PowerCenter Repository Reports do not open in Data Analyzer when the 
PowerCenter repository is on Sybase ASE 12.5.2 
Some PowerCenter Repository Reports do not open and display the following error message: 

This query cannot be processed because it contains TEXT, IMAGE or off-row 
Java columns and references a view defined with a subquery, an outer 
join, or a distinct clause. 

The Metadata Extensions Usage report fails with the following message on the Analyze tab: 
An unexpected error has occurred: [informatica][Sybase JDBC 
Driver][Sybase]Unable to allocate work table for processing group by or 
distinct clause during query optimization. Maximum limit (14) of work 
tables is exceeded. Simplify the query and retry. 

The Mapping Lookup Transformations report fails with the following message on the Analyze tab: 
An unexpected error has occurred: [informatica][Sybase JDBC 
Driver][Sybase]Implicit conversion from datatype 'VARCHAR' to 'INT' is 
not allowed. Use the CONVERT function to run this query.  
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Workaround: To use Sybase ASE 12.5.2 with PowerCenter Repository Reports, you must apply Sybase 
EBF 12922 to the Sybase database, turn on trace flag T289, and set the page size to 16. 

You must stop PowerCenter Services and restart the Sybase server after you apply the EBF. 

CR 79823: Sybase IQ database shuts down if you load a null value 
Sybase IQ version 12.4.3 database shuts down and the session fails when a source has more than two rows 
of data and the first row contains a null value. The issue is recorded in Sybase case 11103183. 

Workarounds:  

 Upgrade to Sybase IQ 12.5. 

 Change the default value for input ports from null to some other value. Use a default input value other 
than null only if your business logic allows it. 

 Configure the following custom property in the Administration Console for the Integration Service: 
OptimizeODBCWrite=0 

CR 78198: Using bulk mode to load to a Sybase target database on SuSE Linux may fail 
Sessions may fail when you use bulk mode to load data to a Sybase target database on SuSE Linux. 

Workaround: Apply Sybase patch ESD 14 (EBF 11500). 

CR 73777: Run continuous sessions fail unexpectedly on Sybase 12.5 repository 
When you schedule workflows to run continuous against a Sybase 12.5 repository, sessions may fail. The 
Integration Service writes an error to the workflow log similar to the following message: 

ERROR : TM_6292 : (2368|2272) Session task instance [s_sessionContin]: 
REP_12400 [Repository Error ([REP_51042] Repository agent connection 
failed. System Error (errno = 121): The semaphore timeout period has 
expired. . Cannot read message header. Read 0 bytes.)]. 

ERROR : TM_6292 : (2368|2272) Session task instance [s_ sessionContin]: 
CMN_1761 [Timestamp Event: [Wed May 12 11:40:42 2004]]. 

ERROR : TM_6292 : (2368|2272) Session task instance [s_ sessionContin]: 
TM_6224 [ERROR: Failed to fetch session information from the repository 
in folder [Test] for session [6] [wf_ContinWF.s_ sessionContin]...Unable 
to Fetch Mapping associated with the session.]. 

Workaround: Reschedule the workflow or run the session again. The Sybase reference is case number 
11037853, bug number 362222. 

CR 39673: Sybase bulk load session fails when you specify owner ID as table name prefix 
When you configure a session for bulk loading and you specify a table name prefix for the target table on 
Sybase, the session fails.  

Workaround: Specify the database name and the owner ID in the target instance Table Name Prefix 
property. Use the following format: 

dbname.ownerID 

CR 33115: Session fails when Sybase IQ external loader loads to a view for a table 
The Integration Service fails the session if the Sybase IQ external loader loads data to a view for a table. 
The Sybase IQ external loader can only load data to a database table. 
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CR 17761: Integration Service loads null values to timestamp columns when bulk loading 
to Sybase 
The Integration Service loads null values (instead of hexadecimal values) to timestamp columns in Sybase 
targets when you perform the following steps: 

1. Create a mapping with a Sybase target that includes a timestamp column. 

2. Do not link any transformation ports to the timestamp column. 

3. Create a bulk load session with this mapping. 

Workaround: To load hexadecimal values to unconnected timestamp columns, use a normal load. 

CR 16959: Loading data to Microsoft SQL Server or Sybase targets in bulk mode does not 
preserve primary key and foreign key relations 
When the Integration Service loads a row with a foreign constraint to a Microsoft SQL Server or Sybase 
target using bulk mode, Microsoft SQL Server and Sybase allow the foreign key table to be loaded before 
the primary key table. Bulk load bypasses the foreign key restraint check in the database and does not 
require that the primary key be loaded. Microsoft SQL Server and Sybase SQL Server preserve primary 
key-foreign key relations for normal load only. 

CR 13591: Unable to correctly import Sybase 12.5 database source or target with primary-
foreign key 
When you use the Source Analyzer or Target Designer to import a source or target definition with a 
primary key-foreign key from Sybase 12.5, the Designer imports the source or target with a primary key 
only.  

CR 9582: Sybase and Informix string datatypes display incorrectly in the Source Analyzer 
When you import a Sybase source definition with Nchar and Nvchar datatypes, the Designer displays them 
as Char and Varchar. When you import an Informix source definition with Nchar datatype, the Designer 
displays it as Char. 

Workaround: Manually change these datatypes to Nchar and Nvarchar. 

Teradata 

CR 127325: Teradata Multiload rejects all records when the flat file target code page is 
Korean and Multiload runs in data driven mode  
The Teradata Multiload external loader rejects all records when it runs in data driven mode and it writes to 
a flat file with a Korean code page.  This occurs on 64-bit AIX platforms.   

CR 99401: Sessions with SQL query override using Teradata ODBC drivers version 3.0.4 or 
earlier for the source connection hang 
Sessions that use Teradata ODBC drivers version 3.0.4 or earlier for the source connection may hang if the 
source uses a SQL override and the SQL statement ends with an equality statement. For example, the 
session hangs if the SQL query override ends with col_number1 = 33. Pushdown optimization sessions 
used to create database views may also hang with ODBC drivers version 3.0.4 or earlier. 

Workaround:  Use Teradata ODBC drivers version 3.05 or later. 

-or-  

If the session does not use pushdown optimization, reorder the SQL query override so that the query 
statement does not end with an equality statement.   
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CR 95241: Sessions configured for full pushdown optimization sometimes fail when using 
a 3.02 ODBC driver 
When you run a session configured for full pushdown optimization on a Teradata 3.02 or earlier database, 
the session fails because the ODBC driver truncates the data.  

Workaround: Use a 3.03 or later ODBC driver for a Teradata database. 

-or- 

When you configure the Teradata ODBC driver, set the following session mode: 
SessionMode=Teradata 

CR 88783: Teradata FastExport block size always at 64K and control file not displayed for 
connection 
The Integration Service always uses a block size of 64K for a Teradata FastExport connection, even if 
block size is set to a different value for the connection. In addition, the control file does not display in the 
Control File Override tool tip. You must click in the Control File Override dialog box and scroll down to 
view the control file. 

CR 71948: Sessions may fail when you load data using Teradata TPump in non-staged 
mode 
When you load data to targets using Teradata TPump in non-staged mode, the session may fail. 

Workaround: Load data to targets using Teradata TPump in staged mode. 

CR 46211, 45602: Invalid date/time operation error when the Integration Service runs 
uncached lookup on Teradata database 
When you run a session that uses an uncached lookup on a Teradata database, the session fails if any port in 
the lookup condition uses a Date/Time datatype.  

The Integration Service writes the following Teradata error message to the session log: 
[NCR][ODBC Teradata Driver][Teradata RDBMS] Invalid operation on an ANSI 
Datetime or Interval value. 

Workaround: Apply the Teradata ODBC patch 3.2.011 or later and remove NoScan=Yes from the odbc.ini 
file.  

CR 43632: Integration Service generates core file if invalid Teradata database specified in 
odbc.ini 
The Integration Service on UNIX generates a core file if the DefaultDatabase entry for a Teradata ODBC 
source in the odbc.ini file specifies an invalid database.  

Workaround: Edit the DefaultDatabase entry and specify a valid database. 

PowerCenter Known Limitations 
You may encounter  the following limitations when using PowerCenter. If you encounter difficulties or 
have further questions regarding one of these limitations, contact Informatica Global Customer Support and 
reference the CR number. 
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Administration Console 

CR 180855:  HTTP port does not redirect to HTTPS port with Internet Explorer 6 
When you configure HTTPS, you cannot access the Administration Console from Internet Explorer 6. The 
Administration Console URL is not redirected to the HTTPS port. Internet Explorer hangs.   

Workaround: Use Microsoft Internet Explorer 7 or Mozilla Firefox . 

 Or, enter the HTTPS port instead of the HTTP port in the Administration Console URL: 
 https://<host>:<HTTPS_port>/adminconsole. 

CR 172744: Editing user information revokes read-only privilege 
If you edit user information for a user that has read-only privilege, the Administration Console revokes 
read-only privilege. 

Workaround: If the user has permission on the domain, revoke the permission on the Domain tab. Then 
grant the user permission on the domain and read-only privilege on the Administration tab. If the user has 
permission on any object except for the domain, edit permissions for the user to grant the user read-only 
privilege on the Administration tab. 

CR 94255: ZoneAlarm firewall prevents you from logging in to the Administration Console 
If the network is protected by a ZoneAlarm firewall that blocks third-party cookies, you may not be able to 
log in to the PowerCenter Administration Console. 

Workaround: Disable the blocking of third-party cookies. 

Bulk Loading 

CR 81467: DB2 bulk load sessions using the database partitioning partition type fail when 
target DB2 database is non-partitioned 
If you run a DB2 bulk load session with the partitioning type set to database partitioning to a target table in 
a non-partitioned database, the session fails and returns the following error message: 

WRT_8229 Database errors occurred: 
[IBM] [CLI Driver] [DB2/6000] SQL27959N The partitioned database 
configuration option “PARTITIONED DB CONFIG” is invalid. Reason code = 
“1”. 
sqlstate= 

Workaround: To run a DB2 bulk load session to a non-partitioned target database, use a single partition for 
the session and use pass-through partitioning for the target partition type. 

CR 36404: Sessions configured for bulk load run in normal mode when the Integration 
Service running on AIX loads to an Oracle database 
Integration Service on AIX runs sessions in normal mode when you configure them for bulk mode. You 
might see the following error message when this occurs: 

WRT_8229 Database errors occurred: 
ORA-26002: Table QASRVRK2.BULK_PRIMKEY_TGT has index defined upon it. 

Workaround: Edit the $ORACLE_HOME/rdbms/admin/shrept.lst file and add the following lines of text: 
rdbms : OCIDirPathDataSave 
rdbms : OCIDirPathFinish 
rdbms : OCIDirPathFlushRow 
rdbms : OCIDirPathPrepare 
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rdbms : OCIDirPathLoadStream 
rdbms : OCIDirPathColArrayEntrySet 
rdbms : OCIDirPathColArrayReset 
rdbms : OCIDirPathColArrayToStream 
rdbms : OCIDirPathStreamReset 

Then run genclntsh. 

CR 34329: When running a session in bulk mode, the Integration Service loads null values 
for the default value, SYSDATE, in the Oracle target 
The Integration Service loads null values into Oracle when the following conditions are true: 

 You use the Target Designer to create a target definition and generate a target table on Oracle with two 
fields.  

 You use SQL*Plus to create a third field in the target table with a date datatype and the default value 
of SYSDATE. 

 You run the session in bulk mode. 

Workaround: Run the session in normal mode or create a column on the relational target definition with the 
date datatype and the default value of SYSDATE before you generate the target table in Oracle. 

Code Pages 

INFA 179778: Sessions with Hong Kong data sources fail on 64-bit Linux 
If you run a session that reads data from a source with the Hong Kong supplementary character set on 64-
bit Linux, the session fails. 

Client 

CR 131992: Designer shuts down with no errors when you try to use the XML Editor with a 
large XML schema   
The Designer may shut down unexpectedly when you use the XML Editor to open a large XML schema in 
the Source Analyzer.  

Workaround: Do not create XML views when importing the XML source file. Create the views manually in 
the XML Editor. 

CR 71164: Designer does not propagate port changes to transformations based on the 
Custom transformation 
When you propagate port changes, the Designer does not propagate to transformations developed using 
PowerCenter Connect SDK and are based on the Custom transformation. If you propagate forward, the 
Designer does not propagate the changes to downstream transformations. If you propagate backward, the 
Designer does not propagate the changes to upstream transformations.  

Workaround: Manually update the port and propagate changes to the rest of the mapping. 

CR 68612: The Designer imports the wrong datatype from Oracle 9i XMLTypes 
If you import an Oracle 9i source or target definition that contains an XMLType datatype, the XMLType 
becomes a Varchar2 data type with precision zero. 

Workaround: Manually change the datatype from Varchar to XMLType and change the precision. 
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CR 50911: Mapping Designer may not update a mapping with changes to a mapplet 
When you have recently modified a port in a mapplet, you may get the following error message when you 
open a mapping that uses the mapplet: 

...mapping <mapping_name> contains a mapplet with a port mismatch. Please 
edit mapplet <mapplet_name>.  

Workaround: To resolve the port mismatch, open the mapplet in the Mapplet Designer. Edit and save the 
mapplet. Then, return to the mapping in the Mapping Designer. Changes to the mapplet appear in the 
mapping. 

CR 47729: AS/400 tables with columns larger than 4000 bytes truncate 
When you import source or target tables from AS/400 using the DB2 ODBC driver or IBM AS/400 Client 
Access ODBC, columns above 4000 bytes import as only 4000 bytes. 

Workaround: Edit the table definition in the Designer after you import it. 

CR 45696: Designer does not correctly import foreign key on table created in Designer 
When you create a target definition, you can use the Target Designer to generate and execute the SQL code 
to create the target in a relational database. If you then import the table with foreign keys into the Source 
Analyzer or Target Designer, the Designer does not import the foreign keys correctly.  

Workaround: Edit the generated SQL query before you execute it on the database. For example, you 
generate the following SQL query for tables AA2 and AA1: 

CREATE TABLE AA2 
( 
    byte_1      byte(10), 
    decimal_5   decimal(10) NOT NULL, 
    varbyte_10  varbyte(10), 
    varchar_11  varchar(10) 
) 
; 
 
CREATE TABLE AA1 
( 
    byte_1      byte(10), 
    decimal_5   decimal(10) NOT NULL, 
    varbyte_10  varbyte(10), 
    varchar_11  varchar(10) 
) 
 
UNIQUE PRIMARY KEY (decimal_5); 
ALTER TABLE AA2 ADD  
    FOREIGN KEY (decimal_5) REFERENCES AA1 (decimal_5); 

Modify the query as follows: 
CREATE TABLE AA1 
( 
    byte_1      byte(10), 
    decimal_5   decimal(10) NOT NULL primary key, 
    varbyte_10  varbyte(10), 
    varchar_11  varchar(10) 
); 
CREATE TABLE AA2 
( 
    byte_1      byte(10), 
    decimal_5   decimal(10) NOT NULL, 
    varbyte_10  varbyte(10), 
    varchar_11  varchar(10), 
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 foreign key (decimal_5) references AA1 
); 

Execute the modified query. When you import the table in the Designer, foreign key columns appear 
correctly.  

CR 41232: Changes to reusable metadata extension default values do not get updated in 
the Designer or Workflow Manager 
When you create a reusable metadata extension in the Repository Manager and specify a default value for 
the extension, objects of that type in the Designer and Workflow Manager do not always receive changes to 
the metadata extension default value. For example, in the Repository Manager you create a reusable 
metadata extension for targets and supply a default value for the extension. You then create and save a 
target in the Designer without changing the metadata extension default value. In the Repository Manager, 
you edit and save the metadata extension default value. When you reopen the Designer, the new target 
contains the original metadata extension default value. 

Workaround: To update the metadata extension default value, edit the target and click the Revert button on 
the Metadata Extension tab. 

CR 39192: Designer might shut down unexpectedly when you save a large mapping 
If your system does not have enough memory, importing a large mapping with the “Save MX Data” option 
selected might cause the Designer to shut down unexpectedly. 

Workaround: Before you import the mapping, click Tools > Options and clear the “Save MX Data” option. 

CR 32379: Designer incorrectly imports COBOL file with signed numeric fields 
When you import a COBOL file with a signed numeric column, the Designer uses an extra space of 
precision for the signed character. As a result, the Integration Service may not correctly write signed 
numeric data for the target. For example, the Designer imports a PIC S9 (2) V99 with a precision of 4 and a 
scale of 2. The Integration Service writes the source value -6789 to the target as -6.78 instead of -67.89.  

Workaround: Increase the precision of the signed numeric field in the COBOL source definition to 
accommodate the signed character. For the above example, increase the precision to 5.  

CR 19266: Designer imports Informix table without columns when table name contains 
slash character (/) 
The Designer might import an Informix table without columns when the table name contains the slash 
character (/). 

CR 17277: Retain Primary Key-Foreign Key relationship option fails if you do not import all 
tables affected in the relationship 
When you import tables with a primary key-foreign key relationship into the Source Analyzer or the Target 
Designer, and then reimport only some of the affected tables, the Designer does not import the key 
relationships. The import tables option to retain user-defined primary key-foreign key relationships fails if 
you do not select all affected tables.  

Workaround: Reimport all tables affected by the primary key-foreign key relationship.  

CR 14760: Foreign keys lost after importing shortcut to source and shortcut to target  
When you import a shortcut to any folder, you lose key type information. 

Workaround: To maintain key type information after you import a shortcut, save the shortcut object, and 
then disconnect and reconnect to the folder in which the shortcut resides. 
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CR 8879: Target update override statements for Sybase target table with Varchar columns 
do not find matches 

When you use a Varchar column in the target update override statement for Sybase target tables, the 
Integration Service does not find matches and no update takes place.  

Workaround: Specify Varchar column type in the update override statement. 

CR 6250: Designer does not import unique keys and referential constraints 
The Target Designer does not import unique keys or referential constraints on a unique key.  

Workaround: Change the unique key to a primary key in the database before importing the target definition, 
or edit the target definition after importing it. 

Command Line Programs 

CR 100685: The infasetup DefineDomain command does not support Windows 
authentication for SQL Server domain configuration databases 
The infasetup DefineDomain command does not support the Microsoft SQL Server feature that allows you 
to log in to the database using your Windows user name and password. To define a domain that uses a 
Microsoft SQL Server domain configuration database, you must enter a valid database user name and 
password. 

CR 99041: infasetup displays an error message if you omit the -databasepassword (-dp) 
option  
The infasetup command line program fails to retrieve an encrypted password from the 
INFA_DEFAULT_DATABASE_PASSWORD environment variable.  If you omit the -databasepassword 
(-dp) option from an infasetup command that expects this option as mandatory, infasetup displays an error 
message.   

Workaround: Specify the domain configuration database password using the -dp option. 

CR 85047: Unicode characters do not display correctly in the command line window on a 
Windows machine when using pmrep 
When you run pmrep commands on a Windows machine and the output contains Unicode characters, the 
Unicode characters may not display correctly in the command line window. The Unicode characters do not 
display correctly because the command line window does not support a UTF-8 locale.  

Workaround: Instead of displaying the Unicode characters in the command line window, configure the 
pmrep command to write the results to an output file using the -o <outputfile> parameter.  

Copy and Deployment 

CR 169867: Copying a deployment group using the pmrep DeployDeploymentGroup 
command might fail 
When you copy a deployment group using the pmrep DeployDeploymentGroup command, the Repository 
Service might be unable to locate the target folder, even when you specify it in the deployment control file. 
In this case, the DeployDeploymentGroup command fails. 

Workaround: Copy the deployment group using the Repository Manager. 
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CR 169691: The pmrep ObjectImport command might fail if you do not specify resolution 
types for all objects or you import a scheduler using the “replace” resolution type 
When you import objects into a versioned repository using the pmrep ObjectImport command, the 
command might fail if you run it more than once and you set up the object import control file in either of 
the following ways: 

 You do not specify the resolution type for each object in the object import control file. 

 You import a scheduler with the resolution type “replace.” 

Workaround: Specify the resolution type for each object in the control file. If you import a scheduler, make 
sure the resolution type is either “reuse” or “rename.” 

CR 168911: Copying deployment groups between Oracle 10g databases might fail 
When you try to copy deployment groups between Oracle 10g databases, the copy operation might fail 
because the Repository Service cannot obtain the necessary database locks. 

CR 131030: PowerCenter does not update the SQL query in an associated mapping when 
you copy a workflow 
When you change the SQL query in a mapping and in the session properties, then copy the associated 
workflow and replace the mapping in the target folder, the Copy Wizard does not update the query in the 
mapping. 

CR 101371: PowerCenter does not copy performance data when you copy a folder 
containing workflow run-time information 
PowerCenter does not copy performance data when you copy a folder containing workflow run-time 
information. 

CR 96705, 96673: Error message displays when you copy a mapping to another repository 
folder, delete the mapping, and copy the mapping again 
You copy a mapping to another repository folder and delete the mapping from the target folder. If you copy 
the mapping again and use the Reuse option to resolve conflicts, the following error message displays: 

REP_57151: Invalid function arguments 

Workaround: When you copy a mapping to another repository folder, use the Rename option to resolve 
conflicts in the Copy Wizard.  

CR 86302: Reusable session is not listed in REP_SESSION_FILES view after folder copy 
After you copy a folder containing a reusable session, query results for the REP_SESSION_FILES MX 
view include a row for the original session but not for the copied session. When you query the view, only 
the original session appears in the query results. 

Workaround: When you copy a folder containing a reusable session, edit and save the copied session. After 
you edit and save the copied session, both the original session and the copied session appear in query 
results for the REP_SESSION_FILES MX view. 

CR 60152: Deployed objects not replaced when renamed 
When you rename a source object that you deployed, and then deploy it again, the deployment wizard 
deploys the renamed object as a new object if you compare the folders in the wizard. It does not replace the 
renamed object. 

Workaround: If you redeploy a renamed object, do not compare folders while in the wizard. 
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Custom Transformation 

CR 68161: Integration Service process shuts down unexpectedly with Custom 
transformation procedures that do not set the length for string output ports 
The Integration Service process shuts down unexpectedly when you run a session containing a Custom 
transformation that uses procedure code with the following properties: 

 The data access mode is row-based. 

 You use the INFA_CTSetData() function to set the output data for string ports, but you do not use the 
INFA_CTSetLength() function to set the length of the output data. 

Workaround: Edit the procedure code and use the INFA_CTSetLength() function to set the data for each 
string output port. 

CR 63965: Integration Service generates a core file if a Custom transformation procedure 
outputs a row in a different partition 
The Integration Service generates a core file when a Custom transformation procedure receives a row in 
one partition and outputs it in a different partition. 

Workaround: Verify that the procedure code outputs rows in the same partition in which they are received. 

CR 62999: Integration Service generates a core file when a procedure calls a Unicode 
function for a port in MBCS string mode 
When a Custom transformation procedure calls a Unicode function, such as INFA_CTGetDataStringU(), 
for a port in MBCS string mode, the Integration Service generates a core file.  

Workaround: Use only MBCS functions, such as INFA_CTGetDataStringM(), when a port is in MBCS 
string mode. Also, use only Unicode functions, such as INFA_CTGetDataStringU(), when a port is in 
Unicode string mode. You can change the string mode for a port using the 
INFA_CTRebindInputDataType() and INFA_CTRebindOutputDataType() functions. Or, you can change 
the default string mode for all ports in the procedure using the INFA_CTChangeStringMode() function. 

Database and Connectivity 

CR 89426, 89221: The Integration Service cannot use ODBC to connect to source and 
target databases when the database tables contain metadata with Unicode characters 
If the Integration Service uses ODBC drivers to connect to source and target databases, and you run a 
session in Unicode mode that reads from or writes to a source or target table containing metadata with 
Unicode characters, the session fails with the following error: 

RR_4035: SQL error 

Workaround: Use native database drivers to connect to the databases. 

CR 47948: Designer does not import AS/400 DB2 datatypes properly 
When you import an AS/400 DB2 definition using a Client Access ODBC connection, the Designer 
imports Bigint datatypes as Char instead of Decimal. Additionally, the Designer imports LongVarchar as 
Varchar, and it imports BLOB and CLOB as Char. 

Workaround: After you import the definition using a Client Access ODBC connection, manually change 
the datatype.  

 Change the imported Bigint datatype from Char to Decimal. 

 Change the imported LongVarchar datatype from Varchar to LongVarchar. 
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 Change the imported BLOB and CLOB datatypes from Char to BLOB and CLOB, respectively. 

 -or- 

Use another type of ODBC connection, such as a DB2 connection. 

CR 21801: ODBC drivers do not pass truncation message to Integration Service 
If the source column size in the database is larger than the column size in the source definition, the 
Integration Service may truncate source data without writing messages to the session log. This occurs when 
you use ODBC sources, and the ODBC drivers do not pass the messages to the Integration Service. 

Workaround: Ensure that the source definition matches the source table in the database. 

Datatypes 

CR 106614: The Integration Service does not read data from a Sybase source if the source 
has an image column 
When you load data from a Sybase source to a Sybase target using normal or bulk mode, the session does 
not read any data from the source if the source has an image column. The session log shows zero rows read. 

CR 105779: On Linux AS 3.0, the Integration Service truncates the last digit of decimal 
values with precision 15 
If you run a session that contains a mapping with a decimal port of precision 15 on Red Hat Enterprise 
Linux Advanced Server 3.0, the Integration Service truncates the number after the 15th digit. In 
PowerCenter 6.x and earlier, the Integration Service rounded the 15th digit. 

CR 81773, 80176: Integration Service trims trailing NULLs in Oracle Varchar2 source and 
lookup data 
Oracle allows embedded or trailing NULLs in Varchar2 columns. However, if an Oracle Varchar2 source 
or lookup table column has trailing null characters, the Integration Service trims the trailing NULLs from 
the data.  

For example, you have ‘abcde’ and five null values in a Varchar2(15) column in an Oracle table: 

"abcde"||chr(0)||chr(0)||chr(0)||chr(0)||chr(0)) 

When the Integration Service reads this column in a source or lookup table, it trims the trailing NULLs and 
processes the following data in the pipeline: 

abcde 

Workaround: Define the source column or lookup port as binary instead of Varchar2, and configure the 
Integration Service to treat binary ports in Oracle source definitions as Varchar2. Configure the following 
custom property in the Administration Console for the Integration Service: 

OracleTreatRawAsVarchar2=Yes 

CR 28774: Integration Service cannot read or write BLOB datatype columns on IBM DB2 
databases on AS/400 
The Integration Service cannot read from or write to BLOB datatype columns for IBM DB2 databases 
installed on AS/400 machines.  

CR 16601: Update Else Insert fails when source and target columns have different widths 
If you run a session with the target option Update Else Insert selected, one or more source Char(n) columns 
are compared to one or more target Varchar2(m) columns without blank padding, the session fails and the 
Integration Service issues a unique constraint violation to the session log. Since the source and target 
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columns are a different width, the columns do not match exactly and the update fails. When the update 
fails, the Integration Service attempts to insert into the target column. Since the record already exists in the 
target column, the insert fails and the Integration Service issues the constraint violation error.  

Workaround: In the Designer, use the RPAD function in the WHERE clause of the target update override. 
By including an RPAD function in the WHERE clause, the Integration Service can allow for extra spaces 
to the right when comparing the char source field to the varchar2 target field. For more information on 
using the WHERE clause or the target update override, see “Mappings” in the Designer Guide. 

CR 2947: Data conversion for flat file targets and error files (Double with scale 0) 
If a mapping outputs Double data to flat file targets or a session reject file (target_name.bad), the following 
data conversion rules apply: 

For UNIX, the Integration Service converts Double values to their string representation based on the IEEE 
math specification of rounding a 5 up if the previous digit is odd, and rounding down if the previous digit is 
even. For example, the Integration Service rounds 0.5 to 0, 1.5 to 2, 2.5 to 2, and so on. 

For Windows, the Integration Service always rounds up when it converts Double values to their string 
representation. For example, .5 rounds to 1, 1.5 rounds to 2, 2.5 rounds to 3, and so on.  

Data Profiling 

CR 107523: Data Profiling session on a grid displays incorrect domain inference results on 
Windows when key range partitioning is set to the exact key range of the data 
When you run a Data Profiling session on grid on Windows with key range partitioning set to the exact key 
range of the data, the session displays incorrect results for the Domain Inference function. 

Workaround: Enter a key range partition value that is greater than the available range of values in the data. 

CR 105854: Profile sessions fail or take a long time to complete on Linux 
Profile sessions on Linux fail or take a long time to complete if the data profile contains one of the 
following functions: 

 Candidate Key Evaluation  

 Functional Dependency  

 Redundancy Evaluation  

 Inter Source Structure Analysis  

Workaround: In the Transformation Developer, edit the STRUCTURE_INFERENCE_MGEP 
transformation. On the Initialization Properties tab, increase the data cache size to 16 and the index cache 
size to 8. 

CR 105721: Auto profile session on grid fails with an unexpected condition on 64-bit Linux 
When you run an auto profile session on grid on 64-bit Linux, the session fails with an unexpected 
condition. 

Workaround: Increase the cache size for the Aggregator and Sorter transformations in the profile mapping. 

CR 103211, 97774: Profile session logs cannot be accessed through the Profile Manager 
Session Monitor 
You may not be able to access profile session logs through the Profile Manager Session Monitor. Access 
workflow and session logs through the Workflow Monitor. If you still cannot access the logs, it may be for 
one of the following reasons: 
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 You ran the session on worker nodes on UNIX and the gateway nodes are on Windows. 

 You ran a temporary profile session. The Integration Service does not create logs for temporary profile 
sessions. 

Workaround: Use the same operating system environment for all worker nodes and gateway nodes in a 
domain. 

CR 102932: Several Data Analyzer Data Profiling reports display a timeout exception upon 
opening 
Data Analyzer displays an exception when you open the following Data Profiling reports: 

 Column Function Verbose Details 

 Source Business Rule Validation Details 

 Source Business Rule Validation Details (Group by Columns) 

 Distinct Value Count Verbose Summary 

 Distinct Value Count Verbose Summary (Group by Columns) 

 Composite report - Data Profile Results 

Workaround: The Data Profiling warehouse database might not be optimized for Data Analyzer report 
queries. Contact your database administrator to ensure that the Data Profiling warehouse tables are 
analyzed periodically. 

CR 102638: Profile session logs do not appear in the Profile Manager when a persistent 
profile session fails 
You cannot access session logs for failed persistent profile sessions through the Profile Manager. 

Workaround: Use the Workflow Monitor to view the session logs. 

CR 102599, 102253: The Designer fails to create a profile mapping for a data profile with 
the Referential Integrity Analysis function on multiple groups in XML source 
The Designer fails to create a profile mapping when a data profile contains Referential Integrity Analysis 
functions on two or more groups in an XML source file. 

CR 93905: Data sampling for intersource functions does not display in the PowerCenter 
Data Profiling report 
When you run a profile session using intersource functions, the PowerCenter Data Profiling report displays 
zeroes for Profiled Rows and Total Rows.  

CR 87330: Profile sessions fail when you profile an XML source with multiple subgroups 
using multiple Data Profiling functions 
Profile sessions on XML sources with multiple subgroups fail for the following reasons: 

 You create a data profile with several functions across subgroups. 

 The subgroups contain strings of infinite length. 

Workaround: If you have several functions across multiple subgroups, limit the number of functions on 
XML file subgroups within a data profile. 

-or- 

If the subgroups contain strings of infinite length, edit the XML source and change the string to a finite 
number. The maximum allowable value is 200. Regenerate the profile mapping and run the profile session. 
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CR 78764, 71129: Profile session may hang when profiling a source that uses a Join 
Complexity Evaluation function and Orphan Analysis function in the same data profile 
When you create a data profile that contains a Join Complexity Evaluation function and an Orphan 
Analysis function for the same source, the session may hang. 

Workaround: Create a separate data profile for each of the Intersource functions. 

CR 78475: Data Profiling report displays the wrong page number when viewing verbose 
data reports for the Row Uniqueness function and the Distinct Value Count function 
When you view the verbose data for the Row Uniqueness function and the Distinct Value Count function, 
page numbers may display incorrectly on the Data Profiling report. This does not affect accuracy of the 
data displayed in reports. 

CR 77846: Deleting a function from a data profile may cause the session information to 
reset for all sources in the data profile 
When you delete a function from a data profile, all session information may revert to the default session 
configuration. 

Workaround: Enter the session information again.  

CR 77325: Designer generates an unexpected condition when the Profile Wizard is open 
for several minutes 
When you leave the Profile Wizard open for several minutes, the Designer generates an unexpected 
condition. 

CR 71663: No lock or privilege check for purging the Data Profiling warehouse 
When you purge the Data Profiling warehouse, there is no lock or privilege check to prevent or notify other 
users. It is possible for another user to purge the Data Profiling warehouse simultaneously. 

Workaround: Before purging the Data Profiling warehouse, notify other users. 

CR 70850, 63924: Importing or saving a data profile with a large source fails with Save MX 
Data option enabled 
Importing or saving a data profile mapping with a large source (over 100 columns) fails and may generate 
an Unknown TCP/IP error. This only occurs when you enable the Save MX Data option in the Designer. 

Workaround: From the Designer, click Tools > Options, and clear the option to save MX data. 

CR 66021: A single function might cause a profile session to fail when the data profile 
contains other valid functions 
If a data profile contains multiple functions, and one of the functions causes an error in reading the source, 
the profile session fails even if the other functions are valid. 

Workaround: Edit the profile and either validate or delete the function.  

CR 62975: Cannot export or import a data profile associated with a mapping 
You cannot export or import a data profile associated with a mapping. You can export or import the 
mapping, but not the associated data profile. 

CR 62001: A session for a PeopleSoft vertical tree source fails when run from Profile 
Manager 
If you run a session for a profile with a PeopleSoft vertical tree source from the Profile Manager, the 
Session Setup page does not display the PeopleSoft attributes and the profile session fails. 
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Workaround: Create a persistent session from the Workflow Manager. 

Data Stencil 

CR 104340: Data Stencil mapping templates not installed on non-English machines 
When you install the PowerCenter Client on a non-English machine, the installer might not install the 
mapping templates for Data Stencil. 

Workaround: If you want to use Data Stencil on a non-English machine, contact Informatica Global 
Customer Support. 

Debugger 

CR 108765: Debugger might shutdown unexpectedly when you debug a mapping with a 
Custom transformation or a transformation built using the Custom transformation. 
When you run the Debugger on a mapping that contains a Custom transformation or a transformation built 
with the Custom transformation, the Debugger might shutdown unexpectedly. 

CR 82420: Designer might shut down unexpectedly when you run the Debugger and click 
Next Instance 
When the Debugger generates many log messages and you click the Next Instance button rapidly, the 
Designer might shut down unexpectedly. 

Workaround: Click Next Instance only after you see “Server is Ready” in the Debugger log in the Output 
window. 

Domains 

CR 107762: When you manually create a domain for Oracle RAC, you cannot specify an 
alternate server    
When you manually create a domain for Oracle RAC, you cannot specify an alternate server. For domains 
on an Oracle RAC environment, it is necessary to specify alternative server in case of domain failover.  

Workaround: Contact Informatica Global Customer Support for the DataDirect JDBC 3.5 release 40 driver. 
After you receive the updated driver files, shutdown Informatica Services and replace the DataDirect JDBC 
driver files in the following location: $INFA_HOME/server/tomcat/shared/lib. The JDBC driver files are 
JAR files that begin with dw.   

Then, use the DefineDomain infasetup command to specify the alternate server. Use the following 
connection string syntax when you run the DefineDomain command:  
-cs"jdbc:informatica:oracle://host_name1:port;ServiceName=sid; 
AlternateServers=(host_name2:port,host_name3:port)" 
 
For example, you may enter something similar to the following:  
infasetup.sh defineDomain -dn ORCL_CS -ad admin -pd pass -ld 
/home/pcsf/811SP2/server/infa_shared/log -nn orcl_cs_node -na benelli:7205 -mi 8000 
-ma 8500 -sv 7905 -bd /home/pcsf/811SP2/server/infa_shared/Backup -rf 
nodeoptions.xml –cs 
"jdbc:informatica:oracle://test1:1521;ServiceName=orcl.world;AlternateServers=(test2
:1521,test3:1521)" -du pctest -dp pctest -dt Oracle -f 
 

After running the DefineDomain infasetup command, configure domain and node settings, and restart 
Informatica Services. 
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For more information about using the DefineDomain infasetup command, see the PowerCenter Command 
Line Reference. 

CR 107707: When you configure a domain database using the installer or infasetup 
DefineDomain, the database service option does not work for Sybase ASE 
When you create a domain using the installer or the infasetup DefineDomain command, you cannot 
override the default database service name option if the database type is Sybase. For Sybase ASE 
databases, the installer and infasetup always store domain configuration information in the default database 
for the user. 

Workaround: If you have multiple Sybase ASE databases on a node, configure the database using the user 
whose default database is set to the database where you want to store domain configuration information. 

Error Handling 

CR 102161, 100096: Sybase RaiseError command does not fail sessions 
User-defined RaiseError commands in Sybase do not fail sessions even though the errors are listed in the 
Sybase error action file. 

Workaround: To have a user-defined RaiseError command fail the session, complete the following steps: 

1. In the Sybase error action file, sybaseerr.act, add the RaisedError number that should fail the session, 
followed by the fatal flag, F, such as 20001,F. You can use the flag R for a row level error, such as 
20001,R. 

2. Configure the following custom property in the Administration Console for the Integration Service: 
SybaseErrorActionFile=<error action file location> 

CR 78180: Integration Service does not fail sessions when the transaction log in the target 
Sybase database is full 
When the Integration Service tries to write to a full Sybase transaction log, Sybase suspends the 
transaction, but the Integration Service does not fail the session. 

Workaround: If you want the Integration Service to fail sessions when a Sybase transaction log is full, see 
the Informatica Knowledge Base article 11486 to use an error action file. 

CR 77060: Integration Service does not fail sessions when Microsoft SQL Server target is 
full 
When the Integration Service tries to write to a full Microsoft SQL Server target, it rejects the rows for the 
full target and does not fail the session. 

Workaround: If you want the Integration Service to fail sessions when a Microsoft SQL Server target is 
full, see the Informatica Knowledge Base article 11486 to use an error action file. 

CR 65379: Integration Service handles numeric underflow exceptions differently 
When you run a session that contains numeric exceptions, the Integration Service returns an error or 
outputs a zero depending on the operating system you use. If you use Solaris or AIX, the Integration 
Service outputs a transformation error. If you use HP-UX, the Integration Service outputs a zero because 
HP-UX does not detect numeric underflow exceptions. 
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External Loading 

CR 133822: Integration Service rejects rows when writing a Teradata BYTE datatype 
The Integration Service rejects rows when writing to a Teradata BYTE datatype with Teradata Multiload. 
The Integration Service rejects the rows when you run the session in Unicode mode on Solaris. 

CR 94863: Teradata TPump loader fails on 32-bit LINUX 
The TPump Loader may fail with the error UTY4014. If you receive this error, the target table may be in an 
inconsistent state. Or, if the session loads to multiple targets using a TPump external loader, and the 
external loader instances start at the same time, you may get error UTY8001. 

Workaround: If the TPump external loader fails with the UTY4014 error, you must drop and recreate the 
target tables.  

- or- 

If the TPump external loader fails with the UTY8001 error, the TPump external loader used the same name 
for multiple instances of the Teradata TPump loader causing a naming conflict. To fix this problem, you 
can override the external loader name in the control file generated by the Workflow Manager. When you 
override the control file, add the NAME command to override the file name generated by the Workflow 
Manager.  

CR 86592: A session fails when you configure a delimited flat file as input to a Teradata 
external loader  
A session fails when the Integration Service passes a delimited flat file to a Teradata external loader.  

Workaround: Configure the session to load a fixed-width flat file to the Teradata database. Configure the 
flat file properties in the Properties settings on the Mapping tab for the session.  

CR 85079: A session fails to write negative decimal values to a decimal column in a 
Teradata FastLoad intermediate flat file  
A session fails to insert negative decimal values into a decimal column of a Teradata FastLoad intermediate 
flat file. Teradata FastLoad does not write decimal values, so PowerCenter defines the decimal column as 
CHAR in the Teradata FastLoad control file. It adds two positions to the column definition. However, the 
column needs an additional position to allow negative values.  

Workaround: Increase the size of the column in the intermediate flat file and increase the size of the port in 
the Teradata database target. To increase the size of the column in the flat file, select the Control File 
Content Override option in the session properties, and Edit Loader Connection. The Integration Service 
uses this control file when you run the session and for each subsequent session run until you clear the 
control file attribute. You can view the control file by opening the Control File Editor. To increase the 
target port column, define the column in the target as decimal (x+1,x). For example, if the Teradata target 
column is decimal (5,5) configure the port as decimal (6,5). 

CR 44703, 17032: Integration Service prints external loader user name and password in the 
control file 
The Integration Service does not encrypt the database user name and password in the external loader 
control file. 

Workaround: You can configure the Integration Service to write the external loader control file to a 
directory separate from the target flat file. You can then configure the permissions on the control file 
directory to allow access by the user starting the Integration Service only. 

Configure the Integration Service to write the external loader control file to a separate directory. Configure 
the following custom property in the Administration Console for the Integration Service process: 

LoaderControlFileDirectory=<directory_name> 
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CR 38627: In sessions with multiple partitions, Oracle external loaders do not commit all 
rows when run in replace mode 
When you run a session with multiple partitions on Windows where you use an Oracle external loader 
connection in replace mode, the loader does not commit all rows to the target. This occurs because replace 
mode truncates the target table and then inserts the rows. In sessions with multiple partitions, the process 
for the last partition truncates rows that the previous processes inserted. This problem occurs on Windows 
systems, but not on UNIX systems. 

Workaround: Perform the truncate operation as a pre-session SQL command, and configure the Oracle 
external loader connection in append mode instead of replace mode. 

External Procedures and Stored Procedures 

CR 72917: Some sessions with External Procedure transformations fail on a 64-bit 
machine running the Integration Service process 
A 64-bit Integration Service fails sessions with external procedures that use any of the following functions: 

 GetLong 

 SetLong 

 GetpLong 

 GetpDouble 

 GetpTime 

Workaround: Edit the external procedure code and use either the SetInt32 or GetInt32 function. 

CR 24457, 23923: Sessions with DB2 stored procedures fail if the IN/OUT parameters are 
defined with Date or Time datatypes 
When you import DB2 stored procedures with IN/OUT parameters defined with Date or Time datatypes, 
the Designer imports them as Date/Time datatype. The session fails due to datatype incompatibility. You 
will see error messages similar to the following in the session log: 

TRANSF_1_1_1_1> ODL_26027 DB2 Fatal Error ODL_26027 [FnName: ExecuteSP -- 
SQLSTATE=42815 [IBM][CLI Driver][DB2/NT] SQL0171N The data type, length 
or value of argument "2" of function "GET_TIMESTAMP0" is incorrect. 
SQLSTATE=42815 

Workaround: The DB2 datatype Timestamp is a superset of Date and Time datatypes. In DB2 stored 
procedures, use the Timestamp datatype to declare Date or Time datatypes for IN/OUT parameters. 

Filter Transformation 

CR 179527: Filter transformation marks filtered rows as rejects when the target is a fixed-
width Unicode flat file       
The Filter transformation marks filtered rows as rejects and passes the rows to the target under the 
following conditions:  

 The Integration Service is running in Unicode mode. 

 The Filter transformation filters out less than 5 percent of the source data. 

 The target is a fixed-width Unicode flat file. 
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Flat Files and COBOL 

CR 173052: The Integration Service does not write target flat file delimiters on UNIX  
The Integration Service fails to write target flat file delimiters when all of the conditions are true: 

 The Integration Service is running in Unicode mode on UNIX. 

 The Integration Service is reading from a relational source. 

 The Integration Service has processed over 20,000 rows. 

CR 107834: Integration Service treats dates as null values in flat file sources when running 
in Unicode mode  
The Integration Service treats valid dates in fixed-width flat file sources as null values when the date is 
preceded by null values and you run the session in Unicode mode.   

Workaround: Change the datatype in the mapping from date to string or run the session in ASCII mode.  

CR 91913: Flat File Wizard does not display Unicode characters correctly 
The Flat File Wizard does not display characters correctly if the characters are in a language other than the 
system locale language. 

Workaround: Manually set the font for the Flat File Wizard to display characters of different languages. 

CR 87724: When you copy a flat file target definition from an existing flat file source 
definition, the target code page should be the same as the source code page 
When you create a flat file target definition from a flat file source definition, the Designer assigns a code 
page to the target. The Designer uses the same code page as the source if the source code page is a superset 
of the Integration Service process code page. Otherwise, the Designer uses the repository code page. The 
Designer should use the same code page as the source code page. 

Workaround: Change the target code page to match the source code page. 

CR 17128: Session may fail when sourcing very large indirect files  
If you run a session using a very large indirect file list (greater than 500 MB), depending on the memory 
size of the machine server, the session may fail. 

CR 7843, 3537: Concatenating data from a Normalizer transformation 
If you concatenate data from a Normalizer transformation, the ports you concatenate cannot include 
OCCURS. 

CR 4649: Non-printable ASCII characters handling 
If a fixed-width flat file contains non-printable ASCII characters, the Integration Service can read and 
propagate those characters through the session. However, if the file contains ASCII NULLs, you may get 
unexpected results. 

In addition, the Flat File Wizard does not display non-printable ASCII characters.  
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High Availability 

CR 103099: Workflow Manager is not resilient while the Integration Service initializes 
If you attempt to start a workflow in the Workflow Manager while the Integration Service is initializing, an 
error message indicates that the Integration Service is unavailable. The Workflow Manager is not resilient 
to temporary unavailability of the Integration Service. 

Workaround: Before you attempt to run a workflow, wait until the initialization of the Integration Service is 
complete and verify that the service is running on the node.  

CR 94930: In a domain with the high availability option, you cannot log in to the 
Administration Console immediately after shutting down the master gateway node 
If you designate two nodes as gateways and you shut down the master gateway node, you cannot 
immediately log in to the Administration Console or refresh the browser view of the Administration 
Console. An error message appears indicating that you do not have permission to access the Administration 
Console. The error occurs because the failover of the master gateway is not instantaneous. 

Workaround: After shutting down the master gateway node, wait approximately 30 seconds before logging 
in to the Administration Console or refreshing the browser view of the Administration Console. 

HTTP Transformation 

CR 171083: Session fails if the last two characters of the password are ampersands (&) 
When you generate a password as a parameter for an HTTP transformation, the Integration Service appends 
an ampersand (&) to generate a complete URL. If the password includes an ampersand at the end, the 
session fails. 

Workaround: Manually edit the password to remove the ampersand. 

CR 127403: HTTP transformation truncates or drops data when using digital certificates  
The HTTP transformation truncates or drops data when you configure the connection object to use digital 
certificates. 

Installation 

CR 133342: Start Informatica Services and Stop Informatica Services do not work on 
Windows after you apply a service pack for PowerCenter.  
After you apply a service pack for PowerCenter, you cannot restart or stop Informatica Services from the 
Windows menu. 

Workaround: Verify the path from the Start menu for Start Informatica Services. Right-click  Start > 
Informatica PowerCenter 8.1.1 > Service. Right-click the Start Informatica Services option and select 
Properties. Verify that the target string ends with “InformaticaServices 8.1.1.” Or, you can start Informatica 
Service from the Control Panel by selecting Administrative Tools > Services. Double-click  Informatica 
Services to start Informatica Services. 

CR 134095: When you launch the PowerCenter Service Pack Installer on HP-UX PA-RISC 
64-bit without setting environment variable, the installer fails 
When you launch the PowerCenter Service Pack installer on HP-UX PA-RISC 64-bit without setting the 
SHLIB_PATH environment variable, the installer fails with the following error: 

/usr/lib/pa20_64/dld.sl: Unable to find library 'libjvm.sl' 
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Workaround: Before you run the installer, set the SHLIB_PATH environment variable to the following 
directories: 

<PowerCenter Installation Directory>/java/jre/lib/PA_RISC2.0W  
<PowerCenter Installation Directory>/java/jre/lib/PA_RISC2.0W/hotspot 

CR 107586: ODBC drivers cannot be loaded if you install the PowerCenter Client before 
PowerCenter Services on a Windows machine 
If you install the PowerCenter Client before you install PowerCenter Services on a Windows machine, the 
ODBC driver routines cannot be loaded when you create an ODBC data source. 

Workaround: If you want to install PowerCenter Services and the PowerCenter Client on the same 
machine, install PowerCenter Services first. 

CR 107449: Incorrect ODBC library names in odbc.ini for DataDirect 5.1 ODBC drivers 
The odbc.ini file shipped with the DataDirect 5.1 ODBC drivers contains incorrect library names. The 
odbc.ini file contains library names in the format ivxxxx.so, but the library names should be in the format 
DWxxxx.so. 

Workaround: Change the library names to the correct values when you create an ODBC data source with 
the ODBC drivers. 

CR 106950: On AIX and Linux, application services may fail to start during installation due 
to host name resolution failure 
During installation, the installer may fail to start a Repository Service or Integration Service with the 
following error: 

Unable to start service [<RepositoryServiceName>] on any node specified 
for the service. 

Workaround: Use a fully qualified host name for the domain host. For example, use the following value for 
the domain host name: 

<machine name>.<domain name>.com 

CR 97813: Installer does not copy uninstall program on 64-bit Linux 
When you install PowerCenter on a 64-bit Linux machine, the installer does not copy the files necessary to 
uninstall PowerCenter to the _uninstallServer directory. An exception is thrown by the installer. 

CR 96534: Installer does not remove files and directories if you cancel installation before 
file copy process completes 
If you cancel a PowerCenter installation before the file copy process completes, the installer does not 
remove the files and directories already copied. 

Workaround: Uninstall PowerCenter manually. You can run the uninstaller in the _uninstallServer 
directory. 

CR 92636: If the registered Microsoft SQL Server name is in the format 
HostName\ServerName, use \HostName as the host name in the JDBC connection string 
In some cases, the registered SQL Server instance name is in the following format: 

HostName\ServerName 

During installation, when you enter HostName in the JDBC connection string for a Data Analyzer or 
Metadata Manager repository, the database connection test fails. For example, if the registered Microsoft 
SQL Server name is dove\dove, the following JDBC connection string fails to connect to the database: 
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dove:1433;SelectMethod=cursor;DatabaseName=mydb 

Workaround: Use \HostName in the JDBC connection string. For the above example, use the following 
connection string: 

\dove:1433;SelectMethod=cursor;DatabaseName=mydb 

CR 91211: If you do not have enough memory or disk space to perform the installation, the 
installer may create temporary files that are not deleted after the installation finishes  
If you do not have enough memory or disk space on the machine where you install PowerCenter Services, 
the installer creates temporary files on disk to allow the installation to continue without interruption. At the 
end of the installation, the installer fails to delete the temporary files.  

Workaround: The temporary files are created in the home directory of the user installing PowerCenter. The 
names for the temporary files are random (for example: install.dir.27168). After installation, you can delete 
the temporary files to clean up the user home directory.  

CR 91096: Installation Detail log does not indicate installation errors 
The Detail log does not indicate whether a command failed or not. It only indicates whether the command 
was run by the installer. For example, the Detail log indicates that a batch file to connect to a Repository 
Service was successful, meaning the command was run. It does not indicate whether the actions of the 
command succeeded or failed. 

Workaround: Use the Debug log to check whether the command or batch file actually succeeded or failed. 

CR 90870: On Solaris, AIX, and HP-UX, when you uninstall PowerAnalyzer and SuperGlue 
or Data Analyzer and Metadata Manager running on BEA WebLogic Server, the 
uninstallation wizard also removes the JDK 
When you install PowerAnalyzer and SuperGlue or Data Analyzer and Metadata Manager on BEA 
WebLogic Server on Solaris, AIX, and HP-UX, the installation wizard installs the JDK and sets the JDK 
path in the JAVA_HOME environment variable. When you uninstall both applications, the uninstallation 
wizard removes the JDK. With the JDK removed, the JDK path in the JAVA_HOME environment variable 
is invalidated and you cannot run another application on the same domain after you uninstall.  

Workaround: To run an application in the same domain, set the JDK path in the JAVA_HOME 
environment variable to another instance of the JDK. 

CR 90713: Data Analyzer repository and Metadata Manager repository must be set up on 
separate Microsoft SQL Server databases 
Typically, you can create the PowerCenter repository, Data Analyzer repository, and Metadata Manager 
repository on the same database with different user accounts. However, the Data Analyzer repository and 
the Metadata Manager repository contain tables that share the same names. In Microsoft SQL Server, if two 
user accounts have ownership rights on a database, the user accounts cannot create tables with the same 
names.  

For example, when you install PowerCenter, one user account can create the tables for the Data Analyzer 
repository but a second user account cannot create tables with the same names for the Metadata Manager 
Repository. The installer does not display any error message when it creates the repositories. However, 
after the installation, you cannot run Metadata Manager. 

Workaround: When you install PowerCenter and create the repositories on Microsoft SQL Server, create 
the Data Analyzer repository and the Metadata Manager repository on separate databases. 

CR 84995: IBM DB2 version must be 8.1.5 or higher 
If you are installing the PowerCenter repository, Data Analyzer repository, or the Metadata Manager 
repository on a DB2 8.1 database, you must use version 8.1.5 or higher. 
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CR 34887: Repository Service process on HP-UX does not start when connecting to 
repository database through Oracle 9i client 
The Repository Service process on an HP-UX system does not start when it connects to an Oracle 
repository database through Oracle 9i client connectivity software. 

Workaround: Add $ORACLE_HOME/lib32 to the SHLIB_PATH shared library environment variable. 

Integration Service 

CR 174479: Integration Service running in Unicode mode truncates flat file target fields 
with Unicode characters without logging the truncated fields in the session log   
When the target data length is greater than the target field length, the Integration Service truncates the 
target field and writes a row to the target. If the Integration Service is running in Unicode mode, and the 
target contains Unicode characters, the session log does not indicate that the field is truncated. 

CR 169010: Using database partitioning when loading data to DB2 target tables with 
aliases causes performance problems 
Performance problems occur when you run a session configured for target database partitioning that loads 
data to an IBM DB2 target, and you use aliases for the target table names. 

When you run a session configured in this way, the Integration Service encounters one of the following 
problems: 

 The Integration Service does not load data directly to the target using the target partition. Instead, it 
passes all data rows through a single node before loading them to the target tables, decreasing session 
performance. 

 The Integration Service generates a core file when you run the session. 

Workaround: Use fully qualified target table names instead of aliases. 

CR 134070: Session fails when the tracing level is verbose data   
A session might fail when the tracing level is verbose data. The session fails with the following error: 

FATAL ERROR : Unexpected Condition in file 
[..\..\common\cmnmisc\tblkcmn.hpp] line [317] 

 

Workaround: Set the tracing level for the session to the normal, terse, or verbose initialization level. 

CR 127550: Sessions that are configured to run on a grid and have multiple lookup 
partitions that share an unnamed persistent cache may not run properly 
A session may fail, stop unexpectedly, or hang if all of the following conditions are true: 

 The session configured to run on a grid. 

 The session is partitioned at a Lookup transformation and the partition type is not set to hash auto-
keys. 

 The Lookup partitions share an unnamed persistent cache. 

 The cache file does not exist before the session runs. 

The session does not run properly if one partition starts building the cache file on one node in the grid, and 
another partition tries to access the file as it is being built. 

Workaround: Configure the Lookup transformation to use a named persistent cache. 
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CR 106961: Session fails to send post-session email to multiple email addresses when the 
session runs on Windows.  
You can configure multiple email addresses in the $PMSuccessEmailUser and $PMFailusreEmailUser 
service variables. When the session runs on a Windows machine, the email fails with the following errors: 

ERROR LM_36488 Session task instance [s_m_test_email] : [CMN_65012 SMTP Error. Not able to send 
message.] 

INFO 3052 LM_36488 Session task instance [s_m_test_email] : [TM_6231 Error sending post session mail 
for session [s_m_test_email].] 

 CR 103171: When the Integration Service uses UTF-8 code page, it writes incorrect data to 
Teradata targets.  
When the Integration Service is running in Unicode mode and uses UTF-8 code page, it writes incorrect 
data to Teradata targets. 

CR 106773, 106578: Session fails with an empty connect string when a heterogeneous 
target uses an ODBC connection 
A session fails on 64-bit AIX when you use heterogeneous targets in the mapping and at least one 
connection is to Microsoft SQL Server through ODBC.  

CR 98157, 97413, 86051: Integration Service may generate a core file upon completing a 
session 
The Integration Service may generate a core file upon completing a session. This occurs after all session 
processes have finished, and it does not affect session results. You can ignore this core file. 

CR 98010, 97201: DB2 sessions on Linux sometimes terminate with a fatal error 
DB2 sessions on Linux sometimes terminate with a fatal error. The session log ends with the following 
messages: 

FATAL ERROR : Aborting the DTM process due to fatal signal/exception. 
FATAL ERROR : Signal Received: SIGSEGV (11) 

Workaround: Contact Informatica Global Customer Support and refer to EBF1580. 

CR 96576: Command task error messages do not appear in the workflow log 
The Integration Service writes error messages generated by the Command task to the domain log. It does 
not write them to the workflow log. 

Workaround: To view Command task error messages, view domain log events in the Log Viewer.  

CR 96030: The Integration Service might not truncate the IBM DB2 target table 
When running a session that writes to an IBM DB2 target database, selecting the Truncate Target Table 
Option for the session does not always result in the Integration Service truncating the target table. 

Workaround: Delete the table using a Pre-SQL query. 

CR 94060: You cannot concurrently update service options and service process options 
for a single service 
If you use the Administration Console or infacmd command line program to update options for the same 
service at the same time, only the last option saved is updated. 

Workaround: Allow one command to complete before entering the next command.  
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CR 92015: Session fails when you use some transaction commands in transaction 
environment SQL for Informix database or Teradata database connections  
When you use transaction environment SQL with Informix or Teradata database connections, some SQL 
commands such as LOCK TABLE and SET ISOLATION TO REPEATABLE READ may cause the 
session to fail.  

CR 88001: Sessions fail to use an SQL override for Teradata FastExport when you add it to 
session properties 
Sessions fail to use an SQL override for Teradata FastExport when you enter the override in the session 
properties. 

Workaround: Enter the SQL override in the source qualifier properties instead of the session properties. 

CR 84772: Integration Service writes data to target connection groups in a random order 
When the Integration Service writes to multiple target connection groups, it commits data to targets in the 
target connection groups in a random order. 

Workaround: Configure the Integration Service to define the commit order for a mapping by adding the 
following custom property in the Administration Console for the Integration Service: 

WrtTCGCommitOrder_<folder_name>.<mapping_name>=<target_name1> 
<target_name2> <target_name n> 

Note: If multiple targets are in the same target connection group, the Integration Service commits data to 
all targets in the target connection group at the same time.  

CR 82558: Integration Service in Unicode mode does not properly read some extended 
ASCII characters from EBCDIC flat files 
The Integration Service in Unicode mode does not properly read some extended ASCII characters from 
IBM EBCDIC US English flat file sources. For example, it reads the left bracket ( [ ) as a double pipe ( ║ ). 
Workaround: Configure the Integration Service to convert characters in IBM EBCDIC US English flat files 
differently. Configure the following custom properties in the Administration Console for the Integration 
Service: 

AlternateEBCDIC=1 
AlternateEBCDICFileName=us_ebcdic_IBM037.map 

See the Informatica Knowledge Base article 15396 to download the file us_ebcdic_IBM037.map.  

CR 81184: FTP source file session hangs when FTP server unexpectedly shuts down 
When the Integration Service reads a file using FTP and the machine hosting the FTP server unexpectedly 
shuts down, the session hangs. 

Workaround: Configure the Integration Service to time out the session after a specified number of seconds 
if it receives no data from the FTP server. To do this, configure the following custom property in the 
Administration Console for the Integration Service: 

FTPTimeout=n 

Where n is the number of seconds the Integration Service waits before stopping the session. 

CR 66177: Sybase sessions complete when targets do not exist 
When you run a session that writes to a Sybase target, the Integration Service may complete the session 
even if the target table does not exist. In this case, the Integration Service writes an error in the session log 
for each row of data that belongs to the non-existent table and writes each row into the reject file. 
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CR 41184: Session hangs if Sybase repository database shuts down and restarts 
If the Sybase repository database server shuts down unexpectedly during a session run, the session hangs 
when you restart the Sybase database server.  

Workaround: On the node that runs the Repository Service, set the operating system parameter called TCP 
KeepAlive timeout to a lower value. To achieve resilience, you may also need to use a lower value for the 
TCP KeepAlive timeout on the machine that hosts the Sybase database. 

CR 38542: Integration Service does not read rows from Oracle sources when query 
override contains a question mark (?) 
When you use a question mark (?) in an SQL override query against Oracle, the Integration Service does 
not read the source rows. The Integration Service uses the question mark (?) for parameter binding when it 
executes SQL against the source.  

Workaround: Create a query using characters other than question marks. 

CR 12074: PowerCenter does not correctly detect newline or linefeed characters with 
IBM930 code page  
Compared to previous versions of Global C, the IBM930 locale file in Global C versions 3.1 and later 
reversed the byte values for newline and linefeed characters. The Integration Service uses the Global C 3.0 
locale file with the IBM930 (Japanese EBCDIC) code page. As a result, the Integration Service may not 
detect newline characters properly if data is encoded according to the Global C 3.1 format.  

To determine the format of your data, refer to the following table: 

 
Global c3.0 Byte Value Global c3.1 Byte Value 

newline (Unicode U+0085) 

linefeed (Unicode U+000A) 

0x25 

0x15 

0x15 

0x25 

 

Workaround: The Integration Service includes three locale files for the IBM930 code page in the 
\bin\locale directory: 

 cp_0930.nls. The locale file currently in use. By default, the Integration Service uses the Global C 3.0 
version of this file. 

 cp_0930.nls.1. The Global C 3.0 version of the IBM930 locale file. 

 cp_0930.nls.2. The Global C 3.1 version of the IBM930 locale file. 

If your data is encoded according to the Global C 3.1 format, rename cp_0930.nls.2 to cp_0930.nls. 

CR 11196: Integration Service generates a core file when you run a test load for a session 
that has multiple Redefines in the Normalizer transformation 
If you are working with multibyte data and run a test load session that has multiple Redefines in the 
Normalizer transformation, the Integration Service generates a core file. 

CR 10153, 10152, 10151: Integration Service always performs case-sensitive string 
comparisons in the Joiner and Rank transformations 
The Integration Service always performs case-sensitive string comparisons in the Joiner and Rank 
transformations even if you clear the option for case-sensitive comparisons. 

Workaround: If you do not want the Integration Service to perform case-sensitive string comparisons, use 
an Expression transformation to convert data to the same case before passing data to a Joiner or Rank 
transformation. 
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Java Custom Transformation 

CR 96831: The DTM might fail when a null object is passed to the Java Custom 
transformation getStringBuffer 
The DTM might fail when you pass a null object to the Java Custom transformation getStringBuffer API.  

CR 92842: Cannot use getLong or setLong APIs for values higher than maximum integer 
and smaller than maximum long value in a Java Custom transformation 
The getLong and setLong APIs in the InputBuffer interface for a Java Custom transformation do not return 
the correct values. The values are not correct if the values returned by the APIs are larger than the 
maximum Java integer value but smaller than the maximum Java long value. 

Workaround: Use the getDouble or setDouble APIs for values larger than the maximum Java integer value. 

CR 83434: getFloat and setFloat APIs lose data precision in a Java Custom transformation 
When you use the getFloat API in a Java Custom transformation to get a float value from a source and use 
setFloat to write data to a target, the float values may lose precision. For example, if getFloat returns a 
value of 34.21, setFloat may write a value of 34.20999908447266 to the target. 

Workaround: Use the getDouble and setDouble APIs instead. 

Java Transformation 

CR 96754, 96688: Session fails if you use simple interface for Java expressions that use 
binary input 
A session with a Java transformation fails if you use the invokeJExpression API that takes binary input for 
a Java expression, including using the Define Expressions dialog box to generate simple Java code for the 
expression. 

Workaround: Use the advanced interface or use the Define Expressions dialog box to generate advanced 
Java code for an expression that takes binary input. 

CR 88021: Session fails with Java expression that uses a stored procedure 
A session fails if you create a Java expression that calls a stored procedure in a Java transformation. 

Workaround: Use JDBC APIs to read from the database instead of using a stored procedure. 

Logging 

CR 127040: The Integration Service encounters an unexpected condition when it runs a 
session with the Error Log DB Connection configured to use a $Source or $Target session 
parameter. 
The Integration Service encounters an unexpected condition if you configure a $Source or $Target session 
parameter for the Error Log DB Connection. 

CR 95886: Cannot use UNIX shared log drive for Service Manager running on Windows 
If you use a UNIX shared drive for the shared directory location for service logs, the Service Manager on a 
Windows gateway node cannot set the proper permissions on the directories on the UNIX shared directory 
location. 

Workaround: In a heterogeneous domain, manually set the permissions for the UNIX shared directory to 
have global read/write/execute permissions or use a Windows machine for the shared directory location. 
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CR 95825: The Log Viewer does not log a warning if the time is not in sync among nodes  
The Log Viewer does not log a warning if the time is not the same among all nodes in a domain.  

Lookup Transformation 

CR 107547: Teradata sessions fail unexpectedly while running a Lookup transformation on 
Solaris   
A session fails unexpectedly when it contains a Lookup transformation running on Solaris 2.8 with 
Teradata ODBC version 3.03.  

Workaround: You can run session containing Lookup transformations on Solaris 2.9 with Teradata ODBC 
version 3.04. 

CR 98390: Sessions fail with a lookup override in a mapplet variable  
The Integration Service cannot expand mapplet variables in the lookup override causing sessions to fail 
with the following error: 

TRANSF_1_1_1> DBG_21263 Invalid lookup override. 

Workaround: Create the variable in the mapping instead of the mapplet. 

CR 87958, 85943, 85817: Session fails after upgrade due to invalid lookup SQL override  
Even though an SQL override is valid and works correctly in PowerCenter 7.1.1 or earlier, it fails in later 
releases in some instances, including the following cases: 

 It includes comments placed between /*  */. 

 It contains a subquery. 

 It uses a Trim (BOTH FROM) command. 

Workaround: For a simple SQL override, rewrite the SQL statement. 

-or- 

For other SQL overrides, configure the following custom property in the Administration Console for the 
Integration Service: 

lookupOverrideParsingSetting=1 

Metadata Integration Model Bridge 

CR 94523: Cannot import project source from MicroStrategy if connection mode is Direct 
You cannot import a project source from MicroStrategy into PowerCenter if the connection mode for the 
project source is Direct. 

Workaround: Change the project source connection mode to Server. 

Nodes 

CR 107247: Repository Service or Integration Service fail to start on heavily loaded node  
If you attempt to start a Repository Service or Integration Service on a node that is overloaded, the service 
fails to start, and no message appears. 

Workaround: Reduce the load on the node, and restart the Repository Service or Integration Service. 
Alternatively, run the Repository Service or Integration Service on a different node. 
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CR 97965: When a domain has only one gateway, the domain does not start up properly 
after you disable the gateway node by killing the Informatica Services service (Windows) 
or by using the kill -9 command (UNIX) 
If the domain has only one gateway and you disable the gateway node by killing the Informatica Services 
service in the Windows Task Manager or by using the kill -9 command to stop the Informatica Services 
daemon on UNIX, a stack overflow may occur during domain startup when the Domain Service attempts to 
elect the master gateway. 

Workaround: Before restarting the domain, delete the Master_<gateway node name>.dat file from the 
master gateway node. 

CR 95276: Connection exceptions appear in the node.log file when you shut down a node 
or when a node shuts down due to insufficient memory 
When you shut down a node or when a node shuts down due to insufficient memory, the following 
connection exceptions may appear in the node.log file: 

A remote host refused an attempted connect operation. 
Connection refused. 

Workaround: Ignore these exceptions, which do not indicate a problem with the node or the connection to 
the node. 

Object Queries 

CR 104927: Query results display check-in times incorrectly if you back up a repository in 
one time zone and restore it in a different time zone 
If you back up a repository in one time zone and restore it in a different time zone, queries on repository 
objects may return unexpected results. Although a query fetches the correct objects, the query results 
window may display the check-in times in the local time where the repository was backed up instead of the 
local time where the repository was restored.   

Parameters, Variables, and Parameter Files  

CR 107621: The Integration Service cannot read parameter files on Windows if they 
contain Unicode characters 
If you run a session that reads data from a parameter file on a Windows machine, and the parameter file 
contains Unicode characters, the session fails with the following error: 

VAR_27016: Warning! Cannot find section for session [name] and folder 
[name] in parameter file [location]. 

CR 107510: The Integration Service cannot read parameter files where the last line is one 
or more equals signs 
If you run a session that reads data from a parameter file, and the last line in the parameter file is one or 
more equals signs, the Integration Service process fails unexpectedly. For example, a parameter file that 
contains the following lines at the bottom of the file causes the service process to fail: 

… 

==================== 

[MyFolder.WF:wf_MyWorkflow.ST:s_MySession] 

$$platform=unix 
==================== 
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Workaround: Substitute another character for the equals signs in the file. 

CR 96149, 93938: The SYSDATE variable does not return more than 19 characters 
By default, the SYSDATE variable in a transformation expression returns a precision of 19.  

Workaround: To capture time in milliseconds, use the PM_GETTIMEOFDAY function. For UNIX, use the 
GetTimeOfDay function. Configure the following custom property in the Administration Console for the 
Integration Service:  

SupportNanoSecInTime=yes 

CR 10246: Service variables on Windows are not accessible when variable assignment 
contains spaces 
A service variable on Windows causes an error during pre-session or post-session shell command execution 
if the variable is assigned to a directory name or path containing spaces. For example, when the service 
variable $PMRootDir is assigned with the value c:\temp temp, the command referencing this variable fails.  

Workaround: When assigning values to server variables, which are referenced in pre-session or post-
session shell commands, if the path contains spaces, enclose the directory in quotes.  

Partitioning 

CR 17163: Integration Service fails partitioned sessions with a Microsoft SQL Server 
source if the partition key is of datatype Smallint 
If you use partition keys of Smallint or Money datatype with a Microsoft SQL Server source, the 
Integration Service fails the session. 

Workaround: In the partition properties, use an SQL query instead of using a key range to select data. 

CR 13914: Additional disk space required to realign incremental aggregation files 
If you change the partitioning after you run an incremental aggregation session, the Integration Service 
realigns the aggregate files the next time you run the session. The Integration Service requires disk space at 
least twice the size of the original cache files to realign the files. 

CR 12581: Associated sources do not display with partitioning keys 
When you partition a Source Qualifier transformation with an associated source that is not connected to the 
Source Qualifier transformation, you cannot create partition keys on the associated source. The Keys for 
Partition dialog box does not display the associated source. 

Workaround: Connect the associated source to the Source Qualifier transformation, and you can create 
partition keys on that source in the session properties. You do not need to connect the output ports in the 
Source Qualifier transformation to another transformation. 

PowerCenter Connect for JMS 

CR 105471: Session to write JMS messages to an IBM MQSeries JMS provider generates a 
core file when commit interval is high 
The Integration Service generates a core file when you run a session that meets the following conditions: 

 It writes JMS messages to an IBM MQSeries JMS provider. 

 The commit interval is greater than 5,000. 

Workaround: Configure the session with a commit interval less than 5,000. 
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CR 102766: Integration Service loses data or writes duplicate data to the target when a 
recovery session does not run in real time 
When you run a recovery session and do not set the flush latency value to 1 or greater, the Integration 
Service loses data or writes duplicate data to the target. 

Workaround: Set the value for flush latency to 1 or greater in the session properties. 

CR 56919: Integration Service returns an error message when you run a session with two 
partitions for a JMS source on Solaris 
When you run a session with two partitions for a JMS source on Solaris, the Integration Service returns the 
following error message:  

MAPPING> [JAVA PLUGIN] [ERROR] at 
weblogic.rmi.internal.ObjectIO.writeObject(ObjectIO.java:36) 

This is because the Integration Service cannot locate the j2ee.jar file for the client provider library in the 
CLASSPATH. Because the error does not have a JMS error code, it is displayed in verbose mode only. 

Workaround: Set the CLASSPATH to the j2ee.jar file. 

CR 48633: A session to read messages from a JMS source with two partitions returns an 
incorrect error message if the JMS provider is BEA WebLogic Server 
When you run a session to read messages from a JMS source with two partitions and the JMS provider is 
BEA WebLogic Server, the Integration Service returns the following message: 

MAPPING> [JAVA PLUGIN] [ERROR] java.lang.ClassCastException: 
com.informatica.powerconnect.jms.server.reader.JMSReaderSQDriver 

MAPPING> Mon Jan 20 14:00:14 2003 

MAPPING> [JAVA PLUGIN] [ERROR] at 
weblogic.jms.frontend.FEConnectionConsumerCreateRequest.writeExternal 
(FEConnectionConsumerCreateRequest.java:105) 

MAPPING> Mon Jan 20 14:00:14 2003 

MAPPING> [JAVA PLUGIN] [ERROR] at 
weblogic.common.internal.ChunkedObjectOutputStream.writeObject 
(ChunkedObjectOutputStream.java:104) 

MAPPING> Mon Jan 20 14:00:14 2003 

MAPPING> [JAVA PLUGIN] [ERROR] at 
weblogic.common.internal.ChunkedObjectOutputStream.writeObject 
(ChunkedObjectOutputStream.java:121) 

MAPPING> Mon Jan 20 14:00:14 2003 

MAPPING> [JAVA PLUGIN] [ERROR] at 
weblogic.rmi.internal.ObjectIO.writeObject(ObjectIO.java:36) 

MAPPING> Mon Jan 20 14:00:14 2003 

The message should read:  
When your JMS provider is WebLogic Server, you may only have one 
partition in a pipeline for the JMS source. Otherwise, the session fails.  
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CR 48631: Error message number does not display when the Integration Service cannot 
connect to BEA WebLogic Server because the WebLogic Server is not running 
When you run a session to read messages from a WebLogic JMS provider or write messages to a 
WebLogic JMS provider and BEA WebLogic Server is not running, the Integration Service fails the 
session. It displays the following Java error message without including a PowerCenter Connect for JMS 
message number: 

[JAVA PLUGIN] [ERROR] javax.naming.CommunicationException. Root exception 
is java.net.ConnectException: <WebLogic Server host name and port 
number>: Destination unreachable; nested exception is:  

java.net.ConnectException: Connection refused; No available router to 
destination 

CR 47200: Java may generate an exception error when a session on UNIX encounters an 
error 
When Java encounters an error during a session on UNIX, the Integration Service may print the following 
exception error: 

Exception in thread <thread name> Exception in thread <thread name> 

If this error message appears after another error message, it is a secondary error. You can ignore this error. 

CR 40995: Session might hang when you stop a debug session before the Integration 
Service meets session conditions 
If you stop a debug session before the Integration Service has met the session conditions, the session might 
hang. For example, you set the session condition Message Count to 1000. You run a debug session and stop 
the session before the Integration Service reaches a message count of 1000. The session might hang.  

PowerCenter Connect SDK 

CR 42031: PowerCenter Connect SDK cannot expand mapplet variables 
The PowerCenter Repository classes do not provide the PowerCenter Connect SDK access to mapplet 
variables. If you create a mapplet with an SDK Source Qualifier in it, and call the IutilsServer expandstring 
function to expand a mapping parameter in the mapplet, the expandstring function looks for the variable in 
the mapping scope instead of the mapplet. The expandstring function cannot expand mapplet variables. 

PowerCenter Repository Reports 

CR 77668: Run Scheduled Reports After Import option causes report errors 
When you import reports.xml into Data Analyzer, if you select the Run Scheduled Reports After Import 
option, Data Analyzer may display errors when running the reports. 

Workaround: Do not select the Run Scheduled Reports After Import option. After you import the reports, 
manually run the schedules to run all scheduled reports. 

CR 64547: Mapping Count and Mapplet Count metrics used in the Source List, Source 
Mapping Dependency, and Source Mapplet Dependency reports only count sources used 
directly in a mapping or mapplet 
The Mapping Count and Mapplet Count metrics are calculated based only on sources used directly in a 
mapping or mapplet. The Mapping Count and Mapplet Count metrics exclude mappings and mapplets, 
respectively, under the following scenarios: 
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 If the source is contained in a mapplet within a mapping, the Mapping Count metric does not include 
this mapping. 

 If the source is used in a Lookup transformation within a mapping, the Mapping Count metric does not 
include this mapping. 

 If the source is used in a Lookup transformation within a mapplet, the Mapplet Count metric does not 
include this mapplet. 

The issue affects the following reports: 

 Source List (primary report in an analytic workflow) 

 Source Mapping Dependency (workflow report in the analytic workflow)  

 Source Mapplet Dependency (workflow report in the analytic workflow) 

CR 12303: All Objects Used in a Mapping report only lists objects used directly in a 
mapping 
The All Objects Used in a Mapping report only lists objects used directly in a mapping. If the mapping 
contains a Lookup transformation on a source or target, the report only displays the Lookup transformation. 
The report does not display the source or target. 

Pushdown Optimization 

CR 131926,127638: Pushdown optimization fails when you join multiple sources that have 
the same port name  
The Integration Service generates incorrect SQL query and fails a session under the following conditions: 

 You join sources that contain ports with the same name. 

 You include one of the port names in the Source Qualifier filter condition. 

Workaround: When you enter the filter condition in the Source Qualifier transformation, qualify any 
reference to the port name by placing the source name in the front, separated by a period. 

Recovery 

CR 95032: A recovery session does not append to the previous session log when the 
session is configured to archive session logs by timestamp 
When you archive session logs by timestamp, the Integration Service appends a timestamp to each session 
log. When you recover a workflow, the Integration Service attempts to open the original session log file 
before it restores the session state of operations. Since the Integration Service does not have the original 
session log name at that point, it creates a new session log.  

Repository 

CR 171151: A mapping with an XML source cannot be imported to the repository 
When you export a mapping that contains an XML source and import it to another folder or repository, the 
import fails with the following error: 

Source Definition <source name> cannot be imported as it is 
potentially unsafe. Importing any associated mapping/mapplet might 
result in an error.  

Workaround:   This error might occur when the XML source has element names that are greater than 80 
characters.  The element name in the repository is longer than the group name that appears in the schema 
because the Repository Service appends the group name to element name.  



 87

CR 135731: Upgrading an ISO8859-1 repository to an UTF-8 repository might cause  
inconsistencies in the repository 
When you upgrade an ISO8859-1 repository to an UTF-8 repository, the repository might contain 
inconsistencies. 

Workaround: Contact Informatica Global Customer Support and refer to EBF2867.  

CR 135022: Links to a target fail to import when the column name changes in the target 
definition 
 The links to a target are not imported with a mapping when you perform the following steps: 

 Update the name of a column in a shared target. 

 Export the mapping that contains the target. 

 Import the mapping to another repository and replace a mapping of the same name. 

CR 132794: The Import Wizard fails to import a mapping with an XML source 
The Import Wizard fails to import a mapping with an XML source. The import fails with the following 
error: 
<Error>:  Name is too long. 

Workaround: Copy the mapping from one folder to another. 

CR 131419: Export drops non-reusable Command or Email task from a session in a 
worklet 
If you include a non-reusable Command or Email task in a session, add the session to a worklet, override 
the Command or Email task with a setting of NONE, and export the worklet, the Workflow Manager 
removes the Command or Email task from the session. 

CR 127421: Advanced Purge does not work correctly for source, target, mapplet, and 
mapping objects   
When you preview objects older than the latest version with Advanced Purge, the Designer does not return 
all of the objects. You cannot  purge all of the versioned objects with Advanced Purge.   

Workaround: Run a query to retrieve the deleted objects. Select View History. Purge the old object 
versions by choosing Tools > Purge Object Version.   

CR 106249: Cannot connect to PowerCenter repository on Sybase 15  
You cannot connect to a PowerCenter repository on Sybase 15 using Sybase 15 client libraries. 

Workaround: Use the Sybase 12.5 client library. 

-or- 

Use the Sybase 15 client library. Run Sybase script lnsyblibs, which creates the system links for the 
libraries. You can find the script in $SYBASE/$SYBASE_OCS/scripts. Before running the script, remove 
the pipe ( | ) character in line 34. 

CR 94886, 91141: An error may occur during code page conversion when using an Oracle 
9i, UTF-8 PowerCenter repository 
If the PowerCenter repository uses a UTF-8 code page and is on an Oracle 9i database, an error may occur. 
During code page conversion from UCS-2 to UTF-8, if PowerCenter requires more than 4,000 characters, 
Oracle displays an error. Oracle 9i has a limitation of 4,000 characters for varchar columns. If an error 
occurs, data may be truncated and records may not be inserted into the PowerCenter repository. 
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CR 94732: Cannot log into Microsoft SQL Server PowerCenter repository if password has 
non-ASCII characters  
You cannot log into a PowerCenter repository if the password contains non-ASCII characters. 

Workaround: Change the user password to use ASCII-only characters. 

CR 90646: Dependent objects reflect the changes to parent objects in the workspace but 
the changes do not get saved to the repository 
When you update an object, any dependent object in a mapping reflects the changes in the workspace but 
does not save the changes to the repository. Similarly, a shortcut object reflects changes to the referenced 
object in the workspace, but these changes do not get saved to the repository. Because the changes are not 
saved to the repository, the mapping retains an invalid status although it appears as valid in the workspace. 

Workaround: Ensure that you check out all objects in the mapping before you modify the parent object. 
Ensure that you check out any shortcut objects before you modify the referenced object. 

CR 75520: Non-reusable session validation fails 
When you validate a non-reusable session from the Repository Manager navigator or from a Results View 
window, the Repository Service validates the session without errors, but it does not save the session. As a 
result, the session fails with validation errors. 

Workaround: Validate the non-reusable session and the parent workflow at the same time through a Results 
View window or pmrep. To validate a session and workflow from a Results View window, you can view 
object dependencies within the PowerCenter Client, and then perform validation. To validate a session and 
parent workflow through pmrep, use the ListObjectDependencies command in conjunction with the 
Validate command. 

Repository Service 

CR 176353: Repository Service does not allow check out of impacted mapping  
When you try to check out a shortcut to an impacted mapping, the following message displays: 
[REP_12355] This object has been modified since the time it was read. 

The message appears because the Repository Service does not mark the mapping shortcut as impacted in 
the repository. 

Workaround: Edit and check in the original mapping before you check out the shortcut.   

CR 95832: Repository Service processes in different domains can connect to the same 
repository database 
The Administration Console does not prevent you from associating Repository Services in different 
PowerCenter domains with the same repository database. When two Repository Services access the same 
repository database, you may experience repository inconsistencies and object locking issues.  

Workaround: If the PowerCenter environment includes multiple PowerCenter domains, ensure that a one-
to-one relationship exists between Repository Services and repository databases across all domains. If two 
Repository Services are associated with the same repository database, disable all Repository Service 
processes for one of the Repository Services. Then, uniquely associate that Repository Service with a 
different repository database, or remove that Repository Service. 

CR 49383: Repository Service will not start on UNIX 
The Repository Service on UNIX does not start if the soft limit for the number of files a process can have 
open simultaneously is greater than the hard limit. 
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Workaround: Configure the hard limit for the number of files a process can have open simultaneously to a 
value greater than or equal to the soft limit. Informatica also recommends configuring the maximum 
number of semaphores per ID to a value greater than both limits. Configure the following kernel parameters 
with the specified values: 

 Maxfiles. The soft limit for the number of files a process can have open simultaneously. Configure this 
parameter for 1024 files. 

 Maxfiles_lim. The hard limit for the number of files a process can have open simultaneously. The hard 
limit should be greater than or equal to the value specified for maxfiles. Configure this parameter for 
1024 files. 

 Semmsl. The maximum number of semaphores per ID. You can configure this parameter in 
/usr/include/sys/sem.h. Configure this parameter for 2048 semaphores. 

SQL Transformation 

CR 107635: Session fails while processing an SQL transformation Unicode script on 
Microsoft Windows  
A session fails when processing an SQL transformation if the SQL transformation is running in script mode 
and the script file is in Unicode. The Integration Service does not recognize the Unicode script characters. 
The session fails with an error message similar to the following message: 
Message Code: pmsql_50059 
Message: [ERROR] Script processing has failed with the following error message: 
 DROP TABLE SQLT_Î¿Ï?Î±_Ï?ÎµÏ€   

Upgrading 

CR 135731: Repository upgrade fails when upgrading an ISO8859-1 repository to UTF-8 
The upgrade fails when you upgrade an ISO8859-1 repository to UTF-8. 

Workaround: If you want to upgrade an ISO8859-1 repository to UTF-8, contact Informatica Global 
Support for EBF 135731. 

CR 109141: Repository upgrade fails on HP-UX IA64 when upgrading XML sources and 
targets from PowerCenter 6.x to 8.1.1. 
The upgrade fails when you upgrade XML sources and targets to a repository on  HP-UX IA 64. 

CR 107487: Cannot edit Web Services Hub properties on the Administration Console after 
upgrade from PowerCenter 8.1 
After you upgrade to PowerCenter 8.1.1, the Web Services Hub does not have the following properties set: 

 SessionExpiryPeriod 

 MaxLMConnections 

You cannot change these Web Services Hub properties in the Administration Console.  

Workaround: Create Web Services Hub and configure the properties on the Administration Console. 
Alternatively, you can use the command line program infacmd to change the settings of the Web Services 
Hub properties.  Use the -so option with the UpdateWSHubService command to configure the properties. 

CR 106817: Cannot change Repository Service properties after upgrade 
If a Repository Service does not have all the required properties after you upgrade to PowerCenter 8.1.1, 
you cannot change the Repository Service properties in the Administration Console. For example, if a 



   90

Repository Service does not have the DBPoolExpiryThreshold and DBPoolExpiryTimeout properties in 
PowerCenter 8.1.1, you cannot use the Administration Console to modify the Repository Service 
properties, such as the operating mode. 

Workaround: Use the infacmd UpdateRepositoryService command to add the missing properties to the 
Repository Service. For example, if the Repository Service lacks the DBPoolExpiryThreshold and 
DBPoolExpiryTimeout properties, use the -so option with the UpdateRepositoryService command to add 
the missing properties and their values. Then, you can use the Administration Console to modify the 
Repository Service properties. Alternatively, create a Repository Service that has all the required 
properties. 

CR 106435: Nodes upgraded from PowerCenter 8.1 have different default values for some 
Load Balancer settings  
If you created nodes using PowerCenter 8.1, and you upgrade from version 8.1 to version 8.1.1, the 
upgraded nodes have the following default values for the “CPU Profile” and “Maximum Memory %” 
general properties: 

 CPU Profile = 10 (should be 1.0) 

 Maximum Memory % = 100% (should be 150%) 

Workaround: If you use metric-based or adaptive dispatch mode, manually set “Maximum Memory %” to 
150% or some other value. If you use adaptive dispatch mode, calculate the CPU profile for all nodes in the 
grid, or manually set the CPU profile for the upgraded nodes to 1.0.  

CR 94073: Behavior of decimals in low precision is not backward compatible 
In previous releases, a double used as a decimal in low precision was accurate up to 15 digits. After the 
fifteenth digit, values varied depending on the operating system. In PowerCenter 8.x, the fifteenth digit is 
rounded, and all values after the fifteenth digit are converted to zeroes. In PowerCenter 8.x, there is no way 
to achieve the behavior used in previous releases. 

Workaround: Contact Informatica Global Customer Support for information about how to achieve 
backward compatibility for your implementation.  

CR 74385: Sessions may fail with upgraded Advanced External Procedure transformations 
Sessions with Custom transformations that were upgraded from Advanced External Procedure 
transformations fail if you used the following upgrade path: 

1. You created the transformation in version 4.x and upgraded to version 7.0 or 7.1. 

2. You upgrade the 7.0 or 7.1 repository to version 8.x. 

These Custom transformations have an IsActive attribute set to false. The IsActive attribute should be true. 

Workaround: Export the Custom transformation to an XML file. Change the IsActive attribute to true in the 
XML file and import the object from the XML file. 

CR 70523: After upgrade, XML definitions might become invalid when view rows violate 
hierarchy rules 
When you upgrade a version 6.x XML definition, the hierarchy relationships might be invalid when you 
upgrade.  

Workaround: Validate the XML definition in the XML Editor. Review the error messages. You might have 
to recreate mappings and sessions that use the XML definition. 

CR 62799, 48727: Sessions using Aggregator transformations with sorted input fail after 
upgrade 
When you upgrade from version 6.0 or 6.1, sessions with the following characteristics might fail: 
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 You enabled sorted input in the Aggregator transformation, but the data is not sorted. 

 The session is data driven. 

 The mapping contains an Update Strategy transformation. 

Workaround: Use sorted input, or disable the sorted input option in the Aggregator transformation. 

CR 55544: Upgraded sessions that use midstream XML solution fail 
After you upgrade to PowerCenter 8.x, the Integration Service fails sessions that use the midstream XML 
solution. 

Workaround: If you want to continue using the midstream XML solution for version 6.x or 7.0, contact 
Informatica Global Customer Support. 

CR 54705: Cannot query descriptions for upgraded reusable tasks 
When you upgrade from version 6.x, descriptions for non-reusable tasks upgrade to a different repository 
table. You can still view the descriptions in the tasks, but you cannot query against them. 

CR 46365, 46146: Integration Service fails to match a lookup value using 
ROUND(TO_DECIMAL(string)) in a string lookup port expression in low precision mode 
The upgrade process from versions prior to 6.1 replaces TO_INTEGER() with ROUND(TO_DECIMAL()). 
When you have ROUND(TO_DECIMAL()) in a lookup port with a String datatype, the Integration Service 
does not match the port value with a string integer value in the lookup cache or table in low precision 
mode. 

For example, you have the following expression in a previous version of PowerCenter or PowerMart: 
TO_INTEGER(‘5.18’) 

The upgrade process changes this expression to: 
ROUND(TO_DECIMAL(‘5.18’)) 

ROUND(TO_DECIMAL()) returns values as a Double with trailing zeros in low precision mode. 

Workaround: Manually change expressions in string lookup ports of a Lookup transformation. Change 
ROUND(TO_DECIMAL()) to TO_INTEGER(). 

User-Defined Functions 

CR 95136: Reverting to a previously saved mapping or to original properties of a reusable 
transformation does not revert a user-defined function 
If you revert to a previously saved mapping or the original properties of a reusable transformation, and the 
mapping or transformation contains a user-defined function, the user-defined function does not revert. 

CR 94374: Cannot use aggregate functions in user-defined functions 
You cannot include aggregate functions in a user-defined function. 

CR 91733, 86535: User-defined functions are not versioned objects 
The repository does not assign versions to user-defined functions. 

CR 91731: Object queries cannot locate user-defined functions  
You cannot run an object query to locate user-defined functions. 
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CR 91730: Cannot create shortcuts to user-defined functions across folders 
You cannot create shortcuts to user-defined functions across folders. 

Workaround: If you want to use a user-defined function in another folder, export the user-defined function 
to XML and import the function into the folder.  

Web Services Consumer 

CR 135075 Web Services Consumer cannot find schema node for SOAP operation   
The Web Services Consumer sometimes returns the following error while parsing a SOAP response from 
the web service: 
ERROR] Encountered a problem during SOAP response conversion (RPC to DOC): 
[Cannot find schema node for SOAP operation []]. 

Web Services Provider 

CR 106939: Web service sessions running in a grid on a machine with a 64-bit operating 
system may display unexpected behavior  
If you run web service sessions in a grid on a machine with a 64-bit operating system, the web service 
sessions may generate errors and shut down unexpectedly. 

Workaround: If problems occur, disable the Session on Grid property and increase the number of partitions. 

CR 106890: Web service sessions with idle time or reader time limit as terminating 
conditions may shut down when running in a grid 
Web service sessions running on a grid on may shut down unexpectedly when you configure idle time or 
reader time limit as terminating conditions. To avoid unexpected shut downs, use message count as the 
terminating condition. 

CR 106380: PowerCenter does not create groups for mime attachments in Web Services 
Provider WSDLs imported as entity relationships 
When you import a source or target definition from WSDL (Provider) that contain mime attachments and 
generate the XML views as Entity Relationships, PowerCenter does not create the groups for the mime 
attachments. 

Workaround: When you import WSDLs with mime attachments, create the XML views as Hierarchy 
Relationships. 

CR 103592: The text for the menu selection WSDL Workspace… does not display on the 
menu selection list for a Source or Target definition imported from a WSDL (Provider) 
On a Source or Target definition imported from a WSDL, you can display the WSDL workspace to obtain 
more information about the properties of the WSDL. To display the WSDL workspace, right-click the 
Source or Target definition. However, if the Source or Target definition is imported from a WSDL 
(Provider), the text for the selection does not display. The menu displays a blank area instead of the text. 

The last selection on the menu should display the text WSDL Workspace…. Although the text does not 
appear, the functionality is available. Click the space to display the WSDL workspace for the WSDL 
associated with the Source or Target definition. 
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CR 102726: The Web Services Hub on HP-UX generates an out of memory exception at 
startup  
When you start the Web Services Hub on a 32-bit HP-UX machine, the service may generate the following 
error: 

OutOfMemoryError: unable to create new native thread 

Workaround: The default values for thread limits in HP-UX are set too low for most Java applications. The 
problem typically manifests as a Java Out of Memory error. Set the value of the max_thread_proc higher 
than the expected maximum number of simultaneously active threads for the Web Services Hub.  

For more information, see the problem documentation on the HP web site: 

http://www.hp.com/products1/unix/java/infolibrary/prog_guide/configuration.html 

CR 79188: Updating a web service workflow while it is running causes a server internal 
error 
If you update and save a web service workflow when the web service is running, client requests made to 
the web service after the modification receive a fault response with the following message: 

SERVER INTERNAL ERROR 

The Web Services Hub responds normally to client calls received before any modification to a web service 
is saved. After a modification is saved, the Web Services Hub sends a fault response to client calls. 

Workaround: To avoid server errors, do not modify a web service workflow while it is running.  

CR 78676: The Web Services Hub does not perform recovery for web service workflows 
When a web service workflow is interrupted, the Integration Service does not continue processing the 
workflow and workflow tasks from the point of interruption, even when you enable the web service 
workflow for recovery and set up a session or workflow recovery strategy.  

Workaround: The Integration Service restarts the session when it receives a request to restart in subsequent 
client calls. 

Workflow Monitor 

CR 107502: Workflow Monitor shows wrong session state when the Persist Run-time 
Statistics to Repository property is set to None  
The Workflow Monitor displays a failed session status when the session in a worklet succeeds and you do 
not configure the Integration Service to persist the run-time statistics.  

Workaround: Review the session log for the correct session status. 

CR 103090: The navigation expand and collapse buttons disappear from the Workflow 
Monitor when you run the Workflow Monitor on Windows XP for several hours with the 
Windows XP display properties theme  
When you run the Workflow Monitor for more than several hours on Windows XP, and you use the 
Windows XP display properties theme, the expand and collapse buttons in the Navigator disappear from 
the Workflow Monitor tree view.  

Workaround: Change the windows and buttons display properties to Windows Classic style. To change the 
display properties, click Control Panel > Display > Display Properties > Appearance. Select Windows and 
Buttons. Change the theme to Windows Classic. 

http://www.hp.com/products1/unix/java/infolibrary/prog_guide/configuration.html�
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CR 101918: The Workflow Monitor shuts down when you exit the Workflow Monitor with 
the Properties window undocked  
The Workflow Monitor shuts down when you exit from it after you move the Properties window away 
from the Workflow Monitor window.  

Workaround: Dock the properties window to the Workflow Monitor before exiting Workflow Monitor. For 
more information, see the Informatica Knowledge Base article 17918.  

CR 95937: Workflow Monitor shuts down unexpectedly when fetching session logs 
When the Workflow Monitor fetches a session log that is 2 GB or higher, it shuts down with an out of 
memory error. The Workflow Monitor displays a warning when the session log is larger than 500 MB. 

Workaround: Do not open the session log. Configure the session to write to a text log file and run the 
session again. Then, use a file editor to view the text log file. 

XML 

CR 97726, 71407: A session fails to parse an XML source file 
A session might fail while parsing an XML source file. The following message displays: 

XML Reader: Error occurred while parsing <Error at <error location>>. The 
attribute <attribute name> is already used in element <element name>. 

Workaround: Contact Informatica Global Customer Support. 

CR 97284: Designer imports an XMLType, CLOB, or BLOB datatype from a relational table 
as datatype Varchar2 with length zero  
When you import a relational table source that contains an XMLType, CLOB, or BLOB datatype, the 
Designer imports the datatype as Varchar2 with a length of zero. The datatype in the source definition 
should be the same type as the datatype in the relational table and the precision should be greater than zero. 

Workaround: Change the datatype of the column in the source definition and change the length of the 
column to be greater than zero.  

CR 67649: Designer hangs when importing a very complex XML schema  
The Designer might hang when you generate entity or hierarchy views while importing an XML source 
from a complex XML schema. 

Workaround: Choose to skip creating XML views when you import the XML source or target. Use the 
XML Editor to create the XML sources or targets. 

CR 67591: Integration Service generates child rows for rejected parent rows 
When you run an XML session that contains errors in the parent rows, the Integration Service generates the 
child rows even though it rejects the parent rows. Because it rejects the parent rows, the Integration Service 
generates child rows with a NULL foreign key. 

Workaround: Add a Filter transformation to the mapping to filter out all rows with a NULL foreign key. 

CR 63677: Debugger allows you to select deprecated XML Writer attributes 
The Debugger allows you to select Output XML on Flush/Commit and Output 2nd Level Groups as 
Separate XML Documents. These options were deprecated in version 7.0, and should only display for 
upgraded MQSeries XML targets. They do not work in the Debugger. 
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CR 59012: Integration Service creates an extra XML output file for On Commit multiple 
documents 
When you set the On Commit option to “Create New Document,” the Integration Service might create an 
extra XML file with no data. After a session flushes commit rows to an XML document, it opens the next 
XML document for the remaining rows. If you have no remaining rows, the last XML document is empty. 

CR 51292: Integration Service cannot read XML INF or –INF values on HP-UX or Solaris 
The Integration Service rejects XML data when you use INF (infinity) or –INF for an XML float or double 
datatype on HP-UX or Solaris.  

CR 17278: Japanese XML targets cannot use user-defined code pages 
You cannot use user-defined code pages such as the following: 

 JEF (Japanese EBCDIC Fujitsu) 

 JIPSE (NEC ACOS JIPSE Japanese) 

 KEIS (Hitachi KEIS Japanese) 

 MELCOM (Mitsubishi MELCOM Japanese) 

 UNISYS (UNISYS Japanese) 

If you select a Japanese user-defined code page for an XML target, the Integration Service ignores the code 
page. It writes a blank character encoding tag in the XML target file, as in the following example: 

<?xml version=”1.0” encoding=””?> 

Since the encoding tag is required in an XML file, the target file is an invalid XML file. 

Workaround: For Japanese XML targets, use one of the following code pages: 

 JapanEUC (Japanese Extended UNIX Code, incl. JIS X 0212) 

 MS932 (Microsoft Windows Japanese, superset of Shift JIS) 

XML Transformations 

CR 171579: The XML Parser does not allow field names greater than 80 characters   

The repository can save column names that are 80 characters or less. When you import an XML definition 
that contains a field name greater than 80 characters, the Designer truncates the column name to 80 
characters. When this results in a duplicate column name, the Designer adds a numeric suffix to the 
duplicate column name to make it unique. 

 

CR 108627: The Integration Service may terminate a session when the mapping contains 
an XML Generator transformation   
When running a session with an XML Generator transformation, the Integration Service may terminate the 
session and the following error occurs: 
FATAL ERROR: Unexpected Condition in file 
[/export/home/build80/zeusbuild/powrmart/server/cmnutils/pmcachemgr.cpp] line [935].  
Contact Informatica Global Customer Support for assistance.  Aborting this DTM 
process due to an unexpected condition. 
 
Workaround: Increase the XML Generator transformation cache size in the session properties. 
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CR 98925, 94914: XML Generator transformation creates an XML file for NULL data  
The XML Generator transformation creates an XML file with null data if the transformation does not 
receive any rows. 

Workaround: If you want to skip creating an XML file when the XML Generator transformation receives 
no data, configure the following custom property in the Administration Console for the Integration Service: 

WriteNullXMLFile=No 

CR 90535, 88171: Integration Service incorrectly validates a null element in a session 
running an XML Generator transformation  
When you create an XML Generator transformation from a schema that defines an element as an optional 
string, the session does not allow the optional element to be NULL when XML validation is enabled for a 
session. The session generates the following error when the element is NULL:  

Value is NULL but element is not nillable. 

Workaround: If you want to skip checking for null element values during the session, configure the 
following custom property in the Administration Console for the Integration Service: 

XMLNillableValidation=No  

CR 89622, 86026: The XML Generator transformation generates data in ISO-8859-1 
encoding when it is configured to output UTF-8  

When the XML Generator transformation is configured to output data in UTF-8 encoding, it outputs data in 
ISO-8859-1 when you run the Integration Service in Unicode mode. 

Workaround: To set the encoding tag to UTF-8, configure the following custom property in the 
Administration Console for the Integration Service: 

 XMLinUTF8 = yes  

Data Analyzer Known Limitations 
You may encounter the following limitations when using Data Analyzer. If you encounter difficulties or 
have further questions regarding one of these limitations, contact Informatica Global Customer Support and 
reference the CR number. 

Alerts and Indicators 

CR 82826: Cannot select rows for a position-based indicator in a ranked report with 
multiple pages 
When you create a position-based indicator in a ranked report with multiple pages, if you do not select any 
values in the report table, Data Analyzer does not allow you to select rows for the indicator in the Select 
Rows windows. Any selection you make in the Select Rows windows is not reflected in the indicator 
definition. 

Workaround: To create a position-based indicator in a ranked report with multiple pages, first select some 
cells in the report table before you click the Indicator button. 

CR 82749: Cannot change the default value for the Show All Table Rows in Indicator or 
Show All Table Rows in Indicator options 
When you create a position-based indicator and change the default value for the Show All Table Rows in 
Indicator or Show All Table Columns in Indicator option, Data Analyzer does not save your changes. 
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When you view the indicator again on the Indicator page, Data Analyzer continues to display the default 
value. 

If you select all column attribute values when you create the Indicator, the default is Show All Table Rows 
in Indicator. If you select all row attribute values when you create the Indicator, the default is Show All 
Table Columns in Indicator. 

CR 82369: Value-Based indicators created on comparison data in reports with time 
settings might not display when the time advances 
If you create a value-based indicator on comparison data in a report with the Month to Date time period, 
Data Analyzer might not display the indicator when the time advances and the comparison time period lies 
in the previous year. For example, you create a report with time period as Month to Date (MTD), 
granularity as Week by Week, and refinement as compare with MTD for previous month. You create a 
value-based indicator on the data from the previous month and add the indicator to a dashboard. When the 
time advances such that the current month is in one year and the previous month is in the previous year, 
Data Analyzer displays the following message on the dashboard and the Preview Indicator window: 

No data to display. 

Workaround: Delete the indicator and create it again in the report. 

CR 81715: Value-based table indicator created on a report with multiple time settings 
displays incorrect data 
If you have a report with more than one time setting and if you create a value-based table indicator on any 
time setting in the report, Data Analyzer always displays data from the first time period in the indicator. For 
example, a report has two time periods, one with time period as Current Year and granularity as Quarter by 
Quarter, and the other with time period as Current Year and no granularity. If you create a value-based 
table indicator on the second time period, the indicator shows data for the first time period. 

Dashboards 

CR 80052: Importing a dashboard exported from a personal folder might create an empty 
folder 
If you import a dashboard exported from a personal folder, Data Analyzer imports the dashboard to a new 
folder named Public Folders > Personal Dashboards (Imported date_of_import) > username. For example, 
if the admin user imports a dashboard on October 24, 2005, Data Analyzer stores the dashboard in a new 
Public Folders > Personal Dashboards (Imported 10-24-05) > admin folder. 

However, Data Analyzer does not allow dashboards with the same name to exist in the same repository, 
even if the dashboards are stored in different folders. If you import a dashboard exported from a personal 
folder and a dashboard with that name already exists in the repository, Data Analyzer provides an option to 
overwrite the original dashboard with the imported version. If you select Overwrite, Data Analyzer 
overwrites the original dashboard and creates an empty Public Folders > Personal Dashboards (Imported 
date_of_import) > username folder.  

Workaround: Rename the dashboard in the source repository before exporting the dashboard. To rename a 
dashboard, find the dashboard on the Find tab. Select the dashboard, and click Edit. Enter a new name. 

Reports and Report Charts 

CR 102847: Data Analyzer does not apply a report table sort order based on a CLOB 
attribute 
If you create a report table sort order based on a CLOB attribute in the Create Report Wizard, Data 
Analyzer does not apply the sorting to the report on the Analyze tab. 



   98

Workaround: Display the report on the Analyze tab and then use the sort buttons at the top of the CLOB 
attribute column to sort the report data. 

CR 102587: When using Microsoft Excel with a report that has a suppressed GROUP BY 
clause, the report does not display correct data 
If you suppress the GROUP BY clause in a report with a non-numeric metric, the report data does not 
display correctly when you create an Excel template for the report or export the report to an Excel 
PivotTable. If you display the report as an Excel PivotTable on the Analyze tab, Data Analyzer displays an 
error. 

If you suppress the GROUP BY clause in a report that contains numeric metrics only and then export the 
report to an Excel PivotTable, the report displays aggregated data instead of granular data. 

CR 99549: Cannot create a report chart when attribute value contains line breaks 
If a report contains an attribute value that has line breaks, Data Analyzer displays an error when you create 
a chart for the report on the Analyze tab. 

CR 89389: Custom attribute may result in incorrect aggregation for calculated metric 
If you create a report that contains a custom attribute and a calculated metric, Data Analyzer uses basic 
aggregation only (SUM, MIN, MAX, and COUNT) to evaluate the metric. Since calculated metrics do not 
have aggregation defined, Data Analyzer sums the calculated metric values. This results in an incorrect 
value if the calculated metric is non-additive but you set it to Additive when you defined the metric 
properties. 

For example, you create a report that has the following result set: 

City Sales Qty ASP (Sales/Qty) 
============================ 
SF 10000 1000 10 
SJ 90000 9000 9 
Oak 12000 1000 12 

You add a custom attribute that groups the three cities into a single value called “SF Bay Area” and then 
remove City from the report. Data Analyzer sums the values for the ASP calculated metric, producing the 
following incorrect result: 

Metro Region Sales  Qty ASP (Sales/Qty) 
=============================================== 
SF Bay  112000  12000 31 

The following is the expected correct result: 

Metro Region Sales  Qty ASP (Sales/Qty) 
=============================================== 
SF Bay  112000  12000 9.33 

CR 82507: Cannot create a gauge indicator on a custom aggregate cell in a cached report 
If you add a custom aggregate calculation to a cached report, you cannot create a gauge indicator on the 
custom aggregate value. When you create a gauge indicator on the custom aggregate cell, Data Analyzer 
displays the following message in the Preview Indicator window and on dashboards: 

No data to display. 

Workaround: You can create a gauge indicator on the custom aggregate value if you save the report and 
open it again from the Find tab. 
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CR 82418: Drilling is not supported on a ranked report based on a hierarchical schema or 
on a custom attribute in a report based on a hierarchical schema 
Drilling on a ranked report based on a hierarchical schema or on a custom attribute in a report based on a 
hierarchical schema is not supported. 

CR 82152: Selected date and time formats for section attributes are not displayed correctly 
in View tab for a report with two sectional tables 
If you create a report with two sectional tables each based on a timestamp attribute, the date and time 
formats you select for the section attributes might not display correctly on the View tab. Regardless of your 
selection when creating the report, the View tab displays the following formats for the section attributes: 

‘MM/dd/yyyy’ for the first sectional table. The time format is not displayed. 

‘yyyy-MM-dd HH:mm:ss.0’ for the second sectional table. 

CR 82053: In a report with time settings, cannot create a custom metric using a custom 
attribute 
If a report with time settings includes a custom attribute, you cannot use the custom attribute as an 
argument for a function in a custom metric expression. For example, you have a report that displays the 
sales in the current month for all products. You create a custom attribute, Product Type, in the report. You 
pass Product Type as the argument for a function in a custom metric expression as follows: 

Within({Product Type}, "Drinks") 

Data Analyzer displays an error message when you validate the expression. 

Note: You can use custom attribute as the value of the Context argument. In this case, Data Analyzer does 
not display an error message. For the preceding example, you can use the following expression: 

Sum({Sales}, “{Product Type}=‘Food’, ‘Drinks’”) 

CR 81856: Report based on a hierarchical schema does not display results if an attribute 
filter uses a global variable 
When you run a report that is based on a hierarchical schema and that contains an attribute filter with a 
global variable as the value, the Analyze tab displays “No report results to be displayed.” 

Workaround: Assign a different value to the attribute filter by selecting from the list of available values or 
by manually entering a value. To edit the attribute filter value from the Analyze tab, click Edit > Select 
Time, Filters, and Rankings > Filters. In the Add Filter task area, click Attribute Filter. Click the existing 
attribute filter and assign a new value. 

CR 81832: Cannot create Combo and 2Y charts or chart indicators for a report with metrics 
as rows 
If you have a report with a simple report table where you display the metrics as rows, you cannot create 
Combo and 2Y charts or chart indicators for the report. For example, you have a report with two metrics 
and two attributes. The report displays the metrics as rows in the report table. If you create a Combo or 2Y 
chart or chart indicator, Data Analyzer displays the following message in the Preview Indicator window 
and on the dashboard: 

Not enough data to plot. This chart type requires at least 2 group(s). 

Workaround: Change the report table to a cross tabular table. If the report table has two or more column 
attribute values, you can create Combo and 2Y charts or chart indicators for the report. 
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CR 81824, 81513: When connected to a DB2 database, searching for numeric attribute 
values while creating a filter or indicator does not return expected results 
When you create an attribute filter in the Create Report wizard, add an attribute filter on the Analyze tab, or 
create an indicator for a multi-page report on the Analyze tab, you can use the Select Attribute Values 
option to select numeric attribute values. When you use the Select Attribute Values option, you can search 
for a numeric value in the Choose Attribute Values window. If you use a DB2 database as the data 
warehouse, when you search for a numeric attribute value in the Choose Attribute Values window, Data 
Analyzer may not return the expected results in certain cases.  

Workaround: Use the wildcards asterisk (*) or percent (%) in the search. For example, if you want to 
search for all values starting with 1, entering 1% might not return the expected results. Entering %1% 
returns all values containing 1. In these situations, you can try entering %01% to achieve the expected 
results. 

CR 81787: Selecting chart colors is not supported for HTML attributes set to SQL 
expressions 
If you select chart colors for an HTML attribute that contains an SQL expression in an analytic or 
operational schema, the selected colors do not display in report charts containing this attribute. Instead, 
Data Analyzer selects the chart colors. However, chart colors selected for an HTML attribute set to a 
column name correctly display in report charts. 

CR 81719: Attribute and custom metric string values contained within the symbols < > 
display as blank values on the View tab 
If a report contains attribute or custom metric string values which contain text within the symbols < >, 
these values do not display on the View tab. For example, if a report contains a string attribute with the 
value “<Big Can>”, when you display the report on the View tab, the attribute displays a blank value. 

Workaround: Display the report on the Analyze tab to view the correct values. 

CR 81555: Exporting a report to CSV loses formatting on numeric attribute values 
When you export a report from the Analyze tab to a CSV document, numeric attribute values do not display 
zeros to the right of the decimal point in the exported file. For example, if a numeric attribute value 
displays on the Analyze tab as 14.00, it displays in the exported CSV document as 14. However, a value of 
6.7 on the Analyze tab still displays as 6.7 in the exported CSV document. 

CR 81436, 69525: Browser hangs if a report with time settings exceeds upper limits 
If you add time settings to a report, you must be aware of the upper limits if you select For Last N Time 
Periods as the time period. A report that exceeds the limits causes the browser to hang when you run the 
report. 

The following table lists the upper limits for a time setting defined as For Last N Time Periods for a one 
level sectional report with 2 attributes, 1 metric, and 14 sections containing one row per section. The limits 
are listed for each granularity: 

Day by Day Week by Week Month by Month Quarter by Quarter Year by Year 

1525 days n/a n/a n/a n/a 

104 weeks 414 weeks n/a n/a n/a 

24 months 86 months 108 months n/a n/a 

8 quarters 32 quarters 36 quarters 36 quarters n/a 
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1 year 8 years 9 years 9 years 9 years 

CR 81219: Cannot add time keys to a calculated metric 
If you create a report with a calculated metric and base metrics used in the calculated metric expression, 
you cannot select time keys for the calculated metric in Step 1 of the Create Report wizard. You can select 
time keys for the base metrics only. 

If you create a report with only one metric, a calculated metric created in the Schema Directory, you cannot 
add time keys for the metric. 

CR 78632: Exporting a report to CSV on Internet Explorer displays two File Download 
dialog boxes and incorrectly displays the report name 
Due to Internet Explorer limitations, when you export a report from the Analyze tab as a CSV document 
and click Open in the File Download dialog box, a second File Download dialog box displays. When you 
click Open, Microsoft Excel incorrectly displays the report name in the worksheet. For example, a report 
named TestReport is displayed as .csv]TestReport[1]. 

CR 77235: Granularity is lost when you remove a filter from a report with time settings 
In a report with time settings, if you add a filter by selecting cells in the report table and clicking the Filter 
button, when you remove the filter the granularity does not display in the report. For example, you have a 
report that displays data for the current year with Quarter by Quarter granularity. If you select a few cells in 
the Q2 column and click the Filter button, Data Analyzer adds filters for the selected attribute values. In the 
report table, Data Analyzer displays data for Q2 for the selected attribute values. If you remove the filters 
from the report, Data Analyzer continues to display data for Q2 only. Data Analyzer does not display data 
for Q1, Q3, and Q4. 

Workaround: Add filters to the report by selecting attribute and metric values from the Filter tab. When you 
remove these filters from the report, the granularity does not display in the report. If you already created the 
filter by selecting cells in the table and want to go back to the original report, open the report from the Find 
tab. 

CR 72691: When you use Sybase as a data source, you cannot use “only show values 
similar to” and “only show values not similar to” operators in filters on numeric attributes 
Due to a Sybase database limitation, when you use Sybase as a Data Analyzer data source, you cannot use 
the “only show values similar to” and “only show values not similar to” operators in filters on numeric 
attributes. If you try to use these operators in filters on numeric attributes in a report, Data Analyzer 
displays an error message when you try to run the report. 

System Administration 

CR 102654: In a WebLogic cluster, you cannot export report data from the View tab on a 
machine that hosts a managed server 
If Data Analyzer runs in a cluster in BEA WebLogic Server and you export report data from the View tab 
on a machine that hosts a managed server, the exported PDF or HTML document does not contain any 
data.  

Workaround: Export report data from the View tab on the machine that hosts the administration server. 

-or- 

To export report data from a machine that hosts a managed server, update the scopeserver.xml 
configuration file and then redeploy Data Analyzer using the WebLogic Administration Console. The 
scopeserver.xml file contains the settings for formatted reports in Data Analyzer. The scopeserver.xml file 
is stored in the Data Analyzer EAR file.  
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In a Data Analyzer cluster in BEA WebLogic Server, all servers in the cluster use the Data Analyzer EAR 
file on the machine that hosts the administration server. You update the scopeserver.xml file on the 
machine that hosts the administration server so that the file contains the host name and port number for a 
machine that hosts one of the managed servers. You can then export report data from the View tab only on 
the machine that hosts this managed server. 

To update the scopeserver.xml file and redeploy Data Analyzer: 

1. On the machine that hosts the administration server, use the EAR Repackager utility to extract the Data 
Analyzer EAR file. 
For more information about using the EAR Repackager utility, see “Accessing the Data Analyzer EAR 
File” in the Data Analyzer Administrator Guide. 

2. In the directory where you extracted the Data Analyzer EAR file, locate the scopeserver.xml file in the 
following directory: 
/custom/properties/ 

3. Open the scopeserver.xml file with a text editor. 
4. Locate the line with the following text: 

<Property name="layout runner url"> 

The file contains the following lines: 

<Property name="layout runner url">HostName:Port/ 
<DataAnalyzerInstance>/layoutrunner</Property> 

<Property name="excel data url">HostName:Port/ 
<DataAnalyzerInstance>/exceldata</Property> 

5. Change the URL to use the host name and port number for the machine that hosts one of the managed 
servers. 

6. Locate the lines with the following text: 
<Property name="host"> 

<Property name="port"> 

7. Change the host and port values to use the host name and port number for the machine that hosts one 
of the managed servers. 

8. Save and close the scopeserver.xml file. 
9. Use the EAR Repackager utility to repackage the configuration files in the working directory into the 

Data Analyzer EAR file. 
10. On the machine that hosts the administration server, log in to the WebLogic Administration Console. 
11. In the left panel of the WebLogic Administration Console, click Deployments > Applications > Data 

Analyzer instance. 
The default name of the Data Analyzer instance is ias. 

The Configuration page appears. 

12. Select the Deploy tab. 
13. Click Redeploy Application. 
14. Restart all the managed servers in the cluster. 

For more information about restarting the managed servers, see “Setting Up a Data Analyzer Cluster in 
WebLogic” in the Data Analyzer Administrator Guide. 

CR 89888, 89884: When using Data Analyzer in Japanese, some text is not translated and 
displays in English 
When using Data Analyzer in Japanese, some text is not translated and displays in English when you 
navigate to the following pages: 



 103

 LDAP Setting page. Click Administration > System Management > LDAP Settings. Click Add. The 
text URL and BaseDN is not translated and displays in English. 

 Time-Based Schedules page. Click Administration > Scheduling > Time-Based Schedules. The text 
Daily is not translated and displays in English. 

 Weekly view of the Calendar. Click Administration > Scheduling > Calendar. Click Weekly. The text 
Daily is not translated and displays in English.  

CR 84963: Importing large number of Teradata table definitions may require longer 
database transaction timeout 
When you import a large number of table definitions from a Teradata database, the process may take some 
time. If the database transaction timeout is not long enough to allow Data Analyzer to complete all the 
database transactions, Data Analyzer does not import any table definition. 

Workaround: You can use one of the following solutions to import a large number of table definitions from 
a Teradata database: 

 Import a small number of table definitions at a time. With the default transaction timeout, 
Informatica recommends importing no more than about 20 table definitions at a time. 

 Increase the database transaction timeout. With a longer transaction timeout, you can import more 
than 20 table definitions at one time. To increase the database transaction timeout, increase the value 
for the DeadLockTimeout parameter. For more information about the Teradata database parameters, 
see the Teradata database documentation. 

CR 78816: Cannot edit or delete fact table attributes that have names with the following 
characters: , ‘ )  
Data Analyzer does not support fact table attribute names containing a combination of the following 
characters: , ‘ ). For example, the attribute name ‘c1’, ‘c2’, ‘c3’) is not supported in a fact table. If you 
create a fact table from a data warehouse table with column names containing these characters, and then 
define attributes from the fact table columns, you cannot to edit or delete the attributes.  

CR 73285: If you use Data Analyzer with a Sybase repository, Data Analyzer displays an 
exception message when you perform tasks that require a large procedure cache size 
On Data Analyzer with a Sybase repository, Data Analyzer displays an exception message when you 
perform tasks that require a large procedure cache size. Tasks that require a large procedure cache size 
include using the Overwrite All option when you import a large schema. Data Analyzer displays the 
following exception message: 

SQL Exception: [Informatica][Sybase JDBC driver][Sybase] There is not 
enough procedure cache to run this procedure, trigger, or SQL batch... 

Workaround: Ask your database administrator to increase the procedure cache size. 

CR 70566: Canceling changes to an operational schema table does not cancel changes to 
attributes or metrics in the table 
When you add or delete metrics and attributes in an operational table, Data Analyzer keeps the addition or 
deletion even if you cancel changes to the operational table. For example, you edit a table in an operational 
schema. You click Add From Table and add a metric to the table. You then click OK to return to the 
Operational Schema Table page. If you click Cancel at this point, Data Analyzer does not cancel the 
changes to the table. It does not roll back the addition of the metric to the table. The new metric remains in 
the operational schema table. 
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CR 64764: If you update or delete a real-time message stream and the database 
transaction fails, the real-time message stream may be left in an inconsistent state in the 
repository 
If you update or delete a real-time message stream and the database transaction fails due to a database 
connection error, Data Analyzer displays an exception message and the real-time message stream may be 
left in an inconsistent state in the repository. You cannot edit or delete a real-time message stream left in an 
inconsistent state. 

Workaround: Recreate the real-time message stream. 

CR 64684: When you edit a filterset, Data Analyzer does not update the cache for a report 
with these changes until the schedule for the report runs 
If you use a filterset in a cached report, when you edit the filterset, Data Analyzer does not update the 
report with the changes made to the filterset. 

Workaround: You can update the report based on the edited filterset in one of the following ways: 

 Run the schedule for the report. Data Analyzer updates the report results based on the changes made to 
the filterset. 

 Click Edit Report, and then save the report. Data Analyzer refreshes the cache for the report. 

CR 63406: HTML link displays when you export a report that uses an HTML type attribute 
Due to a third party limitation, when you export a report that uses an HTML type attribute to Microsoft 
Excel and choose Retain Data Analyzer Formatting, the exported Excel file displays the entire HTML link 
instead of the HTML search string. 

CR 61858: Spaces in column names are not supported for several tables 
Data Analyzer does not support an aggregate fact table, a time key in a fact table, or a time dimension table 
created from a data warehouse table containing spaces in column names. 

CR 60677: Data Analyzer does not support locale-specific sort ordering 
You can specify a sort order when you perform the following tasks: 

 Define an attribute for a dimension table. 

 Define an attribute for a time dimension table.  

 Define an attribute in a fact table. 

 Define an attribute in an operational schema table. 

 Specify an ORDER BY clause when using a Lookup table in the List of Values. 

In each of the above cases, you can choose from Default Sorting As Performed by DB or use the order 
provided for the List of Values. If you choose the Default Sorting as Performed by DB option, you must 
make sure that the database administrator has set up locale-specific sort ordering on the database. If the 
database administrator has not set up locale-specific sort ordering on the database, Data Analyzer might 
return incorrect sort results if your data is not in English.  

CR 59013: Time keys with system names longer than 31 characters generate Oracle error 
Due to an Oracle limitation, you cannot create time keys with system names longer than 31 characters. Data 
Analyzer allows you to create time keys with system names longer than 31 characters. However, when you 
use this time key in a report, and then run the report, Data Analyzer displays the following error message: 

An unexpected error has occurred: ORA-00972: identifier is too long. 

Workaround: Edit the time key and assign it a shorter system name. Recreate the report. 
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Connection problems with IBM DB2 data warehouses on AIX 
By default, AIX does not permit 32-bit applications to attach to more than 11 shared memory segments per 
process, of which a maximum of 10 can be used for local IBM DB2 connections. If you have an IBM DB2 
data warehouse on the AIX platform, you might get connection refused error messages over time. You need 
to use extended shared memory (EXTSHM). EXTSHM allows IBM DB2 to access additional shared 
memory segments. To use EXTSHM with DB2, complete the following tasks:  

1. In /etc/environment: 

append "EXTSHM=ON" 

2. In $DB2_HOME/sqllib/db2profile: 

append "EXTSHM=ON;export EXTSHM 

3. Run in DB2 environment: 

"db2set DB2ENVLIST=EXTSHM"  

4. Shut down the database and reboot the machine: 

"db2stop force" 

reboot server 

5. Restart the database server: 

"db2start" 

Utilities 

CR 103207: The Data Analyzer EAR Repackager Utility may fail to start when you run it 
When you run the EAR Repackager Utility, the utility might display the following error: 

C:\Informatica\DataAnalyzer\ear_repackagerutil\build.xml:6: Following 
error occurred while executing this line 

C:\Informatica\DataAnalyzer\ear_repackagerutil\common.xml:46: The source 
ear file is not found at 
C:\Informatica\DataAnalyzer\ear_repackagerutil\${earlocation.dir}/${iasea
r.name}'. Exiting the application 

Workaround: Modify the file to run the EAR Repackager Utility and rerun the utility. Back up the EAR 
Repackager Utility file before you modify it. 

To modify the EAR Repackager Utility file: 

Go to the EAR Repackager Utility directory: 
<PowerCenterInstallationDir>/DataAnalyzer/ear_repackagerutil 

1. Open the EAR Repackager Utility file with a text editor: 
Windows: run.bat 

UNIX: run.sh 

2. Search for the following text: 

rem # Invoke ANT with the validated command line parameters 

ant.bat %ANT_CMD_LINE_ARGS% 

3. Replace ant.bat %ANT_CMD_LINE_ARGS% with ant.bat “%ANT_CMD_LINE_ARGS%” 

4. Save and close the EAR Repackager Utility file. 
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For more information about the EAR Repackager Utility, see “Accessing the Data Analyzer EAR file” in 
the Data Analyzer Administrator Guide. 

Metadata Manager Known Limitations 
You may encounter the following limitations when using Metadata Manager. If you encounter difficulties 
or have further questions regarding one of these limitations, contact Informatica Global Customer Support 
and reference the CR number. 

Administration 

CR 84226: Tool tips for assigned privileges do not display in the correct position when 
adding a role 
When you add a Metadata Manager role and you place your cursor over an assigned privilege, the tool tip 
does not display near the assigned privilege. It displays at the top of the page.  

CR 83106: Metadata Manager does not import report links associated with imported 
objects 
If you import a metadata object into a new repository, Metadata Manager does not import the associated 
report links. 

Workaround: Create the report links in the new repository. 

CR 75252: Security settings on metadata in the Metadata Manager Warehouse does not 
apply to the Design-Time Lineage report 
The Design-Time Lineage report displays all applicable metadata in the lineage diagram and field-level 
details, regardless of the security settings for the user account. For example, if you only have permissions 
to browse metadata in a specific Oracle database, when you run the Design-Time Lineage report, the report 
shows all repositories involved in the lineage. 

CR 72882: SGCmd does not create a log file and does not warn you if the provided log file 
directory does not exist 
If you specify a log name in sgcmd_log4j.properties and provide a complete path to a log directory that 
does not exist, the SGCmd does not create the log and successfully exits with error code 0 (success). If 
SGCmd does not create a log file, it should fail. 

CR 67023: You cannot import pieces of a metamodel from a metamodel file 
When importing a metamodel, you must import the entire metamodel. You cannot import pieces of a 
metamodel from a metamodel file. 

CR 63504: User permission settings do not control the list of repositories displayed at the 
top levels in the metadata tree  
Metadata Manager does not allow you to use user permission settings to control the list of repositories 
displayed in the top levels of the metadata tree. The repository object displays in the metadata tree, but 
details and content within the repository are not accessible.  
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Application Servers 

CR 87997: Metadata Manager on BEA WebLogic Server may time out if a Metadata 
Manager query returns too many objects 
If you run a query in the Metadata Browser and Metadata Manager returns too many objects, you may 
receive the following error: 

Caused by: javax.ejb.EJBException: nested exception is: SQL Exception: 
The transaction is no longer active - status: 'Markedrollback. 
[Reason=weblogic.transaction.internal.TimedOutException: Transaction 
timed out after 32 seconds  

Due to this exception, it throws JSE in the client side. This timeout exception only applies if you are 
running Metadata Manager on WebLogic Application Server. 

Workaround: To resolve the error, complete the following tasks: 

1. Open the WebLogic Administrator Console. 

2. Click Other Services > JTA Configuration > Timeout Seconds. 

3. Increase the number of seconds. 

Custom Metadata Configurator 

CR 133918: The Custom Metadata Configurator generates an incorrect mapping when you 
create more than nine association maps 
The Custom Metadata Configurator generates an incorrect mapping when you create more than nine 
association maps and try to generate the mapping for a custom XConnect. 

CR 96556: Integration Service process rejects records that have duplicate keys 
When you configure mappings for custom XConnects in the Metadata Manager Custom Metadata 
Configurator, you assign keys to identify each record. If records have duplicate key values, the Integration 
Service process loads the first record and rejects all other records that have the same key value.  

CR 96505: Log Manager does not generate session logs for mappings created by the 
Metadata Manager Custom Metadata Configurator 
When an Integration Service process runs sessions for mappings that were created by the Metadata 
Manager Custom Metadata Configurator, the Log Manager does not create session logs.  

Workaround: To create session logs, enable the session to write to log files. 

CR 96482: Metadata Manager Custom Metadata Configurator does not create the Visibility 
property 
If you map a column to the Visibility class property in the Metadata Manager Custom Metadata 
Configurator and you generate the PowerCenter mappings, the Custom Metadata Configurator loads 
“visibility” as a property value instead of the name of the property.  

CR 92255, 90233: Metadata Manager Custom Metadata Configurator supports English only 
You must run the Metadata Manager Custom Metadata Configurator on an English machine. It currently 
does not support other languages. 
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CR 90800: An error occurs if you log in to the Metadata Manager Custom Metadata 
Configurator before the Metadata Manager Console for the first time 
The first time you log in to the Metadata Manager Warehouse from the Metadata Manager Custom 
Metadata Configurator before you log in from the Metadata Manager Console, you receive the following 
error: 

Custom Metadata Configurator is not able to save login information. 

Workaround: Log in to the Metadata Manager Warehouse from the Metadata Manager Console before you 
log in from the Metadata Manager Custom Metadata Configurator. 

-or- 

Click OK when you receive the error. You can still log in to the Metadata Manager Warehouse from the 
Metadata Manager Custom Metadata Configurator. However, it will not save the connection information. 
Thus, when you log in again, the Metadata Manager Custom Metadata Configurator will not remember the 
connection information from the previous login. You must enter the connection information again. 

CR 89733: You cannot move metadata files to a new location 
You specify the location of the element and association metadata files in the Metadata Manager Custom 
Metadata Configurator. If you move a metadata file to a new location and you try to view the maps to the 
file, the Metadata Manager Custom Metadata Configurator notifies you that the file is not found in the 
location mentioned in the template. If you try to map additional attributes or associations, you receive the 
following error: 

Please select at least one source file. 

Workaround: Do not move the metadata file from its original location. 

CR 88953: If you select Struct or Field and you did not define an association, use the 
ModelElementDependency association 
When you select the Struct or Field option on the Associations tab of the Metadata Manager Custom 
Metadata Configurator, you must select an association between the two classes. If you already defined an 
association between the classes when you created the metamodel, select the association. Otherwise, select 
the ModelElementDependency association. 

CR 88734: Metadata Manager Custom Metadata Configurator does not retain the name of 
the association metadata file 
When you select an association file in the Metadata Manager Custom Metadata Configurator and select an 
element metadata file, the Association File field changes to the same name as the selected element metadata 
file.  

Workaround: Reselect the association metadata file. 

CR 87499: Metadata Manager Custom Metadata Configurator hangs if you provide an 
invalid database type when you log in 
The Metadata Manager Custom Metadata Configurator hangs when you log in if you provide a database 
type that does not correspond to the database, user name, and password. For example, if you enter a 
database name, user name and password for an Oracle database, but you select a SQL Server database type, 
the Metadata Manager Custom Metadata Configurator hangs.  

Workaround: Provide the correct database type when you log in to the Metadata Manager Custom Metadata 
Configurator. 
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CR 86886: You must specify a rule for each class if you map multiple classes for a single 
template file 
In the Metadata Manager Custom Metadata Configurator, if you map multiple classes for a single template, 
you must specify a rule for each class. You use a rule to identify the rows in the metadata file that apply to 
a particular class. The generated mappings use the class rules as filters to extract the appropriate class 
details. 

If you do not specify a class rule when you map multiple classes for a template file, you receive the 
following error when you try to save the template: 

Class Rule is not defined. 

If you map only one class for a template, you do not have to provide a class rule. 

Database Connectivity 

CR 73497: When using DataDirect ODBC drivers to connect to a DB2 database, Metadata 
Manager generates an exception 
If you use the ODBC driver that Informatica ships with Metadata Manager to connect to a DB2 8.x 
repository database, Metadata Manager may display the following exception message: 

javax.ejb.EJBException: nested exception is: Exception: SQL Exception: 
[informatica][DB2 JDBC Driver]No more available statements. Please 
recreate your package with a larger dynamicSections value. 

Workaround: This occurs because the default value, 200, for the DynamicSections connection property for 
the DB2 database is too small. Increase the default value of the DynamicSections connection property to at 
least 500. 

To increase the default value of the DynamicSections connection property, use the DataDirect Connect for 
JDBC utility. The DataDirect Connect for JDBC utility is included in the 330connectjdbc.jar file. You can 
download this jar file from the Product Downloads page of the DataDirect website: 

http://www.datadirect.com/download/downloadindex.asp  

On the Product Downloads page, click DataDirect Connect for JDBC Any Java Platform link and complete 
the registration information to download the 330connectjdbc.jar file. 

To increase the default value of the DynamicSections connection property: 

1. Grant database administrator permissions to the database user name you use to connect to the DB2 
database from Metadata Manager. 

2. Extract the contents of the 330connectjdbc.jar file to a temporary directory. 

3. Install the DataDirect Connect for JDBC utility. 

To install the DataDirect Connect for JDBC utility: 

1. Run one of the following files from the directory where you extracted the 330connectjdbc.jar file: 

On Windows. Installer.bat  

On UNIX. Installer.sh  

2. On the DataDirect Connect for JDBC window, click Next. 

3. Accept the terms in the license agreement, and then click Next. Enter “eval” as the license key, and 
then click Add. Click Next twice. Click Install. 

4. Click Finish to complete the installation. The installation program for the DataDirect Connect for 
JDBC utility creates the testforjdbc folder in the directory where you extracted the 330connectjdbc.jar 
file. 

http://www.datadirect.com/download/downloadindex.asp�
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5. From the testforjdbc folder, run the Test for JDBC Tool. 

To run the Test for JDBC Tool:  

1. Run one of the following files: 

On Windows. testforjdbc.bat 

On UNIX. testforjdbc.sh 

2. On the Test for JDBC Tool window, click Press Here to Continue.  

3. Click Connection > Connect to DB.  

4. In the Database field, enter the following text: 

jdbc:datadirect:db2://<server_name>:<port_number>;databaseName=<database_name>;CreateDefaul
tPackage=TRUE;ReplacePackage=TRUE;DynamicSections=500 

where: 

server_name is the name of the machine hosting the repository database. 

port_number is the port number of the database. 

database_name is the name of the DB2 repository database.  

Note: If you continue getting an exception, you can increase the value of DynamicSections to 750 or 
1000. 

5. In the User Name and Password fields, enter the user name and password you use to connect to the 
DB2 database from Metadata Manager. 

6. Click Connect, and then close the window. 

7. Restart the application server. 

Globalization 

CR 101387: Metadata Manager shows some fields in English when using the Chinese 
locale 
When you use the Chinese locale, most field names in Metadata Manager appear in Chinese, but others 
appear in English. 

CR 92506, 92252: Data lineage does not display Japanese characters correctly 
Data lineage does not display Japanese characters correctly. 

Workaround: To display Japanese characters correctly in data lineage, complete the following steps:  

1. In the DataAnalyzer.properties file, change the Chart.FontName property to Arial Unicode MS. 

2. Install the Unicode font on the Metadata Manager client machine that displays data lineage. 

The client machine uses the Unicode font to display multibyte character sets through the SVG Viewer. For 
more information about installing the Unicode font, see the following URL: 

http://www.stthomasgoc.org/unicode.html 

CR 90692: You must change the code page if you are loading non-English metadata into 
the Metadata Manager Warehouse  
If you load non-English metadata from a flat file into the Metadata Manager Warehouse, then you must 
change the code page of the PowerCenter file reader. The file reader reads the metadata in the flat files. Use 
the Shift-JIS code page if you want to load Japanese metadata using the Business Objects XConnect. Use 

http://www.stthomasgoc.org/unicode.html�
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the UTF-8 code page if you want to load non-English metadata using any XConnect that uses MITI 
technology.  

The following XConnects use MITI technology: 

 Erwin 

 PowerDesigner 

 Rational Rose 

 Visio 

 ERStudio 

 Hyperion Essbase 

 OracleDesigner 

 Cognos Impromptu 

 Cognos ReportNet Framework Manager 

 DB2 Cube Views 

 Microstrategy 

To change the code page, log in to the Workflow Manager. For each of the following sessions that read 
from a flat file, change the code page of the file reader: 

S_M_CLASS_ATTR_FLAT_FILE_PRIMARY_EXTRACT 
S_M_CONNECTION_FLAT_FILE_EXTRACT 
S_M_CONNECTION_PRIMARY_FILE_EXTRACT 
S_M_ELEMENT_FIRST_FILE_LOAD 
S_M_ELEMENT_FLAT_FILE_EXTRACT 
S_M_ELEMENT_PRIMARY_FILE_EXTRACT 
S_M_ELMNT_ASSOC_FLAT_FILE_EXTRACT 
S_M_ELMNT_ASSOC_FLAT_FILE_FIRST_LOAD 
S_M_ELMNT_ATTR_FLAT_FILE_EXTRACT 
S_M_ELMNT_ATTR_FLAT_FILE_FIRST_LOAD 
S_M_EVENT_FLAT_FILE_EXTRACT 
S_M_EVENT_PRIMARY_FILE_EXTRACT 
S_M_EXPRESSION_FLAT_FILE_EXTRACT 
S_M_EXPRESSION_PRIMARY_FILE_EXTRACT 
S_M_FEATURE_MAP_FIRST_FILE_LOAD 
S_M_FEATURE_MAP_FLAT_FILE_EXTRACT 
S_M_FEATURE_MAP_GENERIC_FILE_EXTRACT 
S_M_FEATURE_MAP_GENERIC_FIRST_FILE_LOAD 
S_M_RUN_FLAT_FILE_EXTRACT 
S_M_STATUS_FLAT_FILE_EXTRACT 
S_M_STATUS_PRIMARY_FILE_EXTRACT 
S_M_TASK_LOG_FLAT_FILE_EXTRACT 
S_M_TASK_MAP_FLAT_FILE_EXTRACT 
S_M_TASK_STRUCT_FLAT_FILE_EXTRACT 

CR 90692, 89976, 89975: ERStudio and Erwin source metadata may appear incorrectly in 
the Metadata Browser if the code pages do not match 
If the code page of the source file format does not match the code page for the PowerCenter session file 
reader, the source metadata may not appear correctly in the Metadata Browser. 

Workaround: Change the code page of the PowerCenter session file reader to match the code page of the 
source file format.   
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CR 89859: The CC, BCC, and OK options are not translated into Japanese 
If you are running Metadata Manager using a Japanese locale and you try to email results from a metadata 
search, data lineage, or where-used analysis, the following options are not translated into Japanese: 

 CC. The Carbon Copy (CC) option on the Email page. 

 BCC. The Blind Carbon Copy (BCC) option on the Email page. 

 OK. The OK option on the Attachments page. 

Installation 

CR 104525: If you install Metadata Manager with an existing repository that uses a 
different database, the installer does not set up the connection to the repository correctly 
If you install Metadata Manager with an existing Metadata Manager or PowerCenter repository and the 
database type is different than when you first created the repository, the installer does not set up the 
connection to the repository correctly. 

Workaround: If you do not use the same database type, you must manually configure the MM_WH_Conn 
connection in the Workflow Manager to the repository. 

CR 98400: The installer does not prompt you to start the Metadata Manager server before 
you upgrade metamodels and reports 
You must start the Metadata Manager server before you upgrade the metamodels and reports. If you do not 
start the Metadata Manager server, the installer fails to upgrade the metamodels and reports. 

Metadata Directory 

CR 106503: An error occurs when you enter \ and a special character in the beginning of 
the search criteria and you search all object properties 
A null pointer exception error occurs when you enter \ and a special character in the beginning of the search 
criteria and you search all object properties. Examples of special characters include &, ^, $, #, and {. 
Metadata Manager does not display a null pointer exception when you start a search with \ and one of the 
following wildcard characters: *, %, _. 

CR 83712: Metadata Manager does not allow you to edit object link properties 
After creating an object link, you cannot edit the properties, such as the Description property.  

CR 67234: Results task area does not reflect changes to object properties immediately 
When you modify object properties that display in the Results and Details task areas, the Details task area 
displays the changes immediately, but the Results task area does not.  

Workaround: To refresh the display, select a different object in the Metadata tree, and then select the 
original object.  

CR 65038: Metadata Manager does not update the Repository Refresh Date when you 
modify metadata through the Metadata Directory 
When you update the repository with new metadata through the Metadata Directory, Metadata Manager 
does not update the Repository Refresh Date. 
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Metadata Manager Console 

CR 105076: The Metadata Manager Console does not refresh the list of deleted source files 
for some XConnects 
If you delete a source file from the list of source files in the Metadata Manager Console, the Metadata 
Manager Console does not refresh the list of source files for the following XConnects: 

 Business Objects 

 Cognos Impromptu 

 Cognos ReportNet Content Manager 

 Hyperion Essbase 

 IBM DB2 CubeViews 

CR 104812: The Metadata Manager Console does not save connection information when 
you try to save the information for one XConnect and another XConnect is highlighted 
When you try to save the source repository connection information for one XConnect on the Configuration 
Properties tab and another XConnect is highlighted, the Metadata Manager Console displays an exception 
and does not save the connection information.  

CR 103343: Error occurs when starting Metadata Manager Console and it is installed on a 
directory that is mapped to another machine 
An error occurs if the Metadata Manager Console is installed on a directory that is mapped to another 
machine and you start Metadata Manager Console on the machine with the mapped directory.  

Workaround: You must enable FullTrust for .Net framework before you can start Metadata Manager from 
the machine with the mapped directory. 

To enable FullTrust: 

1. Go to the Control Panel on the machine with the mapped directory.  

2. Double-click Administrative Tools. 

3. Double-click Microsoft .Net Framework 1.1 Configuration. 

4. Expand the Runtime Security Policy folder. 

5. Expand the Machine folder. 

6. Expand the Code Groups folder.  

7. Expand the All_Code code group. 

8. Right-click the LocalIntranet_Zone code group and then select Properties. 

9. Click the Permission Set tab, and then select FullTrust as the permission set. 

10. Click Apply. 

11. Click OK. 

CR 102427: The Resume option is not enabled for data modeling tool XConnects that fail 
while generating connection assignments 
The Resume button in the Metadata Manager Console is not enabled for data modeling tool XConnects that 
fail while generating connection assignments to other source repositories. If you do not elect to generate 
connection assignments, this error does not occur. 
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Workaround: Instead of clicking the Resume button, click the Load button to run the entire XConnect 
again. 

CR 99382: The XConnect run fails if the value of the Schema Inclusion List or Folder 
Inclusion List parameter is greater than 4,000 characters 
The PowerCenter XConnect uses the Folder Inclusion List parameter to determine the folders of objects to 
load into the Metadata Manager Warehouse. The database XConnects use the Schema Inclusion List 
parameter to determine the schemas to load into the Metadata Manager Warehouse. The values for these 
parameters must not exceed 4,000 characters. If the value exceeds 4,000 characters and you try to run the 
XConnect, the XConnect run fails. 

CR 98969: Errors may occur if you do not configure the source repository connection for 
the Microstrategy XConnect before you run the XConnect 
If you do not configure the source repository connection for the Microstrategy XConnect before you run 
the XConnect, the Metadata Manager Console displays the Repository Configuration Parameters pop-up 
window, which prompts you to provide source repository connection information. If you change the 
version of the Microstrategy XConnect from the default 7.0 and you add a project, the project does not 
appear in the list of projects in the Project Source grid. If you change the version back to the default 7.0, the 
values of the fields in the Project Source grid are removed. You cannot proceed. 

Workaround: Click Cancel to close the Repository Configuration Parameters pop-up window. Configure 
and save the source repository connection in the Configuration Properties tab in the Metadata Manager 
Console. You can run the XConnect after you configure and save the source repository connection. 

CR 98912: Metadata Manager Console closes Business Objects client tools when you run 
the Business Objects XConnect 
When you run the Business Objects XConnect, Metadata Manager Console closes Business Objects client 
tools that are running on the same machine as the Metadata Manager Console. Business Objects client tools 
include Business Objects Designer and Business Objects Reporter. If a Business Objects client tool is 
performing any tasks when Metadata Manager closes the tool, Metadata Manager Console aborts the tasks 
or an error occurs. 

Workaround: Close Business Objects client tools before you run the Business Objects XConnect. 

CR 97783: The Metadata Manager Console configures the wrong relational connection 
type for a Microsoft SQL Server source or target when the Integration Service and the 
Repository Service are on UNIX 
When you run an Integration Service and a Repository Service on UNIX, the Metadata Manager Console 
configures the wrong relational connection type for a source repository or Metadata Manager Warehouse 
target that resides on a Microsoft SQL Server database. The Metadata Manager configures a Microsoft 
SQL Server relational connection. The connection should be ODBC.  

Workaround: Replace the Microsoft SQL Server connection with an ODBC connection for the source 
repository and the Metadata Manager Warehouse. You must change the relational connection type for a 
source repository each time you save the source connection information in the Metadata Manager Console. 

To change the connection for a source repository: 

1. In the PowerCenter Workflow Manager, replace the existing source repository relational connection 
with the predefined MM_Source relational connection. 

There is one relational connection for each source repository, where the naming convention for the 
relational connection is R<repository_uid>. The repository UID uniquely identifies each source 
repository. Use the parameter file name to determine the repository UID. For example, if the parameter 
file name is 12345.par, the repository UID is 12345. To determine the parameter file name, select the 
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corresponding XConnect in the Metadata Manager Console, and then click the Parameter Setup tab. 
The parameter file name appears on the Parameter Setup tab. 

2. Delete the existing source repository relational connection. 

3. Create a relational connection of an ODBC type for the source repository.  

Use the same name as the existing source repository relational connection. 

When you run the XConnect, the Metadata Manager Console replaces the MM_Source relational 
connection with the ODBC relational connection that you created. 

To change the connection for the Metadata Manager Warehouse: 

1. In the PowerCenter Workflow Manager, create an ODBC-type relational connection to the Metadata 
Manager Warehouse. 

Use a unique name. For example, if you have Metadata Manager Warehouse connections named 
MM_WH_Conn@1 and MM_WH_Conn@2, create a connection named MM_WH_Conn@3. 

2. Replace the latest version of the existing Microsoft SQL Server connection with the ODBC-type 
connection. 

For example, if you have connections named MM_WH_Conn@1 and MM_WH_Conn@2, and you 
created a connection named MM_WH_Conn@3, replace MM_WH_Conn@2 with 
MM_WH_Conn@3. 

CR 97719: An error appears if you run a data modeling tool XConnect with connection 
assignments and select the Monitor option 
The following message appears if you run a data modeling tool XConnect with connection assignments and 
select the Monitor option in the Metadata Manager Console: 

Failed to load resources from resource file please check your setup. 

Workaround: Do not select the Monitor option when you run the data modeling tool XConnect. To view 
the workflow status in the Workflow Monitor, open the Workflow Monitor from the Start menu. 

CR 97306: Metadata Manager Console does not display the repository type for a custom 
XConnect if you change the name of the custom repository type 
To display the repository type for each custom XConnect, the Metadata Manager Console requires the 
name and ID of the repository type to be the same. When you create a custom repository type, Metadata 
Manager uses the name you provided as the ID for the repository type. If you update the repository type 
name, Metadata Manager does not update the ID.  

Workaround: Make sure the repository name and ID are the same. If they are different, perform one of the 
following tasks: 

 Change the name to match the ID. 

 Delete the repository type, and then recreate it. 

CR 96624: Metadata Manager Console does not prohibit you from trying to create an 
XConnect that was previously created by the Metadata Manager Custom Metadata 
Configurator 
If you create a custom XConnect using the Metadata Manager Custom Metadata Configurator, the 
Metadata Manager Console does not prohibit you from trying to create another custom XConnect for the 
same repository type. Although the Metadata Manager Console allows you to try to create the XConnect, 
nothing actually happens when you save your settings. 
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CR 91814: An error appears if you click the save button in the Metadata Manager Console 
when it does not show any XConnects 
If the Metadata Manager Console does not show any XConnects and you click the Save button in the 
Configuration Properties tab, the following error appears: 
Error: Index was out of range. Must be non-negative and less than the size of 
the collection. 

Parameter name: index 

Source: mscorlib 

Trace: at System.Collections.ArrayList.get_Item(Int32 index) 

        at C1.Win.C1FlexGrid.RowCollection.get_Item(Int32 index) 

at Informatica.frmRepo.btnConfig_Save_Click(Object sender,    

EvenArgs e) 

at System.Windows.Forms.Control.OnClick(EventArgs e) 

Workaround: Add the source repositories in Metadata Manager to show XConnects in the Metadata 
Manager Console. The error does not occur when there are XConnects in the Metadata Manager Console. 

CR 89536: Output tab of the Metadata Manager Console does not scroll when you run a 
Data Analyzer XConnect 
When you run an XConnect, the Output tab of the Metadata Manager Console shows the progress of the 
XConnect run. The Output tab automatically scrolls through the message window to display new messages. 
However, the Output tab does not automatically scroll when you run a Data Analyzer XConnect. 

Workaround: You must manually scroll through the message window to view the latest progress of a Data 
Analyzer XConnect run. 

CR 87654: Metadata Manager Console does not validate the database type when you log in 
The Metadata Manager Console does not validate the database type when you log in. As a result, an error 
does not display if you specify the wrong database type when you log in. If you specify the wrong database 
type, you can log in to the Metadata Manager Console, however, you cannot run XConnects successfully or 
use Metadata Manager Console functions. 

Workaround: Close the Metadata Manager Console, and then open and log back in to it using the correct 
database type. 

CR 84295: The Metadata Manager Console does not use secure FTP (SFTP) to transfer 
files 
The Metadata Manager Console uses FTP to transfer files, not SFTP. You cannot use the FTP function in 
the Metadata Manager Console if your system is configured to use SFTP. 

Workaround: Use the following procedure to manually transfer files using SFTP: 

1. In the Metadata Manager Console, select Administration tab > File Transfer Configuration. 

2. Instead of specifying the FTP directory to a remote machine, specify a local folder where the Metadata 
Manager Console can access the template parameter files. 

3. Click the Parameter Setup tab, and then configure the parameters if needed.  

4. Click Save to save the parameter configuration. 

Click Save even if you did not configure any parameters. When you click save, the Metadata Manager 
Console generates a parameter file, such as 12345.par, in the local folder you specified.  

5. Open the generated parameter file. 
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6. In the parameter file, perform a global search for $$REPOSITORY ID, and enter the repository ID 
value if it does not exist already.  

To determine the repository ID, select an XConnect in the Metadata Manager Console, and then click 
the Parameter Setup tab. The Parameter Setup tab displays the repository ID for the selected 
XConnect. 

7. Save file. 

8. Use SFTP to transfer the modified parameter file from the local directory to the following directory on 
the remote machine: 

<PowerCenter home>\server\infa_shared\SrcFiles 

The PowerCenter Workflow Manager uses the parameter file in this directory when you run the 
XConnect. 

Metadata Manager Warehouse 

CR 97009: If you import metadata from the same XML file multiple times, Metadata 
Manager may create duplicate records 
If you import metadata from the same XML file multiple times, Metadata Manager may create duplicate 
records.  

CR 90635, 78535, 75043: XConnect loads may fail if the Metadata Manager Warehouse is 
on Oracle 9i and the Oracle client is 10g 
The XConnect load might fail if the Oracle client is 10g and the Metadata Manager Warehouse is on an 
Oracle 9i database. This occurs because many of the sessions in the XConnects are configured to run in 
Bulk mode.  

When using Oracle 10g client to bulk load into an Oracle 9i database, the session fails with the following 
error: 

WRT_8229 Database errors occurred: ORA-00942: table or view does not 
exist  
Database driver error...Function Name : Prepare DPL 
SQL Stmt : INSERT INTO SALGRADE_tgt(GRADE,LOSAL,HISAL) VALUES ( ?, ?, ?) 
Oracle Fatal Error 
Database driver error... 
Function Name : Execute Multiple 

Workaround: Use the Oracle 9i client for the target database connection. 

Reports 

CR 127739: Data lineage and where-used analysis for Teradata views do not show 
relationships to tables or views defined at different database user levels 
When you create a table at a user level and define a table view at a different user level, Metadata Manager  
data lineage and where-used analysis do not display the table or view.      

CR 106106: Data lineage and where-used analysis do not show tables included in a 
SELECT statement that is nested within another SELECT statement 
Data lineage and where-used analysis do not show tables included in a SELECT statement that is nested 
within another SELECT statement. For example, data lineage and where-used analysis do not show the 
SORT_MUTA table in the following nested SELECT statement: 

SELECT DAGE_ID  
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FROM REMO_DAG 
WHERE DMLO_DM_ALIAS = 'REMO' 
AND SOVM_ID in (SELECT MANT_ID from SORT_MUTA WHERE Col = 'Voor') 

CR 105949: Data lineage does not map the input and output fields correctly when you view 
field level details       
When you select a field in data lineage to show the field-level details, Metadata Manager might map the 
wrong field expression and input and output fields. 

CR 104128: Lineage does not display correctly for flat files that have columns with Integer, 
Double, or Date Time datatypes 
If you run data lineage on a flat file that has columns with Integer, Double, or Date Time datatypes, 
Metadata Manager does not show the lineage between the flat file and a PowerCenter mapping that extracts 
data from it or loads data into it. 

CR 103974: Flat file sources and lookups may not appear in data lineage for some 
sessions 
If you specify the name of a source or lookup flat file in the session properties of a session, data lineage 
does not show the flat file source or lookup for the session when the following conditions are true: 

 A mapplet contains the flat file source or lookup. 

 The mapping containing the mapplet is used in multiple sessions. 

 For other sessions that use the same mapping, you use a session parameter to represent the flat file 
name or you specify the flat file name in the session properties. 

CR 100609: Error occurs if you run where-used analysis or a custom report on a deleted 
object 
Metadata Manager does not display deleted objects in reports or where-used analysis. If you run where-
used analysis or reports on deleted objects, an error displays. 

Workaround: Include the following filter in the report to remove deleted objects from the report: 
deleted flag = ‘N’ 

CR 99383: Data lineage and where-used analysis do not show the tables that correspond 
to Sybase Power Designer views 
Data lineage and where-used analysis do not show the tables that correspond to Sybase Power Designer 
views. 

CR 96689: The schedule for the System Activity QTD by Month report is not assigned 
The System Activity QTD by Month report should have the Daily schedule attached to it.  

Workaround: Attach the Daily schedule to the report to enable it to run everyday. 

CR 96082: Names of the object and real parent may overlap in the lineage diagram 
The names of the object and real parent may overlap in the lineage diagram. 

CR 95080: If a custom object is a field object and it does not have a parent object, the 
lineage diagram displays a blank box 
All custom objects that are classified as field objects must have a parent object. Otherwise, the lineage 
diagram displays a blank box for the custom object. 
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CR 94963: Business Intelligence reports that use the IMA_REPORT view do not show 
ReportName values for Data Analyzer objects 
Business Intelligence reports that use the IMA_REPORT view do not show ReportName values for Data 
Analyzer objects. The IMA_REPORT view is created using the IMW_DATA_STRUCT table, which is not 
populated with any Data Analyzer metadata. 

CR 94954, 89871: Data Analyzer custom, schema-level metrics and attributes do not 
display in data lineage 
If you promote custom metrics or attributes to the Schema Directory in Data Analyzer, the custom metrics 
and attributes do not display in data lineage. 

CR 94869: Business Intelligence reports do not show information if they are built using the 
IMA_USRACCT_PR_CNT view 
The packaged Business Intelligence XConnects do not load metadata into this view.  

CR 94041: Data lineage for ERStudio objects does not show connections to Oracle 
database objects 
Data lineage on ERStudio objects does not show connections to Oracle database objects. 

CR 94037: Data lineage on ErwinView class objects do not show connections to Oracle 
views if the view is a materialized view 
Data lineage on ERwinView class objects do not show connections to Oracle views if the view is a 
materialized view. 

CR 94023: The Procedures, Functions and Triggers Summary report does not show 
Sybase and Microsoft SQL Server triggers 
The Procedures, Functions and Triggers Summary report in the Database Management folder does not 
show triggers for Sybase and Microsoft SQL Server databases.  

CR 92040: Data lineage between IBM DB2 CubeViews and a relational database does not 
work 
Data lineage between IBM DB2 CubeViews and a relational database does not work. 

CR 90460: Data lineage does not display if it has to display more than 600 data structures 
Data lineage does not display if it has to display more than 600 data structures. For example, if you run data 
lineage on a database table that is used in more than 200-250 PowerCenter mappings, then you may 
encounter this error. 

Metadata Manager uses the following parameters to restrict the objects that appear in the lineage diagram: 

 MAX_DISPLAYABLE_STRUCTS. This parameter restricts the lineage diagram to display 600 
objects. You cannot modify this value. 

 Lineage.MaxImpactLevels. This parameter determines the maximum number of levels of metadata 
that show in the lineage diagram. The number of levels refers to the number of data structures on either 
side of the object on which you run data lineage. For example, a PowerCenter mapping with five 
sequential transformations between the source and target has seven levels. The default parameter value 
is 3. You can configure this value in the IMM.properties file to display a different number of levels.  

If the number of objects exceeds 600 objects, Metadata Manager restricts the number of levels to show less 
objects in the lineage diagram. If Metadata Manager cannot reduce the number of objects below the  
600-object limit, Metadata Manager displays an error.  
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Workaround: Run data lineage on a field instead of the data structure. This issue is less likely to occur 
when you run data lineage on a field. 

CR 89618: Java Script Error (JSE) appears when you launch data lineage from 
PowerCenter and the browser window is minimized 
If you launch data lineage from PowerCenter and the browser window is minimized, the browser displays a 
JSE error instead of the lineage diagram.  

Workaround: In the browser window, click the Where-Used tab, and then click the Lineage tab to display 
the lineage diagram. 

CR 83726: You cannot run data lineage and where-used analysis from the Create tab 
You cannot run the Data Lineage and Where-Used Analysis reports from the Create tab in Metadata 
Manager. If you click the Display on Analyze or Display on View button, you receive the following error: 

No provider registered for the provider type:102 

Although you have permission to view the Data Lineage and Where-Used Analysis reports on the Find tab 
and click Edit to view their definitions on the Create tab, you cannot edit the reports or click the Display on 
Analyze or Display on View button to run the reports. You can only edit and view the other reports from 
the Create tab. 

Workaround: Run the Data Lineage and Where-Used Analysis reports as described in the Metadata 
Manager User Guide.  

CR 75479, 75476, 75474: Metadata Manager may apply incorrect filters to child reports in 
analytic workflows  
If the parent report in an analytic workflow has sections, when you run a child report, Metadata Manager 
filters the results based on the first section of the parent report. This issue affects the following child 
reports: 

Child Report(s) Analytic Workflow Primary Report 

Classes by Package Repository Type Exploration 

Associations by Package Repository Type Exploration 

Class Inheritance,  
Class Attributes,  
Element Statistics,  
Class Associations 

Classes Exploration 

CR 66190: Metadata Manager displays lineage for PowerCenter objects from flat file 
sources only in the PowerCenter domain 
Metadata Manager does not provide lineage of PowerCenter objects from flat file sources across domains. 
Flat files include direct flat files or indirect flat files, such as FTP connections, External Loader, XML 
source, and MQ series. 

CR 63056: Metadata Manager displays incorrect session start and end dates and times for 
Data Analyzer schedules 
Metadata Manager displays incorrect session start and end dates and times for report runs using Data 
Analyzer schedules. If a report run fails, Metadata Manager does not use the start and end times of the 
failed report run. It uses the start and end times of the last successful report run.  
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XConnects 

CR 127166: Metadata Manager Schema Details (Attributes, Metrics) report does not show 
the folder of Microstrategy dimensions 
The Schema Details (Attributes, Metrics) report shows Microstrategy dimensions as the folders of 
Microstrategy attributes, but does not show the Microstrategy folder that contains the dimensions.  

Workaround: To see the folder that contains the dimension, modify a copy of the report template and add 
the folder as the parent object for dimensions. After you modify the report template, run the report again.  

To add the folders of dimensions in the report, complete the following steps: 

1. In Metadata Manager, edit a copy of the report. 

2. Add the ODS Reports Attributes > Level 0 > Element attribute to the report. 

3. Add an attribute filter to the report to show only the Folder attribute value. 

4. Save the report under another name. 

CR 127159: The Microstrategy XConnect does not load report hierarchies  
If you include a hierarchy object in a Microstrategy report, the Microstrategy XConnect does not load the 
hierarchy object. 

CR 127151: Associations between Microstrategy reports and custom groups do not appear 
in Metadata Manager 
If you create a custom group for a report in the Microstrategy Custom Group Editor and load the 
Microstrategy metadata, Metadata Manager does not load the association between the custom group and the 
report. As a result, the association between the objects do not appear in Metadata Manager reports, data 
lineage, or where used analysis.  

CR 131544: Metadata Manager does not display data lineage between logical tables 
defined in Microstrategy 
Metadata Manager does not display data lineage between logical tables defined in Microstrategy and the 
underlying database tables. The Microstrategy XConnect cannot parse the SQL query used to define the 
logical tables in Microstrategy. As a result, Metadata Manager cannot determine lineage between the 
logical table and the database table. 

CR 107672: The Cognos ReportNet Content Manager XConnect fails if you configure 
Cognos ReportNet Content Manager to use Challenge/Response logins 
If you configure the Cognos ReportNet Content Manager to use Challenge/Response logins, the Cognos 
ReportNet Content Manager XConnect fails with the following error: 

The Bridge was not able to complete the Import/Export process 
successfully. Please verify information entered in the configuration 
Properties section is correct. 

CR 106278: Integration Service generates unique key constraint errors when PowerCenter 
repository is on Microsoft SQL Server and Metadata Manager Warehouse is on Oracle or 
Sybase 
If the PowerCenter repository for Metadata Manager resides on a Microsoft SQL Server database, the 
Metadata Manager Warehouse resides on an Oracle or a Sybase database, and you run an XConnect, the 
Integration Service generates unique key constraint errors. However, the XConnect run completes 
successfully.  
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CR 106191: The Integration Service generates transformation errors if you do not set up 
the connection assignments for the Business Objects or PowerCenter XConnect 
If you do not set up the connection assignments when you run the Business Objects or PowerCenter 
XConnects, the Integration Service generates transformation errors. However, the XConnect run completes 
successfully. 

Workaround: Set up the connection assignments when you run the Business Objects or PowerCenter 
XConnect. 

CR 105414: The ERwin XConnect does not load the names of physical tables from an 
Erwin 4.x source repository 
The Erwin XConnect does not load the names of physical tables from an Erwin 4.x source repository. 

CR 104542: The Business Objects XConnect does not extract Desktop Intelligence and 
Webi documents that are saved in Favorites in Business Objects  
The Business Objects XConnect does not extract Desktop Intelligence or Webi documents that are saved in 
Favorites in Business Objects. 

CR 102091: If you loaded metadata from a Business Objects universe and you remove all 
universes from Business Objects Supervisor, you can run the Business Objects XConnect 
again 
When you remove all Business Objects universes and you click the Retrieve/Refresh Universes option in 
the Metadata Manager Console, the Metadata Manager Console shows the following message: 

There is no universe found in repository. 

After this message, you can still click Load to run the XConnect, even though the XConnect should not run. 

CR 101539: Error appears when you use a DataDirect ODBC driver for the Business 
Objects XConnect 
An error appears if you use a DataDirect CLOSED ODBC driver for the Business Objects XConnect.  

Workaround: Use a native ODBC driver installed on the Metadata Manager Console machine. For 
example, for Oracle, use the Oracle in OraHome92 native driver instead of the DataDirect CLOSED ODBC 
5.1 Oracle Wire Protocol ODBC driver. 

CR 100961: After you upgrade Metadata Manager, the source connections for the existing 
XConnects may not be valid 
After you upgrade Metadata Manager, you must verify and save the source repository connections for all 
existing XConnects in the Metadata Manager Console. Re-enter the value for any field in the Configuration 
Properties tab that is blank. 

CR 97719: An error appears if you run a data modeling tool XConnect or Microstrategy 
XConnect with connection assignments and select the Monitor option  
The following message appears if you run a data modeling tool XConnect or Microstrategy XConnect with 
connection assignments and select the Monitor option in the Metadata Manager Console: 

Failed to load resources from resource file please check your setup. 
 

Workaround: Do not select the Monitor option when you run the data modeling tool XConnect or 
Microstrategy XConnect. To view the workflow status in the Workflow Monitor, open the Workflow 
Monitor from the Start menu. 
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CR 97706: Metadata Manager Console displays the wrong status if Data Analyzer 
XConnect fails at the session S_M_CONNECTION_EXTRACT 
If the Data Analyzer XConnect fails at the session S_M_CONNECTION_EXTRACT, the Metadata 
Manager Console states that the XConnect completed successfully. 

CR 97646: PowerCenter XConnect does not extract attributes for non-reusable sessions 
The PowerCenter XConnect does not extract attributes, such as log file names, for non-reusable sessions. 

CR 96169: Transformation errors may occur in the session 
S_M_ELMNT_ASSOC_FIRST_LOAD 
Transformation errors occur in the session S_M_ELMNT_ASSOC_FIRST_LOAD if the session 
encounters particular datatypes when loading associations.  

CR 96033: Session S_M_ELMNT_ASSOC_FLAT_FILE_FIRST_LOAD rejects records when 
running the Hyperion XConnect 
The session S_M_ELMNT_ASSOC_FLAT_FILE_FIRST_LOAD rejects records when running the 
Hyperion XConnect. 

CR 95323: PowerCenter XConnect rejects records if the PowerCenter repository is on an 
IBM DB2 database 
The PowerCenter XConnect rejects records if the PowerCenter repository is on an IBM DB2 database.  

CR 94372: Data Analyzer XConnect fails if the Data Analyzer repository is on Sybase 
The Data Analyzer XConnect fails if the Data Analyzer repository is on Sybase. When you run the Data 
Analyzer XConnect, the ipaxconnect.bat file fails with the following error: 

Class Not Found Error. 

CR 94200: The Informix XConnect may fail at the S_M_ELEMENT_FIRST_LOAD or 
S_M_ELEMENT_EXTRACT session 
The Informix XConnect may fail at the S_M_ELEMENT_FIRST_LOAD or S_M_ELEMENT_EXTRACT 
session. 

CR 94022: The ERwin, ER Studio, and Sybase XConnects do not extract associations 
between procedures and other objects 
The Erwin, ER Studio, and Sybase XConnects do not extract associations between procedures and other 
objects. As a result, where-used analysis does not show the table on which the procedure is created, and 
data lineage does not show the source and target objects of the procedure. 

CR 88985: The Data Analyzer XConnect fails if the Data Analyzer repository is on a DB2 
8.1.2 database 
The Data Analyzer XConnect fails if the Data Analyzer repository is on a DB2 8.1.2 database.  

Workaround: Upgrade the Data Analyzer repository from DB2 8.1.2 to 8.1.9. The Data Analyzer XConnect 
supports DB2 8.1.9. 

CR 83708: The Business Objects XConnect does not parse the Business Objects metadata 
correctly if the Business Objects source repository does not provide the data provider 
column for a document variable 
The Business Objects XConnect expects that each data provider document variable has a corresponding 
column in a data provider query. The number of columns in the data provider varies depending on the 
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scope of analysis in the saved version of the document. Extra columns, which contain values for dimension 
objects that are used for drill-down, are added to the data provider. If the Business Objects XConnect does 
not find the data provider column that corresponds to a document variable, then it writes an entry to the 
XConnectBusObj.log file. This issue may also prevent lineage from displaying correctly in the Design-
Time Lineage report. 

CR 83707: Business Objects XConnect may not parse universe metadata 
The Business Objects XConnect expects that each universe object contains a Select property, which 
specifies a database column or an expression that evaluates to a single value for each output row. If the 
object does not contain an expression, the Business Objects XConnect writes an entry to the 
XConnectBusObj.log file.  

You may also encounter other parsing issues if the Select expression references tables that are not included 
in an Object table list. This typically happens when the select expression contains subqueries. 

Workaround: To avoid parsing errors when the object does not contain a Select property, you should 
convert objects without Select clauses to filter conditions. Filter conditions behave the same way, except 
the filter icon correctly indicates how they can be used. This workaround may also prevent a user from 
creating a Business Objects query that does not contain valid columns. 

If you encounter other SQL parsing issues, contact Informatica Global Customer Support. Provide the 
XConnectBusObj.log file, which contains diagnostic information that helps Informatica resolve these 
issues. 

CR 83676: PowerCenter XConnect does not notify you when you load a shortcut to a 
PowerCenter object, but do not load the object 
You can exclude objects in particular PowerCenter folders from the metadata load. If you exclude a shared 
folder that contains objects, but include folders that contain shortcuts to the excluded objects, Metadata 
Manager may not display correct information. For example, the Design-Time Lineage report cannot show 
lineage if an object referenced by a shortcut is not loaded into the Metadata Manager Warehouse. 

Workaround: Load all shared folders containing objects that are referenced by shortcuts in folders that are 
loaded. 

CR 80344: ‘Primary Key’ displays as the name of ERwin primary keys and indexes 
When you export Erwin metadata to an XML file, if the names of primary keys or indexes are not 
available, ERwin uses ‘Primary Key’ as their default names. To display the actual names in Metadata 
Manager, update the ERwin model with the names, export the metadata to an XML file, and then run the 
ERwin XConnect again. 

CR 72728: Oracle XConnect extracts temporary tables from Oracle 10g repositories 
Oracle 10g has a new Flashback feature that enables you to reinstate tables that were previously dropped 
from the database. If you enable this feature, when you drop a table, Oracle 10g renames the dropped table 
to a system-defined name and stores this temporary version of the table in the same schema. When you run 
the Oracle XConnect, the XConnect extracts information about these temporary tables. 

CR 66539: Microsoft SQL Server XConnect does not extract the association between a 
view and an index 
Microsoft SQL Server XConnect does not extract the association between a view and an index.  

CR 58555: Integration Service process variables and code pages do not display as object 
properties 
Metadata Manager does not display details for the Integration Service process, such as code pages and 
values for process variables. 
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CR 56404: PowerCenter XConnects do not extract some attributes of application-specific 
sources  
When a PowerCenter XConnect loads PowerCenter metadata into the Metadata Manager Warehouse and 
the PowerCenter repository contains application-specific sources, such as PeopleSoft, the Integration 
Service process does not load some attribute values into the Metadata Manager Warehouse, such as the 
Tree Name, Set ID, and Set Control attributes. 

CR 55150: PowerCenter XConnects do not support global and local repositories 
PowerCenter XConnects do not support a local repository with an object reference from the global 
repository. 

Documentation Addenda 
This section includes updates to the documentation. 

Administration Guide 

Chapter 17: Managing Logs 

Understanding Log Events 
The following text adds to the Domain Log Events list: 

 Service Manager. Log events from the Service Manager and signal exceptions from DTM processes.  

PowerCenter Command Line Reference 

Chapter 1: Using the Command Line Programs, Overview 
Add the following entry after the bulleted list of command line programs: 

To run command line programs and utilities on UNIX, you may need to set the library path environment 
variable to the location of the PowerCenter utilities. For more information, see “PowerCenter Utilities 
Installation” in the Installation and Configuration Guide. 

Chapter 4: Infasetup Command Reference (Using infasetup) 

The following text adds to the Using infasetup section: 

Using Database Connection Strings 

Some infasetup commands use connection strings to connect to the domain configuration database. Specify 
the database host, database port, and database service name as part of the connection string. 

You can use connection strings with the following infasetup commands: 

 BackupDomain 

 DefineDomain 

 DefineGatewayNode 

 DeleteDomain 

 RestoreDomain 

 UpdateGatewayNode 
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The following table lists the connection string syntax for each supported database: 

Database Name Connection String 

Oracle jdbc:informatica:oracle://host_name:port:SID=sid  

Microsoft SQL Server jdbc:informatica:sqlserver://host_name:port; 
SelectMethod=cursor;DatabaseName=database_name 

IBM DB2 jdbc:informatica:db2://host_name:port; DatabaseName=database_name  

Sybase ASE jdbc:informatica:sybase://host_name:port;DatabaseName=database_name 

Chapter 4: Infasetup Command Reference (infasetup Commands) 
The following option adds to the syntax of the infasetup commands: BackupDomain, DefineDomain, 
DefineGatewayNode, DeleteDomain, RestoreDomain, and UpdateGatewayNode. 
<-DatabaseConnectionString|-cs> database_connection_string 

The following table adds to the description of the infasetup commands options and arguments: 

Option Argument Required/
Optional 

Description 

-DatabaseAddress 

-da 

database_hostname: 
database_port 

 

Conditional Name and port number of the machine hosting 
the domain configuration database. Required if 
you do not use -DatabaseConnectionString (-cs) 
option. 

-DatabaseConnectionString 

-cs 

database_connection_
string 

Conditional Connection string used to connect to the domain 
configuration database. Specify the database 
host, database port, and the database service 
name as part of the connection string. Required 
if you do not use -DatabaseAddress (-da) and  
-DatabaseServiceName (-ds) options. 

-DatabaseServiceName 

-ds 

 

database_service_ 

name 

Conditional The database service name. Required for 
Oracle, IBM DB2, Microsoft SQL Server, and 
Sybase ASE databases. Enter the SID for 
Oracle, the service name for IBM DB2, or the 
database name for Microsoft SQL Server or 
Sybase ASE. Required if you do not use  
-DatabaseConnectionString (-cs) option. 

 

PowerCenter Post-Upgrade Reference 

Chapter 8: Integration Service 
Behavior Change 

Version Implemented: PowerCenter 8.1.1 SP4 

Versions Affected: 8.0, 8.1, 8.1.1 

The Integration Service processes decimal values as Doubles or Decimals. When a session calculation 
converts a Double value to a String or Decimal value, and high precision data handling is not enabled, the 
Integration Service stores up to 15 digits. The value stored by the Integration Service differs across 
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platforms. This is due to compiler and hardware differences. For example, a calculation run on Windows 
produced slightly different results than the same calculation run on UNIX. 

In a previous version, the Integration Service rounded the fifteenth digit and set all digits after the fifteenth 
digit to 0.  

You may notice slight changes in the results of calculations where Doubles are converted to String or 
Decimal values. If you require accuracy greater than 15 digits, enable high precision data handling. 

Chapter 12: Mappings and Mapping Objects, Sorter Transformation 
Add the following information: 

Behavior Change 

Version Implemented: 8.1.1 SP2  

Versions Affected: 6.x, 7.x, 8.0, 8.1, 8.1.1, 8.1.1 SP1 

Effective in version 8.1.1 SP2, the Sorter transformation requires at least 16 MB of cache memory instead 
of 8 MB. 

PowerCenter Troubleshooting Guide 

Chapter 10: CFG Messages     
Add the following error message: 
CFG_10095 The Service Manager failed to read the domain configuration from <database type> database with 

connection string <database connection string> with error <error message>. 

Cause: The port number assigned to the Web Services Hub is already in use. 

Action: Verify that the database connectivity information specified for the domain is correct. 

or 

Cause: The domain configuration database has invalid data. 

Action: Contact Informatica Global Customer Support. Before restoring the domain configuration      
database from the last known good backup file, first back up the invalid domain configuration 
database to another file to help Informatica Global Customer Support troubleshoot the 
problem.   

Chapter 65: SPC Messages 
Add the following error message: 
SPC_10039 Could not start Informatica PowerCenter Web Services Hub service on port <port number> 

because this port is in use.  

Cause: The port number assigned to the Web Services Hub is already in use. 

Action: Reconfigure the Web Services Hub to use a different port number. 
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Workflow Administration Guide 

Chapter 24: Parameter Files 
Add the following entries to Table 24-5 “Session Input Fields that Accept Parameters and Variables” in the 
“Where to Use Parameters and Variables” section: 

Tab Field Valid Parameter and Variable Types 

Properties tab $Source connection value User-defined session parameter $DBConnectionName 

Properties tab $Target connection value User-defined session parameter $DBConnectionName 

Metadata Manager Administrator Guide 

Chapter 3: Setting Up the Metadata Manager Console, Specifying the PowerCenter Source 
Files Directory 
Add the following information: 

The Metadata Manager Console must be able to write files to the PowerCenter source files directory. 

Contact Information 

North America / South America  Europe / Middle East / Africa Asia / Australia 

Informatica Corporation 
Headquarters 
100 Cardinal Way 
Redwood City, California  
94063 
United States 
 
 
Toll Free  
+1 877 463 2435 
 
 
Standard Rate 

Brazil: +55 11 3523 7761  
Mexico: +52 55 1168 9763 
United States: 650 385 5800 

Informatica Software Ltd. 
6 Waltham Park 
Waltham Road, White Waltham 
Maidenhead, Berkshire 
SL6 3TN 
United Kingdom 
 
 
Toll Free  
00 800 4632 4357 
 
 
Standard Rate 
Belgium: +32 15 281 702 
France: +33 1 41 38 92 26 
Germany: +49 1805 702 702 
Netherlands: +31 306 022 797 
United Kingdom: +44 1628 511 445 

Informatica Business Solutions 
Pvt. Ltd. 
Diamond District 
Tower B, 3rd Floor 
150 Airport Road 
Bangalore 560 008 
India 
 
Toll Free  
Australia: 1 800 151 830 
Singapore: 001 800 4632 4357 
 
Standard Rate 
India: +91 80 4112 5738 
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Notices 
This Informatica product (the “Software”) includes certain drivers (the “DataDirect Drivers”) from 
DataDirect Technologies, an operating company of Progress Software Corporation (“DataDirect”) which 
are subject to the following terms and conditions: 

1. THE DATADIRECT DRIVERS ARE PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. 

2. IN NO EVENT WILL DATADIRECT OR ITS THIRD PARTY SUPPLIERS BE LIABLE TO THE 
END-USER CUSTOMER FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
CONSEQUENTIAL OR OTHER DAMAGES ARISING OUT OF THE USE OF THE ODBC DRIVERS, 
WHETHER OR NOT INFORMED OF THE POSSIBILITIES OF DAMAGES IN ADVANCE. THESE 
LIMITATIONS APPLY TO ALL CAUSES OF ACTION, INCLUDING, WITHOUT LIMITATION, 
BREACH OF CONTRACT, BREACH OF WARRANTY, NEGLIGENCE, STRICT LIABILITY, 
MISREPRESENTATION AND OTHER TORTS. 

The POCO software (Copyright © 2008, Applied Informatics Software Engineering GmbH and 
Contributors. All rights reserved.) is included under the Boost Software License - Version 1.0 - August 
17th, 2003. Permission is hereby granted, free of charge, to any person or organization obtaining a copy of 
the software and accompanying documentation covered by this license (the "POCO Software") to use, 
reproduce, display, distribute, execute, and transmit the POCO Software, and to prepare derivative works of 
the POCO Software, and to permit third-parties to whom the POCO Software is furnished to do so, all 
subject to the following:  The copyright notices in the POCO Software and this entire statement, including 
the above license grant, this restriction and the following disclaimer, must be included in all copies of the 
POCO Software, in whole or in part, and all derivative works of the POCO Software, unless such copies or 
derivative works are solely in the form of machine-executable object code generated by a source language 
processor. THE POCO SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-
INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE 
DISTRIBUTING THE POCO SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER 
LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE POCO SOFTWARE OR THE USE OR OTHER DEALINGS IN THE POCO 
SOFTWARE. 
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